
NRG-FR1, NRG-FR1-LCP, NRG-FR2, and NRG-FR2-LCP      
User Guide



Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Statement of Compliance
This product has been determined to be compliant with the applicable standards, regulations, and 
directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is 
available upon request by contacting techsupport@rossvideo.com. Please include the product; 
model number identifiers and serial number and country that compliance information is needed in 
request.

EMC Notices
United States of America — FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which 
case the user will be required to correct the interference at his own expense.

Canada

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe “A” est conforme a la norme NMB-003 du Canada.

Korea — Class A Statement

This device has been evaluated for conformity for use in a business environment. When used in a 
home environment, there is a danger of interference.

Europe

This equipment is in compliance with the essential requirements and other relevant provisions of 
CE Directive 93/68/EEC.

International

This equipment has been tested to CISPR 32:2015 along with amendments AMD1:2019, and found 
to comply with the limits for a Class A Digital device. 

General Handling Guidelines
• Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.

Important — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.

. 



A Word About Static Discharge
Throughout the many procedures in this manual, please observe all static discharge precautions.

Warranty and Repair Policy
The NRG systems are backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

Caution — Avoid handling circuit boards in high static environments such as carpeted areas, and 
when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards 
from the frame, and exercise proper grounding precautions when working on circuit boards. Exercise 
proper grounding precautions when working on circuit boards.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to NRG, what you should know about maintaining security of this product, and how we can 
partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data
• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
This guide covers the configuration and operation of the Ross Video NRG-FR1, NRG-FR1-LCP, 
NRG-FR2, and NRG-FR2-LCP routers. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides general information to keep in mind before configuring your NRG, 

instructions for configuring the NRG network settings, and assigning a name to the router.
• “Using DashBoard” outlines the NRG tree view in DashBoard, and how to navigate the nodes.
• “Product Info Interfaces” outlines the hardware information, network settings, access controls, 

how to create backups of your settings, and general management for the NRG.
• “Role-Based Access Control” outlines the use of Role-Based Access Control (RBAC) within the 

DashBoard software application for the NRG.
• “System Interfaces” outlines the interfaces that manage the available devices in your routing 

system that are auto-detected by the NRG.
• “Enabling a Service” outlines how to enable a communication protocol, and configure the 

additional settings on the NRG for a protocol. A summary of the supported commands is also 
provided.

• “Timing and Reference Setup” outlines how to configure the reference and time settings for the 
NRG.

• “Configuring the SDI I/O Ports” provides instructions on how to manage your hardware 
matrices.

• “Database Interfaces” summarizes the interfaces for creating and managing your routing 
system databases, and how to access the interfaces in DashBoard.

• “Creating a New Database” provides an overview of the Database Manager, and describes how 
to create a new database.

• “Defining a Database” outlines how to use the Database sub-nodes in DashBoard to further 
define a database for the NRG.

• “Configuring the LCP Buttons” outlines the default button assignments, how to customize the 
color and the brightness level for a button, and how to assign a function to a button on the 
NRG-FR1-LCP and NRG-FR2-LCP front panels.

• “LCP Operation” provides a general outline of how to use the front panel buttons on the 
NRG-FR1-LCP and NRG-FR2-LCP.

• “Soft Panels in DashBoard” outlines how to create, access, and use the soft panels for your NRG.
• “NRG-MV Setup” provides an overview of the NRG-MV feature including how to install a NRG-MV 

license key, display the NRG-MV interface in DashBoard, and add UMD text and Audio meters to 
the Multiviewer PiPs.

• “Glossary” provides a definitions of commonly used terms and conventions for this guide.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your NRG:

• DashBoard User Guide, Ross Part Number: 8351DR-004
• NRG Installation Guide, Ross Part Number: 2200DR-403
• NRG-FR1 and NRG-FR1-LCP Quick Start Guide, Ross Part Number: 2200DR-401
• NRG-FR2 and NRG-FR2-LCP Quick Start Guide, Ross Part Number: 2200DR-402
• Walkabout Application Note, Ross Part Number: 2201DR-003
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Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Save As dialog, click OK.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the NRG Installation Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 An error message displays when an object overlaps a tile or when one tile overlaps another in the 
workspace.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Toll Free Technical Support (North America): 1-844-652-0645
• Toll Free Technical Support (International): +800 1005 0100
• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
This chapter provides instructions for launching DashBoard, using the Walkabout application in 
DashBoard, adding the NRG router to the Tree View in DashBoard, re-naming the NRG via 
DashBoard, enabling access for a DashBoard client. An overview of how databases are used by the 
NRG is also provided.

If you have questions pertaining to the configuration or operation of the NRG, contact us at the 
numbers listed in “Contacting Technical Support”. Our technical staff is always available for 
consultation, training, or service.

Before You Begin
Keep the following in mind:

• DashBoard is required to configure the NRG router.
• The NRG supports a maximum of 10 DashBoard clients with 10 other TCP/IP connections (remote 

control panels, third-party control systems, etc.).
• Ross Video recommends a Memory Allocation of at least 4GB in DashBoard to ensure reliable 

operation. Refer to the DashBoard User Guide for details on setting the Memory Allocation value.
• Your facility IT Department provided the required network settings to be assigned to the NRG.

Establish Communications
An effective routing system takes careful planning. Routing systems may consist of many devices 
either located within the same facility, or across multiple locations. Routing devices (routers) must 
connect and communicate with each other and any control system devices all on a high speed 
network.

Walkabout is a DashBoard system for network device discovery. NRG supports the Walkabout 
system for configuration of its IP settings. Once you establish communications over Ethernet 
between the NRG router and DashBoard, you can proceed to use the interfaces in DashBoard that 
enable the NRG to communicate with the other devices in your routing system.

Network Settings
The NRG network settings can be changed via the DashBoard > Walkabout interface. A complete 
network setting requires a static IP address, a network mask address, and a gateway address. These 
should be supplied by your IT Department for this device.

Launch DashBoard
DashBoard must run on a computer that has a physical wired ethernet connection. Wireless 
connections do not allow device discovery.

For More Information on...
• downloading and installing the DashBoard client software, refer to our website.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.15 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.
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Using Walkabout to Assign the Initial IP Address to the NRG
Walkabout is a Ross router utility operating within DashBoard that enables you to configure the 
network settings for Ross routers, remote control panels, and other devices. Once a valid 
connection is established with Walkabout, the NRG can be added to DashBoard and be available for 
monitoring and configurations using the options in DashBoard. 

NRG supports a basic configuration mode via the Walkabout system for initial configuration of IP 
settings. Use Walkabout to:

• specify device IP settings and names
• specify a name for your routing system

Once the NRG router is physically installed and cabled to your facility network, you will need to 
assign it an initial static IP address to enable DashBoard to locate it on your network. Establishing 
an initial IP address enables DashBoard to communicate with the router and update the Basic Tree 
View with the NRG nodes.

For More Information on...
• the features of Walkabout, refer to the document Configuring Devices Using Walkabout.

To assign the initial static IP address to the NRG using Walkabout

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout table, to ensure the entries are current.

4. In the Walkabout table, find the entry for the NRG router you want to configure.

A factory default NRG will display the router marketing name in the Name field and an IP 
address of 192.168.20.141. 

 Do not attempt to configure multiple NRG routers at the same time.

5. Use the Name field to assign a unique identifier to the NRG router. 

This will also be the name displayed in the Tree View of DashBoard.

6. To assign a new IP address:

a. Double-click the Address field.

b. Enter the IP address supplied by your IT Department for this device.

c. Press Enter to save the new address.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP address for connection outside of the local area network 
(LAN).

 After you edit a cell in the Walkabout table, it is recommended to wait approximately 1 minute, 
then click Refresh to apply the new settings.

9. Click Reboot in the row of the Walkabout table for the NRG router.

The router reboots and the new settings are applied.

If Walkabout Communication is Unavailable
If Walkabout communication is disabled, perform one of the following:

• Enable Walkabout via the NRG > System > Connections > Services tab; or
• Connect an USB drive to the NRG to set the IP address.
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Both methods are described below.

To enable Walkabout communications on the NRG

1. Locate the NRG node in the Tree View of DashBoard.

2. Expand the NRG node to display a list of sub-nodes.

3. Expand the System sub-node.

4. Double-click the Connections sub-node.

5. Select the Services tab.

The Services tab lists the available communications protocols and provides options for 
enabling/disabling each protocol for the router.

6. Select the Enable Walkabout box.

7. Click Apply.

8. Follow the procedure “To assign the initial static IP address to the NRG using Walkabout”.

To use an USB drive to set the IP address of the NRG

1. Format a USB drive as FAT32.

 Ensure the USB drive does not already contain a network configuration file.

2. Plug the USB drive into the USB port on the back panel of the NRG.

3. Wait approximately 30 seconds.

4. Unplug the USB drive from the USB port on the back panel of the NRG.

5. Plug the USB drive into your local machine.

6. Verify that a file named <PRODUCT>.<SERIAL>.ip_setting_0.txt was created on the USB drive.

7. View the file to ensure it contains the current IP configuration of the NRG.

In the following example, the user is verifying the configuration of an NRG-FR1 that is set to the 
default values.

 Contact Ross Technical Support for a default file if your USB drive file does not include the 
configuration information or if the file was not copied to your USB drive.

8. Copy the <PRODUCT>.<SERIAL>.ip_setting_0.txt to your local machine.

9. Edit the copied file by updating the DHCP, Address, and Gateway fields to the required values.

10. Rename the edited file to nrg.network

11. Copy the updated nrg.network file from your local machine to the USB drive.

12. Delete the old <PRODUCT>.<SERIAL>.ip_setting_0.txt from the USB drive.

13. Eject the USB drive from your local machine.

14. Plug the USB drive into the USB port on the on the back panel of the NRG.

[Match]
Name=bond0

[Network]
DHCP=0
Address=192.168.20.141/24
Gateway=192.168.20.1
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15. Wait approximately 30 seconds.

16. Unplug the USB from the NRG.

17. Proceed to “To manually add the NRG router to the Tree View in DashBoard” using the 
values you specified in step 9.

Troubleshooting Tips
• If the NRG accepts the new IP changes, the file will be renamed from nrg.network to 

nrg.network.success.
• If the NRG does not accept the new changes, the file will be renamed to nrg.network.failure.
• If the NRG still does not report valid settings, restart the NRG router and contact Ross Technical 

Support.

Add the NRG Router to the Tree View in DashBoard
Once you assigned the NRG router a static IP address, you can then manually add it to the Tree View 
in DashBoard. Manually adding the NRG router displays its node in the Tree View, granting you 
access to the interfaces described in the “Navigating the NRG Interfaces in DashBoard”.

To manually add the NRG router to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Select Equipment or Service Type to Add dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.
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6. Enter the IP address for the router in the IP Address field that you assigned in “To assign the 
initial static IP address to the NRG using Walkabout”.

7. Perform one of the following steps:

• In the text fields provided, enter the display name for the NRG, and port of the panel you wish 
to add; or

• Click Detect Frame Information to automatically retrieve the connection details.

8. Click Finish. 

Updating the Network Settings for the NRG Router
 This section is not applicable if your router is already set to the correct IP address.

Once you establish initial communications with the NRG router, and it displays in the DashBoard 
Tree View, you may wish to review or change the IP address and other settings according to your 
facility network requirements.

 This procedure requires a reboot of the router.

To update the network settings for the NRG router

1. Locate the NRG in the Tree View of DashBoard.

2. Expand the NRG node to display a list of sub-nodes in the Tree View.

3. Double-click the Product Info node.

4. Select the Network tab.

5. Locate the Settings area.

6. Edit the fields as required.

 Do not assign the NRG to an IP address in the range of 192.168.12.0-192.168.12.255. These are 
reserved addresses.

7. Click Apply.

8. Click Reboot. This button is located at the bottom of the window. 

 The NRG will need to be re-added to the Tree View in DashBoard using the new IP address. Refer 
to “Add the NRG Router to the Tree View in DashBoard”.
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Re-naming the NRG Router
If you installed multiple NRG routers in your system, each router must have a unique name 
assigned to it. This ensures that the router is easily identifiable in the Walkabout interface and 
uniquely identifies its inputs and outputs in the DashBoard database interfaces.

Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.slot.Port.Type.Channel where Frame identifies 
the physical router chassis housing the matrix/matrices. By default, each NRG router ships with the 
name “NRG” automatically set. By re-naming each NRG router, you are providing a unique identifier 
for the sockets within the router system.

Re-naming the NRG Router via DashBoard
Each NRG router can be given a unique name that is used on internal menus and as the identifier in 
the tree views of DashBoard. 

 Changing the router name after database configuration takes time to propagate through the 
system, and for DashBoard to reconnect, resuming stable system operation. Sufficient time must 
be allowed when making this change before attempting to use the system. This time will vary 
depending on features, matrix size, and configuration. The router name is typically assigned 
during initial commission and very rarely ever changed again.

 This procedure requires a reboot of the router.

To re-name the NRG router via DashBoard

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the NRG router.

 The NRG router does not support Unicode characters.

4. Press Enter to apply the new name.

5. Click Reboot.

 It may take several seconds or more for the NRG node name to update in the Tree View of 
DashBoard.

Configuring Access for DashBoard Clients
You can specify which DashBoard clients on your network can access and connect to your NRG. By 
default, the Permitted Clients list is blank, allowing all DashBoard clients on your network to 
connect to your NRG.

For More Information on...
• the use of Role-Based Access Control within DashBoard, refer to “Enabling RBAC for an NRG”.

To enable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. Locate the Permitted Clients area of the Network tab.

4. Click Add in the Permitted Clients area of the Network tab.
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The Add Address dialog opens.

5. Use the IP Address field to specify the IP address of the DashBoard client you wish to grant 
access to your NRG.

6. Click Apply.

The Add Address dialog closes.

The Dashboards list in the Permitted Clients area updates to display the specified IP address.

7. Repeat steps 4 to 6 for each DashBoard client you want to allow access.

 Ensure that the IP address for your DashBoard client machine is also added.

8. Click Apply in the Permitted Clients area to apply the change.

To disable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. From the Dashboards list, select the IP address for the DashBoard client you want to disable 
access for.

 Do not delete the IP address for your DashBoard client machine.

4. Click Delete in the Permitted Clients area of the Network tab.

5. Click Apply in the Permitted Clients area to apply the change.

Establish Communication with Devices
Once the NRG displays in the Tree View of DashBoard, it can communicate with other DashBoard 
Connect devices. 

When DashBoard is launched, devices such as openGear frames and Ross routers, are listed and 
made available in the Tree View. DashBoard uses the open SLP protocol to locate devices on the 
same network as the computer running the DashBoard client software. There are two methods for 
adding a device to the Tree View in DashBoard: using the auto-connect feature of DashBoard or 
manually adding a device by specifying the IP address of the device.

 Third-party device information is not automatically retrieved. These devices must be added 
manually. 

Communications between NRG and the Devices in a Routing System
While DashBoard enables you to locate devices in your network, the NRG still needs to establish 
communications with the devices and define how they are connected (a connection point). Each 
external device must have a connection point defined in the NRG database. For those devices that 
are not directly connected to your network, such as Ross NK Series routers and remote control 
panels, you must manually add their connection information (port number) to the NRG database. 
Once this information is entered into the database, the device matrices, inputs, and outputs can be 
managed via the database.

For More Information on...
• enabling a communication protocol, and configuring the additional settings on the NRG for each 

protocol, refer to “Enabling a Service”.
• adding a device (connection point) to be included and controlled via the NRG database, refer to 

“Adding Connection Points”.
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Enabling Remote Controller Mode
If the NRG will be in a routing system that is managed by an Ultricore BCS, the NRG must first have 
its Remote Controller Mode enabled. This allows the NRG to be controlled by the Ultricore BCS in 
the routing system. Once this mode is enabled, you cannot access the NRG databases. You will 
create and manage the databases for your routing system via the Ultricore BCS.

For More Information on...
• the Ultricore BCS, refer to the Ultricore BCS User Guide.
• database management with an Ultricore BCS, refer to the Ultrix and Ultricore Database Guide.

To enable the Remote Controller Mode on the NRG

1. In the Tree View of the NRG, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Setup tab.

3. Locate the Control Mode area.

4. Select the Remote Controller Mode box.

5. Wait for the new setting to be applied.

6. Verify that the NRG tree no longer displays its Database nodes.

7. Create a connection point from the Ultricore BCS to the NRG as outlined in the Ultrix and 
Ultricore Database Guide.

How a Database Determines the Routing System
The various database tables within an NRG determine if a signal/route can be made from input to 
output. 

For a given level, if there is a physical port mapped, for the same physical device, in both the Source 
and Destination interfaces, and the controlling device has the level enabled, then a crosspoint 
switch can be issued and executed on the NRG. 

Table 1 outlines a database with four levels. Level 1 has mapped valid Sources and Destinations, 
and the level is enabled on the controlling device. 

Using the Default Database
Upon initial bootup, the NRG automatically creates a default database as follows:

Table 1  Example of a Multi-Level Database Setup

Level 1 Level 2 Level 3 Level 4
Is a physical source assigned?  xa

a. An entry is not present in the corresponding Level column of the Source interface.

 

Is a physical destination assigned?   xb

b. An entry is not present in the corresponding Level column of the Destinations interface.

x

Is the Level enabled on the Controller device?    x

Can a switch be executed? c

c. A switch will be executed.

xd

d. A switch will not be executed. Physical ports from the same logical matrix must be entered in the 
same control level before a connection can be made.

xd xd
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1. Creates one router level.

2. Defines the sources and destinations (one-to-all mapping) for all detected inputs and outputs. 

 The I/O labels use the nomenclature of NRG.slot1.Port[#].Type.Channel. For example 
NRG-FR1.slot1.out[4].SDI.ch1.

3. Creates two soft panels that includes all levels, destinations, and sources of the default 
database.

Creating a New Database
You can choose to use the default database, or create a new database based on your routing 
requirements. Refer to “Creating a New Database” and “Defining a Database”. 

You can also choose to copy the default database to create a new version to edit as required. Refer 
to “Copying a Database”.
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Using DashBoard
The DashBoard client software enables you to monitor and control devices in your routing system 
from a computer. The NRG requires DashBoard for configuration and operation. The interfaces are 
accessed by expanding the main NRG node in the DashBoard Tree View and selecting the 
appropriate sub-node. This chapter outlines the NRG tree nodes in DashBoard, and how to navigate 
these nodes.

If you have questions pertaining to the operation of the NRG, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

For More Information on...
• the DashBoard client software, refer to the DashBoard User Guide.
• accessing DashBoard, refer to “Launch DashBoard”.
• specific NRG sub-nodes, refer to “Product Info Interfaces”, “System Interfaces”, and “Database 

Interfaces”.

NRG in DashBoard
NRG groups the configuration, monitoring, and operating features in a Tree View in the DashBoard 
client window. Each node of the tree opens to reveal one or more sub-nodes, giving access to the 
features for your router.

Figure 1  Example of the NRG Nodes in a DashBoard Window

NRG includes the following interfaces, as separate nodes, in the DashBoard Tree View.

Product Info
Double-click the Product Info node to display this interface in the right pane of the DashBoard 
window. The interface is organized into two areas: Status (read-only) tabs located on the left, and a 
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series of configuration options (tabs) located on the right. Refer to “Product Info Interfaces” for 
more information.

System
The System tree has five sub-nodes: NRG, Connections, NRG-MV, LCP, and Logs. Refer to “System 
Interfaces” for more information.

• NRG — enables you to monitor the hardware (temperature, fans, power, ethernet, storage, 
reference) and the I/O signals. 

• Connections — enables you to specify the protocol(s) the NRG router will use to communicate 
with an external device. Refer to “Enabling a Service” for details.

• NRG-MV — enables you to manage your NRG-MV licenses, and configure the Multiviewer Head 
settings for your router. Refer to “NRG-MV Setup” for details.

• LCP — enables you to customize the button colors and functions on the NRG-FR1-LCP and 
NRG-FR2-LCP routers. This sub-node is only applicable to the NRG-FR1-LCP or NRG-FR2-LCP. 
Refer to “Configuring the LCP Buttons”.

• Logs — displays read-only information that is used by Ross Technical Support for diagnostic and 
troubleshooting purposes.

Database
Expanding the Database node enables you to configure the databases, matrices, destinations, 
sources, groups, levels, soft panels, and salvos for the NRG routing system. Refer to “Database 
Interfaces”, “Creating a New Database”, and “Defining a Database”.

Control
The Control sub-node provides access to the configured soft panels available on the NRG router. 
Refer to “Soft Panels in DashBoard” for more information.

Navigating the NRG Interfaces in DashBoard
The interfaces are accessed by expanding the topmost NRG node in the DashBoard Tree View and 
selecting the appropriate sub-node. Several of the interfaces are organized in a table layout with a 
toolbar on the bottom, and a toolbar on the left side of the tab.

For More Information on...
• the Database interfaces for your router, refer to the Ultrix and Ultricore Database Guide.

To access the NRG interfaces in DashBoard

1. Ensure that DashBoard is running. Refer to “Launch DashBoard”

2. Locate the NRG node in the Tree View of DashBoard

3. Expand the NRG sub-node.

4. Double-click the Product Info sub-node to display that interface in the right pane of the 
DashBoard window.
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The Product Info interface is two panes within the same DashBoard window: status (read-only) 
fields in the left pane, and a series of tabs with configurable menus and settings in the right 
pane. Refer to “Product Info Interfaces” for more information.

5. Expand the System sub-node.

The System tree includes the following sub-nodes: NRG, Connections, NRG-MV, LCP, and Logs. 
Refer to “System Interfaces” for more information.

6. Expand the Database sub-node.

The Database Manager and Configuration sub-nodes display. Double-click the Database 
Manager sub-node to create, activate/inactive, and delete databases on this router. You can 
also backup and restore databases using the Import/Export options in the Database Manager 
toolbar. Expand the Configuration sub-node to list the options available for configuring a 
database. Refer to “Database Interfaces” for more information.

7. Expand the Control sub-node.

Each sub-node is a configured soft panel in your routing system. A soft panel is a DashBoard 
interface that represents a panel of buttons that is used to make crosspoint switches in your 
routing system. By default, there are two pre-configured soft panels that are available for 
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immediate use. But you may create more to suit your routing needs. Refer to “Soft Panels in 
DashBoard” for more information.
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Product Info Interfaces
The Product Info interfaces provide hardware information, network settings, access controls, 
options for creating backups of your settings, and general management for your router. This 
chapter summarizes the Product Info interfaces.

Overview
The Product Info interface displays two panes within the same DashBoard window: status 
(read-only) fields in the left pane, and a series of tabs with configurable menus and settings in the 
right pane. (Figure 2)

Figure 2  Example of the Product Info Interface for an NRG

The following sections briefly outline each tab displayed on the Product Info interface starting with 
the leftmost tab.

Product Tab
The Product tab provides read-only information about the general hardware and software status. 

Table 2 summarizes the read-only information displayed in the Product tab.

Table 2  Product Info — Product Tab

Item Parameters Description
Product <text> Indicates the product name

Vendor <text> Indicates the supplier/manufacturer

System Version # Indicates the build version

Serial Number # Indicates the serial number 
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Other Tab
Table 3 summarizes the read-only information displayed in the Other tab.

Network Tab
The Network tab provides network setup options and options to specify DashBoard client access.

Figure 3  Example of the NRG Product Info > Network Tab

Uptime #h #m #s Indicates the number of hours since the last reboot

System time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the internal 
clock (if no connection to an NTP Server is available) 
where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time

Table 3  Product Info — Other Tab

Item Parameters Description
Frontend SW Rev # Read-only information used by Ross Technical 

Support.Backend SW Rev #

Device FW Rev #

Table 2  Product Info — Product Tab (Continued)

Item Parameters Description
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Table 4 summarizes the fields and menus displayed in the Network tab.

Table 4  Product Info — Network Tab

Item Parameters Description
Information (Read-only)

Active ENET ENET # Indicates the ETH port on the NRG is the 
primary network connection

ENET 1 Link Connected (x, y) Indicates that a valid network link is configured 
on the ETH port of the NRG where:
• x represents the connection speed (Mbps)
• y represents the link type (e.g. full duplex)

Not Connected Ethernet communications for the NRG are 
invalid. The ethernet cable may be disconnected 
on the rear panel or the ethernet network may 
be down or experiencing problems.

ENET MAC <number> Indicates the MAC address for the NRG 

Settings

IP Mode Static The user manually specifies the network 
settings for the device

Static DHCP The DHCP service for your network assigns the 
network settings to the router. Once the 
settings are validated, they are static.

Address ###.###.###.### Specifies the IP address for the device

Subnet Mask ###.###.###.### Specifies the subnet mask for the device

Gateway ###.###.###.### Specifies the gateway for communication 
outside of the local area network (LAN)

Cancel Discards any unsaved changes made to the Address, Subnet Mask, 
and Gateway settings and reverts back to the current running values.

Apply Updates the Address, Subnet Mask, and Gateway settings

Permitted Clients

DashBoards: # Lists the IP address of each DashBoard client 
that is allowed to communicate with this device

Add Enables you to add a new DashBoard client to the Permitted Clients 
list

Delete Deletes the selected DashBoard client from the Permitted Clients list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the Permitted Clients list

Cancel Discards any unsaved changes made to the Permitted Clients list and 
reverts back to the current running values

Apply Updates the Permitted Clients list settings
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Setup Tab
The Setup tab provides global settings such as assigning a device name, enabling remote control 
mode on a router, and determining access to the NRG. (Figure 4)

Figure 4  Example of the NRG Product Info > Setup Tab

Table 5 summarizes the options displayed in the Setup tab. 

Table 5  Product Info — Setup Tab

Item Parameters Description
Device Identification

Device Name <name> Provides a unique identifier for the router in the 
Tree View of DashBoard 

System Name <name> Provides a unique identifier for the routing system

Control Mode

Remote Controller 
Mode

Selected Enables the primary device (usually an Ultricore 
BCS) in your routing system to control this NRG 
router. This also hides the Database nodes in the 
Tree View.

Cleared This router cannot be controlled and monitored by 
a primary device

DashBoard Interface

DashBoard Timeout 30-300s Sets the maximum number of seconds that 
DashBoard waits until it queries NRG. The default is 
70 seconds. 

Update Applies the new value in the DashBoard Timeout menu

RPM Role Based 
Access Control 
Required (read-only)

On Any DashBoard without RPM will not be allowed to 
connect to the device unless the user enters a 
'master password'

Off Disables RBAC support
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Storage Tab
Table 6 summarizes the read-only displayed in the Storage tab.

Change Role Based 
Access Settings

Displays the Change RBAC Settings dialog. Refer to 
“Role-Based Access Control” for details.

Include Channel 
Maps in Source & 
Destination 
Parameters

Selected Allows a database to match the quantity of BNC I/O 
fitted in the router. 
Each input / output SDI port will be mapped to 
default labels of SRC xx and DST xx respectively.
• I/O mapping occurs for Level 1 only (Video)
• the Sources field is ignored
• the Destination field is ignored
• the Level field is applied

Cleared Disables this option

Table 6  Product Info — Storage Tab

Item Parameters Description
Internal OK There are no storage space issues detected

WARNING Less than 20% of the storage space is available

CRITICAL Less than 10% of the storage space is available

Table 5  Product Info — Setup Tab (Continued)

Item Parameters Description
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Role-Based Access Control
This chapter outlines the use of Role-Based Access Control (RBAC) within the DashBoard software 
application for the NRG.

Before You Begin
Ensure the following:

• The Ross Platform Manager and appropriate licenses are purchased to use RBAC features.
• The RPM Server is configured and added to DashBoard.
• The permissions for the devices in your routing system are defined via the Ross Platform 

Manager.

For More Information on...
• configuring the Ross Platform Manager and Server, refer to the DashBoard RPM User Guide.
• the Ultricore Profiles feature, refer to the Ultrix and Ultricore Database Guide.

Enabling RBAC for an NRG
The RBAC feature determines access to an individual NRG via a DashBoard instance (client). Once 
RBAC is enabled, any DashBoard without RPM will not be allowed to connect to the NRG unless the 
user enters a 'master password'. 

• If a DashBoard instance has RPM and the account for the current user is configured to allow 
access to the NRG, the user will be able to continue using the NRG. 

• If the user does not have access, the NRG will be disconnected from DashBoard until a user with 
access rights is signed-in.

To enable RBAC on an NRG

1. Launch DashBoard.

2. Locate the NRG node in the Tree View.

3. Expand the NRG node to display a list of sub-nodes.

4. Expand the NRG sub-node.

5. Double-click the Product Info sub-node.

The Product Info interface displays.

6. Select the Setup tab.

7. Locate the RPM Role Based Access Control Required area.

8. Click Role Based Access Settings.

The Change RBAC Settings dialog opens.

9. From the RPM Role Based options, select On.

  The RPM Role Based is set to Off by default.

10. Use the Client Master Password field to specify the text string a user can enter to gain access 
to this device when RPM is not present in DashBoard or if DashBoard is unable to connect to 
the RPM Server.
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11. Click Done.

• The Change RBAC Settings dialog closes.
• On the Setup tab, the RPM Role Based Access Control Required field now reports On.

To verify that RBAC is enabled

1. Close the Product Info interface in DashBoard.

2. Locate the device node in the DashBoard Tree View.

3. Right-click the device node.

4. Select Disconnect.

The device node displays a grayed out icon.

5. Right-click the device node.

6. Select Connect.

The device node displays with a lock icon. Any user attempting to access this device will be 
prompted to enter the password specified in step 10 in the previous procedure. 

Accessing a Device with RBAC Enabled
Once the NRG is accessed through DashBoard are configured to require connection to an 
authenticated DashBoard instance (client), connection requests from unauthenticated sources are 
declined. A Lock icon displays next to the NRG node in the Basic Tree View to indicate that RBAC is 
enabled for that device. If RBAC is enabled but your system is not using an RPM Manager or Server 
or the RPM Server is unavailable, you will need to enter a Client Master Password to gain access to 
the device. This section outlines how to use a Client Master Password to access a device when RBAC 
is enabled.

 If RPM is used, access to the device is based on the privileges of the current user signed into 
DashBoard.

For More Information on...
• managing access control in DashBoard, refer to the DashBoard RBAC User Guide.

To access an NRG when RBAC is enabled

1. Locate the NRG node in the Tree View of DashBoard.

Notice that the node displays an icon with a lock symbol.

2. Double-click the NRG node.

The Password dialog opens.

3. Enter the password as defined in step 10 of “To enable RBAC on an NRG”.

4. Click Login.

The Password dialog closes and the NRG node displays a green icon and its tree nodes are 
accessible.

 Entering an incorrect password denies access and the device icon is lit red.



NRG User Guide (v1-rev1) System Interfaces • 37

System Interfaces
The System interfaces enable you to monitor the hardware, signal status, and the routing system 
devices that are communicating with the NRG. From the System tree you can also configure the 
NRG Multiviewer licensed feature (NRG-MV), and configure the NRG-FR1-LCP or NRG-FR2-LCP front 
panel buttons. This chapter summarizes each System interface.

Overview
By default, the NRG > System tree has five sub-nodes: NRG, Connections, NRG-MV, LCP, and Logs. 
Double-click a sub-node to displays its interface in the right pane of the DashBoard window.

 The LCP sub-node is only applicable to the NRG-FR1-LCP or NRG-FR2-LCP. Refer to “Configuring 
the LCP Buttons”.

Figure 5  Expanded NRG > System Nodes in the Tree View

NRG Interface
The NRG interface provides an overview of the NRG hardware and connections. (Figure 6 and 
Figure 7) From this interface you can monitor the hardware (internal temperature, fan operation, 
and PSU connections), the input signals (Sources), and the output signals (Destinations). 

Figure 6  Example of an NRG-FR1 Interface
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Figure 7  Example of an NRG-FR2 Interface

Table 7 summarizes the fields displayed in the NRG interface. 

Table 7  System — NRG

Item Parameters Description
Alarms

Temperature 
(read-only)

OK (Green) Indicates that the chassis core components 
temperature is within the normal range

Warning (Yellow) Indicates that at least one chassis core component 
temperature is between 90°C and 100°C (194°F and 
212°F)

Failed (Red) Indicates that at least one chassis core component 
temperature is above 100°C (212°F)

Fan (read-only) OK (Green) Normal operation; no hardware errors are 
associated with the chassis fan

Failed (Red) Indicates that the fan is not functioning correctly. 
Contact Ross Technical Support.

PSU 1 (read-only) OK (Green) • Indicates that PSU 1 is detected and connected to 
a valid power source

• Normal operation with no hardware errors

Failed (Red) Indicates a valid connection to PSU 1 is not detected

PSU 2 (read-only) N/A Indicates the status of PSU 2 is not applicable (e.g. 
(e.g. the Redundant power box is not selected)

OK (Green) • When in redundant power mode, this indicates 
that PSU 2 is detected and connected to a valid 
power source

• Normal operation with no hardware errors

Failed (Red) When in redundant power mode, this indicates a 
valid connection is not detected
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ENET 1 (read-only) OK (Green) Indicates that a valid network link is configured on 
the ENET 1 port

Failed (Red) Ethernet communications on the ENET 1 port are 
invalid. The Ethernet cable may be disconnected on 
the NRG back panel or the network may be down or 
experiencing problems

ENET 2 (read-only)
(NRG-FR2 and 
NRG-FR2-LCP only)

N/A Indicates the status of the ENET 2 port is not 
applicable (e.g. the Redundant ethernet box is not 
selected)

OK (Green) When in redundant ethernet mode, this indicates 
that a valid network link is configured on the ENET 2 
port

Failed (Red) When in redundant ethernet mode, this indicates 
ethernet communications on the ENET 2 port are 
invalid. The Ethernet cable may be disconnected on 
the NRG back panel or the network may be down or 
experiencing problems.

Storage Space 
(read-only)

OK (Green) There are no storage space issues detected

Warning (Yellow) Less than 20% of the storage space is available

Critical (Red) Less than 10% of the storage space is available

Redundant power Selected Monitors the additional power supply (PSU 2) 
connected to the NRG back panel. 
In the event of a power loss on one PSU, the router 
will automatically switch to the second PSU port.

Cleared Additional power supply (PSU 2) is not monitored

Redundant ethernet 
(NRG-FR2 and 
NRG-FR2-LCP only)

Selected Monitors the redundant ethernet link, ENET 2, 
connected to NRG back panel. 
In the event communication is lost on a link, the 
router will automatically switch to the second 
Ethernet port. 

Cleared The redundant ethernet link (ENET 2) is not 
monitored

Reference

Status (read-only) OK (Green) Reports the status on the input reference signal 
connected to the REF port on the NRG back panelNo Sync (Yellow)

Detected format 
(read-only)

<text> Reports the video format detected on the input 
reference signal connected to the REF port on the 
NRG back panel

Default NTSC If you did not connect a reference source signal to 
the REF port on the NRG rear panel, use this menu 
to specify the default reference format for the NRG 
router.
If you connect a valid reference source to the REF 
port, it will take precedence over the Default setting

PAL

Table 7  System — NRG (Continued)

Item Parameters Description
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Trigger

Format Custom Enables you to specify a custom switching time

<format> Select a format to specify the switch timing that will 
be used by the NRG when switching inputs/outputs

Custom (μs) # Specifies the time (number of microseconds) from 
the start of the custom switching line to the actual 
switching event

Signal Status > Sources

ID (read-only) # Auto-numbered field. This is not used within the 
routing system itself, however, third-party 
protocols that do not support labels will reference 
this field in their communications.

Label <text> Assigns a unique identifier (label) for the source in 
the routing system. This label is used by control 
interfaces/devices

Signal Status 
(read-only)

 <format> Indicates the video format detected is supporteda 
and the signal is valid on the specified socket

Indeterminate Indicates the video format is detected but is not 
supported on the specified socket. The signal is not 
processed/passed.

 No Signal Indicates that the video format cannot be detected 
on the specified socket 

Signal Mode SDI Video Identifies the input signal as SDI video (default)

MADI Identifies the input signal as MADI (audio) only. The 
video data is ignored.

DVB-ASI Identifies the input signal as carrying MPEG-TS data 
up to 270Mbps.

Signal Status > Destinations

ID (read-only) # Auto-numbered field. This is not used within the 
routing system itself, however, third-party 
protocols that do not support labels will reference 
this field in their communications.

Label <text> Assigns a unique identifier to the destination in the 
routing system. This label is used by control 
interfaces/devices.

Signal Status 
(read-only)

 <format> Indicates the video format detected is supportedb 
and the signal is valid on the specified socket

Indeterminate Indicates the video format is detected but is not 
supported on the specified socket. The signal is not 
processed/passed.

 No Signal Indicates that the video format cannot be detected 
on the specified socket 

a. Refer to the NRG Installation Guide for a list of supported formats.
b. Refer to the NRG Installation Guide for a list of supported formats.

Table 7  System — NRG (Continued)

Item Parameters Description
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Connections Interface
Double-click the Connections sub-node to display a series of tabs in the right pane of the 
DashBoard window. (Figure 8) 

Figure 8  Example of the NRG > Connections > Incoming Connections Tab

The Connections interface lists and configures the connection points in your routing system. The 
interface is organized into three tabs: Incoming Connections, Services, and Protocol Servers. The 
following sections outline each tab.

Incoming Connections Tab
The Incoming Connections table lists the connection details of remote client devices under the 
supervision of the active database currently communicating with the router. (Figure 8)

Table 8 summarizes the fields displayed in the Incoming Connections tab. 

Table 8  Connections — Incoming Connections

Item Parameters Description
Device ID <name> Specifies the external device for the connection 

point

Name <name> Assigns a unique identifier for the device in the 
routing system. This name is also used when 
matrices are defined in the system.

Protocol GVG Native The device uses the third-party GVG protocol to 
communicate

OGP This device uses the openGear protocol to 
communicate

Probel SW-P-08 The device communicates via the Probel SW-P-08 
protocol

Ross NK The device uses the Ross NK protocol to 
communicate (T-Bus or TCP only)

RossTalk The devices communicates via the RossTalk 
protocol
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Services Tab
The Services tab provides options for enabling/disabling a communication protocol for the router. 
(Figure 9)

Figure 9  Example of the Connections > Services Tab

Table 9 summarizes the options displayed on the Services tab.

 

Communication tcp   The device is communicating over a network 
connection. Note that the DashBoard client 
computer, the router, and the external device must 
be on the same network.   

ip: # Specifies the IP address of the device on the 
network

ip: localhost Specifies that the device is the router you are 
currently configuring

port:##### Specifies the ethernet port the devices is associated 
with on the network

Details <text> Provides a short textual description of the device

Table 9  Connections — Services

Item Description
SSH service Enables the ability to log onto the NRG via an SSH server. 

Secure Shell (SSH) Login is a client-server protocol used by system 
administrators to securely log onto remote systems and execute 
commands over an unsecured network. SSH may also be used by 
Technical Support for advanced troubleshooting.

Walkabout Enables the NRG to communicate with devices in the Walkabout 
system

Table 8  Connections — Incoming Connections (Continued)

Item Parameters Description
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Protocol Servers Tab
The Protocol Servers tab lists the currently active servers running in the routing system. (Figure 10) 
This tab is auto-populated based on the external devices on the same network as your NRG and the 
protocols (services) that you enabled on the Services tab.

Figure 10  Example of the Connections > Protocol Servers Tab

Table 10 summarizes the fields displayed in the Protocol Servers tab.

GVG Native Enables the NRG to communicate via the GVG Series 7000 Native 
protocol and is available over an ethernet connection.

Probel SW-P-08 Enables the NRG to communicate via the Probel SW-P-08 protocol. 
This protocol is available over an ethernet connection.

RossTalk Communications via the RossTalk protocol (a plain text based protocol 
that allows control of Ross Video equipment)

NK/RCP Enable this option if there are Ross NK series routers and/or remote 
control panels (RCP) in your routing system. 
The Ross NK series devices must be connected to the ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable 
communication with the NRG.

Enable Upgrades & 
Support Access

Remote access and upgrades are disabled by default (the Upload 
button is disabled in the DashBoard interfaces). Remote upgrades 
may optionally be enabled through DashBoard via this option. 

On boot-up or power cycle, this option will default back to disable 
(box is unselected). You must select the box again if you wish to 
enable web access and firmware upgrades after a boot-up or 
power cycle.

Table 9  Connections — Services (Continued)

Item Description
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Server Options Dialog

Click Options (located in the bottom left corner of the Protocol Servers interface) to display the 
Server Options dialog. The dialog provides additional settings for each the communication 
protocols that the NRG uses for connecting to external devices. Refer to the user documentation for 
your external device to learn more about what settings are required.

Table 11 summarizes the fields displayed in the Server Options dialog.

 

Table 10  Connections — Protocol Servers

Item Description
Name Indicates the unique identifier for the server in the routing system. 

This name is also used when matrices are defined in the system.

Communication Indicates the communication protocol, IP address, Port Number, and 
configuration details of the active device

Options Displays additional settings for each supported protocol.

Table 11  Connections — Protocol Servers > Server Options

Item Parameters Description
GVG Native

L4 Echo No The Ethernet Layer 4 acknowledge is disabled. This 
is the default.

Yes The Ethernet Layer 4 acknowledge is enabled

Sequence More to 
Come Character

# Enables the user to assign a number to the 
seq_flag field in a packet that will indicate more 
messages to come. The default value is 9.
A value of 0 (zero) indicates the last or only packet.

Send Trailing HT Yes Includes the trailing <HT> character (Horizontal Tab 
(0x09)) in the packet

No The trailing <HT> character is not included in the 
packet

Send nbr_sources 
Leading Zero

Yes Always forces the nbr_sources field to be 2 ASCII 
characters (e.g. 1 becomes 01). This supports 
fragmentation of large message streams.

No Allows the nbr_sources field to be a single ASCII 
character

Repeated Packet 
Holdoff (ms)

# NRG detects repeated identical packets, and will 
skip processing if the packets are repeated within 
the specified delay. The default is 0.

Probel SW-P-08

Protocol Variant Use Last Req The NRG will respond using protocol variant 
(extended/non-extended) as per the received 
request format. This is the default.

Non-Extended NRG will always reply using non-extended 
formatting

Extended NRG will respond with extended formatting
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NRG-MV Interface
The NRG-MV interface enables you to manage the NRG-MV license(s) for your NRG. Once an 
NRG-MV license is enabled on the NRG, you can configure the settings for the Multiviewer Head(s). 
(Figure 11) Refer to “NRG-MV Setup” for more information on this licensed feature.

Matrix Mode No NRG will use information from the LEVEL section of 
the protocol to control NRG levels

Yes NRG will use information from the MATRIX_ID 
section of the protocol to control NRG levels

Do not wait for ACK No NRG will wait for message acknowledgments 
between connect responses. This is the default.

Yes NRG will not wait for message acknowledgments 
between connect responses

Batch Collate Time 
(ms)a

# Wait up to 100 milliseconds for multiple commands 
received before processing. The default is 0 (which 
disables this feature).

Batch Collate Split 
Size (# of 
commands)

# Wait up to 100 received commands before 
processing. The default is 0 (which disables this 
feature).

Unused Field # Send number (0-15) in either Level or Matrix field - 
which ever is not used as per Matrix Mode setting. 
The default is 0.

Probel Filter Yes Probel SW-P-08 crosspoint tally responses are 
provided when there are no status changes 
resulting from the crosspoint connect message

No Removes the Probel Crosspoint Switch filter

Repeated Packet 
Holdoff (ms)

# NRG detects repeated identical packets, and will 
skip processing if the packets are repeated within 
the specified delay. The default is 0.

Follow Level 
Enabled

Yes Enables a user to configure a specific level to act as 
a “Follow” level. When a “Connect Crosspoint” 
message with this level is received, Ultrix/Ultricore 
will issue a Take command for all database levels.

No Disables this feature

Follow Level # Specifies the routing level for Probel that signals a 
follow/all-level Take

a. When the Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will 
release the batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 11  Connections — Protocol Servers > Server Options (Continued)

Item Parameters Description
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Figure 11  Example of the NRG-MV Interface with One Multiviewer Head

Table 12 summarizes the fields and settings displayed in the NRG-MV interface. 

Table 12  System — NRG-MV

Item Parameters Description
NRG-MV License

Request code # This character string is used to obtain an NRG-MV 
license key

License key # The license key that was provided for this router

Count # Indicates the number of available licenses on this 
router

Apply Click this button to apply the changes to the 
NRG-MV license(s) settings

Output DisplayPort Passthrough The DisplayPort (DP) port on the NRG back panel is 
not assigned to a Multiviewer Head.
This assigns 1080p monitoring passthrough to the 
DP port output. 
Refer to the NRG Installation Guide for more 
information on the DP port.

Head 1 Assigns Multiviewer Head 1 as the output for the DP 
port on the router 

Head2 Assigns Multiviewer Head 2 as the output for the DP 
port on the router.
This is only applicable when using an NRG-FR2 or 
NRG-FR2-LCP with two NRG-MV licenses enabled.

slot#.head#
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Enable BNC output Selected The NRG-MV Head output is allocated to the 
following BNC:
• NRG-FR1, NRG-FR1-LCP: OUT 16
• NRG-FR2, NRG-FR2-LCP: OUT 33 (Head 1), OUT 34 

(Head 2). Note that each Head requires one 
NRG-MV license.

Cleared The NRG-MV Head is no longer the output on the 
OUT 16, OUT 33, or OUT 34 BNCs

Audio bar channels # Specifies the number of channels in a single block 
of audio meters. The maximum is 16.

EU meter bar Selected The audio level status is reported in real-time as a 
series of vertical bars that comply with European 
Union (EU) standards 

Cleared Disables the EU scale

Audio bar peak hold Selected The audio meters report the audio peak level 
measurements for your audio channels. 
Measurement units are in decibel full scale (dBFS) 
where 0dBFS is the maximum digital value.

Cleared The audio meters do not report the audio peak 
level

Output signal 
format (read-only)

# Reports the output video format for the specified 
NRG-MV Head.

This field reports the video format of the output 
on the designated NRG-MV Head BNC. If the BNC 
output is enabled, the video format is tied to the 
reference. If disabled (regular SDI output), the 
format will reflect what is being routed through 
that BNC.

PiPs (read-only) slot1.headx-pip[y] Identifies the NRG-MV PiP in your database where:
• x represents the head
• y represents the PiP in the head layout

UMD Selected Enables you to add a new label box to the specified 
PiP

Cleared Disables this feature

Meter Selected The specified PiP displays (up to 16 channels of 
audio) in a single block of audio meters as defined 
by the Audio bar channels, EU meter bar, and audio 
bar peak hold settings

Cleared Disables this feature

UMD label <text> • Defines the content of the UMD label box for the 
specified PiP. The label can include a maximum of 
24 characters.

• The label can be a string or simple text. 
• Supports Unicode characters

Table 12  System — NRG-MV (Continued)

Item Parameters Description
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LCP Interface
While the LCP interface displays for all NRG models, it is applicable only to the NRG-FR1-LCP and 

NRG-FR2-LCP. 

The tabs on the LCP interface enable you to customize the buttons the front panel of the router. 
The interface is organized into four sections: the top toolbar reports if the current configuration is 
the factory default or a customized layout. Under the toolbar is an image that represents the front 
panel buttons (which are selectable from the interface). A series of tabs displays under the router 
image, select a tab to access the settings, and options to customize the buttons. The bottom toolbar 
includes buttons for discarding or saving any recently edited settings. (Figure 12, Figure 13) 

Figure 12  Example of the LCP > Configuration Tab for an NRG-FR1 or NRG-FR1-LCP

Figure 13  Example of the LCP > Configuration Tab for an NRG-FR2 or NRG-FR2-LCP

The following sections summarize the tabs on the LCP interface.

 Each LCP tab includes the Cancel (bottom left corner) and Send Configuration to LCP (bottom 
right corner) buttons. After editing the settings of a tab, ensure to click Send Configuration to 
LCP to apply your changes.
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Configuration Tab
The Configuration tab provides menus and fields that determine the display and operation of the 
front panel buttons.

Table 13 summarizes the fields and settings displayed in the Configuration tab. 

Macros Tab
The Macros tab enables you to record a sequence of events (e.g. switches) to a macro. You can then 
assign the macro to a button on the front panel. The options are organized into a table where each 
macro is grouped into a series of rows with each row assigned to a task. A column represents a 
setting for a specific event within that macro. You begin by creating a new event and assigning it a 
task (e.g. switch, protect, etc.). The available settings in the subsequent columns depend on what 
task is assigned to that event.

For example, Figure 14 shows Macro 1 includes 3 events, while Macro 2 includes 2 events. 

Table 13  LCP — Configuration

Item Parameters Description
Alias Set Default No alias set is assigned to the router

<name> Assigns this label set to the NRG. This is useful 
when your system includes a mix of RCP and NRG 
and you wish to ensure the same labels are applied 
to all devices.

Cutbus Mode Off Disables this feature

Normal Creates a default switching panel that only affects 
assigned outputs on the router. Refer to “Normal 
Cutbus Mode”.

Cutbus 1 
Destination

# When operating in Normal mode, the Cutbus Dest 1 
equals Cutbus Dest 2

Cutbus 2 
Destination

# When operating in Normal mode, the Cutbus Dest1 
does not equal Cutbus Dest 2

Panel Brightness # Sets the LED brightness for the front panel buttons. 
The value range is from 0 (off) to 10 (maximum 
brightness). The default value is 5.

Protect Mode Block Other Panels The PROTECT button functions as a Protect. The 
protected destination and level(s) cannot be 
switched to another source by other remote control 
panels. The protected destination and level(s) can 
be switched to another source on the local remote 
control panel.

Block All Panels The PROTECT button functions as a Lock. The 
locked destination and level(s) cannot be switched 
to another source by the local remote control panel 
or other remote control panels.

Load Defaults All editable parameters in the LCP interfaces are reset to the factory 
default values
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Figure 14  Example of the LCP > Macros Tab for an NRG-FR1 or NRG-FR1-LCP 

Table 14 summarizes the fields and settings displayed in the Macros tab. 

1) Macro # 3) Task 5) Task Option 2 7) Buttons

2) Event # 4) Task Option 1 6) Selection

Table 14  LCP — Macros

Item Parameters Description
Macro # Auto-assigned number to the selected macro

Event # Identifies the event within this macro

Task Switch A crosspoint switch is performed by this event

Macro Another macro is launched by this event

Protect Creates a protect condition on the destination of 
the selected crosspoint

Salvo A salvo is performed by this event

Task > Switch

Destination # Allocates the specified destination to this event. 
Available only when Task is set to Switch or Protect.

Source # Allocates the specified source to this event. 
Available when the Task is set to Switch.

Selection # Assigns the router level for the event. Available 
when the Task is set to Switch or Protect.

Task > Macro

Macro # Allocates the specified macro to this event. 
Available only when Task is set to Macro.

Task > Protect

Destination # Allocates the specified destination to this event. 
Available only when Task is set to Switch or Protect.
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Key Colors Tab
The Key Colors tab enables you to assign a color to each button function. When the function is 
assigned to a button on the front panel, the button is lit the corresponding color. 

Figure 15  Example of the LCP > Key Colors Tab for an NRG-FR1 or NRG-FR1-LCP

Protect Condition Enable The Protect condition is applied by a Protect event. 
Available when the Task is set to Protect.Disable

Selection # Assigns the router level for the event. Available 
when the Task is set to Switch or Protect.

Task > Salvo

Salvo # Allocates the specified salvo to this event. Available 
only when Task is set to Salvo.

Buttons

Set All Selects all router levels (The NRG supports a maximum of 4 levels)

Clear All Clears all selected levels

Delete Removes the event from the macro

Add Event Displays a new row within the selected macro to add a new event

Table 14  LCP — Macros (Continued)

Item Parameters Description
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Figure 16  Example of the LCP > Key Colors Tab for an NRG-FR2 or NRG-FR2-LCP

Table 15 summarizes the fields and settings displayed in the Key Colors tab. 

Key Assignments Tab
The Key Assignments tab is used to assign functions to the buttons of the NRG-FR1-LCP or 
NRG-FR2-LCP.

Table 15  LCP — Key Colors

Item Parameters Description
Key Mode <mode> Specifies the function to assign a color to

Selected <color> Assigns the specified color for when the button is 
selected on the front panel

Off When the button is selected, it does not display a 
color

Default <color> Assigns the specified color to the button when it is 
not selected

Off The button does not display a color
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Figure 17  Example of the LCP > Key Assignments Tab for the NRG-FR1 or NRG-FR1-LCP

Figure 18  Example of the LCP > Key Assignments Tab for the NRG-FR2 or NRG-FR2-LCP

Table 16 summarizes the fields and settings displayed in the Key Assignments tab. 

Table 16  LCP — Key Assignments

Item Parameters Description
ID # Identifies the physical button on the front panel. 

Notice that selecting the row for an ID also lights 
the corresponding button on the panel map above 
the Key Assignment tab

Key Mode <name> Assigns a function to the selected button. The 
selected function determines the settings in the 
columns to the right of the Key Mode column.

Key Mode > Destination

Default DST # Assigns a specific output signal to the button when 
no Shift button is selected first
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Shift 1 DST # Assigns the output signal to the button when the 
Shift 1 button is selected first

Shift 2 DST # Assigns the output signal to the button when the 
Shift 2 button is selected first

Key Mode > Source

Default SRC # Assigns a specific input signal to the button when 
no Shift button is selected first

Shift 1 SRC # Assigns the input signal to the button when the 
Shift 1 button is selected first

Shift 2 SRC # Assigns the input signal to the button when the 
Shift 2 button is selected first

Key Mode > Crosspoint

Destination DST # Selects the physical output that connects to the 
item of destination equipment to which you want to 
switch

Source SRC # Selects the physical input that connects to the item 
of source equipment that provides the required 
signal

Mask # Selects the breakaway level that you want to use for 
the switch

Key Mode > Shift

DST Shift 1 Assigns the output signal to the button when the Shift 1 button is selected 
first

DST Shift 2 Assigns the output signal to the button when the Shift 2 button is selected 
first

SRC Shift 1 Assigns the input signal to the button when the Shift 1 button is selected 
first

SRC Shift 2 Assigns the input signal to the button when the Shift 2 button is selected 
first

Key Mode > Macro

Macro # Assigns the specified macro to this button. The 
macro is executed when this button is selected, and 
a TAKE is issued. Macros are defined using the 
Macros tab.

Key Mode > Salvo

Salvo # Assigns the specified salvo to this button. The salvo 
is executed when this button is selected, and a 
TAKE is issued. Salvos are defined within the 
database configurations. 

Key Mode > Level

Level # Assigns the specified router level to this button

Key Mode > Take

A switch is performed when this button is selected

Table 16  LCP — Key Assignments (Continued)

Item Parameters Description
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Logs
There are four logs that can be viewed from the Logs tab: Controller Communications Log, System 
Log, DashBoard Communications Log, and Audit Log. The read-only information displayed in the 
logs is used by Ross Technical Support for diagnostic and troubleshooting purposes. If required, 
click Manage Log Requests (located in the top right corner) to display a dialog that enables you to 
download/generate logs when troubleshooting with Technical Support.

Key Mode > Take Cancel

Selecting this button cancels the action the NRG is performing.

Key Mode > Protect

Selecting this button places a block on the current destination, preventing it from being 
controlled (selecting other sources) by any other control devices

Key Mode > Panel Lock

Selecting this button places a lock on local control panel, preventing the NRG from being 
controlled by any button presses until the Panel Lock is released.

Key Mode > Chop

Enables you to toggle two different sources to the same destination. 

Key Mode > Unassigned

The button does not have a function assigned to it.

Table 16  LCP — Key Assignments (Continued)

Item Parameters Description
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Enabling a Service
The NRG routers support a set of third-party protocols (services) that enable the router to 
communicate with devices in your routing system. Before creating a connection point to an external 
device, you must first enable the required protocol(s) on the NRG router, and configure any settings 
required for communication using that protocol. This chapter outlines how to enable a 
communication protocol, and configure the additional settings on the NRG for each protocol (if 
required). A summary of the supported commands is also provided. 

If you have questions about the operation of your Ross devices, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Enabling a Communication Service
Use the options in the System > Connections > Services interface to enable or disable each required 
service. This allows your router to communicate with an external device that uses that enabled 
third-party protocol.

 Serial communication is not available at this time.

To enable a service

1. Locate the NRG node in the Tree View of DashBoard.

2. Expand the NRG node to display a list of sub-nodes.

3. Expand the System sub-node.

4. Double-click the Connections node.

The Connections interface opens in the DashBoard window with the Incoming Connections tab 
automatically selected.

5. Select the Services tab.

The Services tab lists the available communications protocols and provides options for 
enabling/disabling each protocol for the router.
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6. Enable or disable a service by selecting or clearing the associated box. Choose from the 
following:

• SSH service — Enables the ability to log onto the NRG router via an SSH server. Secure Shell 
(SSH) Login is a client-server protocol used by system administrators to securely log onto 
remote systems and execute commands over an unsecured network. SSH may also be used 
by Ross Technical Support for advanced troubleshooting.

• Walkabout — Enables the NRG router to communicate with Ross Video devices in the 
Walkabout system.

• GVG Native — Enables the NRG router to communicate via the GVG Series 7000 Native 
protocol and is available over an ethernet connection.

• Probel SW-P-08 — Enables the NRG router to communicate via the Probel SW-P-08 protocol. 
This protocol is available over an ethernet connection.

• RossTalk — Enables the NRG router to communicate via the RossTalk protocol (a plain text 
based protocol that allows control of Ross Video equipment).

• NK/RCP — Enable this option if there are Ross NK series devices or signal types the NRG 
router itself does not handle. The Ross NK series devices must be connected to the ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable communication with the 
NRG router.

• Upgrades & Support Access — Enables remote software upgrades for the router. Refer to 
Table 9 for details.

7. Click Apply.

Configuring the Service Settings
The Protocol Servers tab lists the currently active servers running in the routing system. This tab is 
auto-populated based on the external devices on the same network as your router and using the 
protocols enabled in the Services tab. Some services require you to configure additional settings on 
the router. This section briefly summarizes those additional settings.

To configure the service settings

1. Locate the NRG node in the Tree View of DashBoard

2. Expand the NRG node to display a list of sub-nodes.

3. Expand the System sub-node.

The Connections interface opens in the DashBoard window.

4. Select the Protocol Services tab.

5. Click Options (located in the bottom toolbar).

The Server Options dialog opens.

6. Locate the options for the third-party protocol you wish to configure for communications.

Refer to the following sections for a summary of the settings based on the protocol.

• “GVG Series 7000 Native Protocol Commands”
• “Probel SW-P-08 Protocol Commands”
• “RossTalk Commands”

7. Click Apply.

The Server Options dialog closes and the new settings are applied.
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Third-Party Protocols
The NRG control system is able to control third-party matrix devices. You must define an interface 
for the system before accessing the third-party matrix devices. The NRG connection point must be 
compatible with the settings of the external device you are trying to control.

 The NRG does not support serial communications at this time.

Before proceeding, ensure that you have the following connection specifics:

• Communication protocol
• Communication type (TCP/IP)

Ethernet Communication
The ethernet interfaces to these protocols are automatically started with NRG and no further 
configuration is necessary. However, you must configure your external control systems to match 
the settings outlined in Table 17. The Protocol Options are outlined with the respective protocol 
details in the following sections.

The NRG router can communicate with third-party external devices via a TCP/IP connection. By 
default, NRG provides a server process for the following ethernet protocols:

Server Options and Supported Commands
Some protocols require additional settings be configured on the router. The following sections 
outline these required settings based for each protocol.

GVG Series 7000 Native Protocol Commands
The router supports the GVG Series 7000 Native protocol and is available over an ethernet 
connection. Refer to Table 18 for connection details.

Table 19 summarizes the Server Options for the GVG Series 7000 Native protocol.

Table 17  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

Table 18  Default GVG Native Connection Types

Setting
Ethernet
Port (incoming) 12345

Port (outgoing) 12345a

a.For outgoing connections, port 12345 is the default value but is 
user configurable.
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To send GVG Native commands to the router

1. Create a network connection to the router on TCP/IP Port 12345.

2. A valid connection is reported in the NRG > Connections > Incoming Connections interface.

3. Refer to Table 20 for a list of supported GVG Native Protocol commands. 

Table 19  Server Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on protocol layer 4

No Do not send acknowledgments. This is the default.

Table 20  GVG Native Protocol Commands

Message
Notes

Command Description
BK[,parameter]

BK,D Force next QD command to return 
status of all destinations

Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all 
destinations being returned.

BK,E Request status of level 4 echo setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response (e.g. 
Take commands).
This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific destination from 
having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination status by 
name

QD[,dest_name] Query Destination status by name No information is returned for unmatched destination levels

Qd[,dest_name] Query Destination status by name Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by indexa

Qi,destIndex,lvlIndex Query Destination status by indexa The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by indexa No information is returned for unmatched destination levels

Qj Query Destination status by indexa Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter

QN,S Query source names/labels As defined inactive database

QN,D Query destination names/labels As defined inactive database

QN,L Query level names/labels As defined inactive database

QN,IS Query names via source indexa

QN,ID Query names via destination indexa

QT Query date and timea

TA,dest_name,nbr_sources,src_name_
entry1[,...src_name_entryn]

Takes sources (on specified levels) to 
specified destination, by name rather 
than index

Src_name_entryn = src_name,level_bitmap
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For More Information on...
• these commands, refer to the GVG protocol documentation.

Probel SW-P-08 Protocol Commands
The router supports the Probel SW-P-08 protocol and is available over an ethernet connection. 
Table 21 provides the default values for this protocol.

 

Table 22 summarizes the settings in the Server Options dialog for the Probel SW-P-08 protocol.

  

TD,dest_name,src_name_entry Takes same source to all or specified 
levels

Src_name_entryn = src_name[,levelbitmap]
No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level indexa

TJ,destIndex,nbr_sources,srcIndex,lev
el_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified levels) to 
specified destinations by index rather 
than name; allows breakaways

TS,salvo_name Request Take Salvo TS,salvo_name

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.

a.Zero-based hex logical index numbering.

Table 21  Default Probel SW-P-08 Connection Types

Setting
Ethernet
Port (incoming) 8910

Port (outgoing) 8910a

a.For outgoing connections, port 8910 is the default value but is 
user configurable.

Table 22  Server Options — Probel SW-P-08

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received command 
format (e.g. if received a non-extended command, 
reply in a non-extended format). This is the default.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. This is the default.

Do not wait for ACK Yes NRG will not wait for message acknowledgments 
between connect responses

No NRG will wait for message acknowledgments between 
connect responses. This is the default.

Batch Collate Timea # milliseconds Wait up to 100 milliseconds for multiple commands 
received before processing. The default is 0 (which 
disables this feature). 

Table 20  GVG Native Protocol Commands (Continued)

Message
Notes

Command Description
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Table 23 lists the supported Probel SW-P-08 protocol commands.

Batch Collate Split Size # received 
commands

Wait up to 100 received commands before processing. 
The default is 0 (which disables this feature). 

Unused Field # Send number (0-15) in either Level or Matrix field - 
which ever is not used as per Matrix Mode setting. The 
default is 0.

Repeated Packet 
Holdoff (ms)

# NRG detects repeated identical packets, and will skip 
processing if the packets are repeated within the 
specified delay. The default is 0.

Follow Level Enabled Yes Enables a user to configure a specific level to act as a 
“Follow” level. When a “Connect Crosspoint” message 
with this level is received, NRG will issue a Take 
command for all database levels.

No Disables this feature

Follow Level # Specifies the routing level for Probel that signals a 
follow/all-level take. Note that the NRG supports a 
maximum of 4 levels.

a.When both Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will release the 
batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 23  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status
Cmd22: Byte max dest 191
Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

Table 22  Server Options — Probel SW-P-08 (Continued)

Option Setting Notes
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to the router

1. Create a network connection to the router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 24 for a list of supported 
commands.

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group Salvo 122 Crosspoint Connect On Go Group Salvo 
Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

124 Crosspoint Group Salvo Interrogate 253 Extended Crosspoint Group Salvo Tally Preset group status

Table 23  Probel SW-P-08 Native Protocol Commands (Continued)

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
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Table 24  RossTalk Protocol Commands

Message
Notes

Command Description
GPI ## Execute the salvo number corresponding to the 

numerical ## extension of the command
For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the NRG 
database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

TIMER ##:END Request Timer ID to end

TIMER id:SET:hh:mm:ss.s Request to set Timer value

TXTLABEL ID:<id>; TEXT:<text>; 
BGCLR:<bgcolor>; TXTCLR:<textcolor>

Where:
• <id> is a unique “rosstalk id” associated with 

an RossTalk display object. This field is 
compulsory.

• <text> is the text to be displayed. This field is 
optional.

• <bgcolor> is the background color of the text 
label. Specified in comma separated RGB 
format using 2 byte hex values (e.g. 
RR,GG,BB). This field is optional.

• <textcolor> is the text color of the text label.                
Specified in comma separated RGB format 
using 2 byte hex values (e.g. RR,GG,BB). This 
field is optional.

There is a 20 character maximum.
Messages with only the id field will be ignored. 
The following is an example of a message:
TXTLABEL ID:25; TEXT:CAM1; 
BGCLR:0x00,0x00,0x00; 
TXTCLR:0xFF,0xFF,0xFF

Note that <bgcolor> and <textcolor> are 
specified as R,G,B triplet. For example:
• 255,255,255 or 0xff,0xff,0xff is white

• 0,0,0 or 0x0,0x0,0x0 is black

• 255,0,0 or 0xff,0x0,0x0 is red 

XPT D:<dest> S:<source> I:<user_id> [L:<levels>] Crosspoint command for a router TAKE where:
• <dest> is the logical destination ID from the 

active database (1-based)

• <source> is the logical source ID from the 
active database (1-based)

• <user_id> is the numeric user/panel ID that 
will be used to request the switch

• <levels> is an optional parameter specifying 
comma-separated list of 1-based level IDs to 
switch (for breakaway, e.g. L:1,2,4). If no 
levels are specified, a follow switch (all valid 
levels) is requested. 

• <levels> supports ranges specified by two 
numbers separated by dash (e.g. L:1-4)

Range start value must be less than the end 
value
Single levels and ranges can be mixed in the 
list (e.g. L:1,2)
There are no spaces between numbers or 
ranges
Invalid numbers or improperly specified 
ranges will be ignored 
An argument is separated from its value using 
a single colon (:)
Command arguments are separated single 
spaces
The arguments may be specified in any order, 
(e.g. these are equivalent: XPT D:1 S:4 I:2 and 
XPT S:4 I:2 D:1)
Examples:
• ID 7 requesting to switch Dest 2 to Source 1 

on Levels 1,2, and 4

• XPT I:7 D:2 S:1 L:1,2,4
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Timing and Reference Setup
This chapter outlines how to configure the reference and time source for your NRG router.

For More Information on...
• cabling the reference source for your NRG router, refer to the NRG Installation Guide.
• the NRG-MV licensed feature, refer to “NRG-MV Setup”.

Before You Begin
Keep the following in mind:

• The NRG router requires an external time source in order to accurately report the time-of-day.
• The NRG only supports NTP Server as a time source at this time.
• If a reference source is not connected to the REF port, the NRG-MV outputs 1080p 59.94Hz (NTSC) 

or 1080p 50Hz (PAL) by default. Refer to “NRG-MV Setup” for more details.
• An external reference source must first be connected in order to support the NRG-MV output at 

1080p 60Hz.

Specifying a Default Reference Format
If you did not connect a reference source signal to the REF port on the NRG rear panel, you can still 
configure a Default Reference format using the options in the System > NRG interface. Note that 
this Default Reference setting only applies to start-up with no reference source connected.

Keep the following in mind:

• If you connect a valid reference source to the REF port, it will take precedence over the Reference 
> Default setting.

• If the connected reference source becomes unavailable, the NRG router will use the last known 
good reference format until a re-boot or power cycle occurs (at which time the Default Reference 
setting will be applied). 

• If the NRG router does not have a valid reference signal connected to it, an NRG-MV Multiviewer 
Head still needs a reference to output correctly. Specifying the Default Reference Format 
provides an internal reference signal of either NTSC or PAL rates to allow the NRG-MV Head to 
still output with no system reference signal connected.

To specify the default reference format for the NRG router

1. Expand the NRG node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Double-click the NRG node.

4. Locate the Reference area at the top of the NRG interface.

5. Use the Default menu to specify the reference format for the NRG router. 

Configuring a Reference Trigger for the NRG Router
If a reference signal is connected to the NRG router, you can configure a reference trigger with a 
custom switching point.
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To configure the reference trigger for the router

1. Expand the NRG node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Double-click the NRG node.

4. Locate the Triggers area.

 The Reference > Detected format field indicates the format of the reference signal connected to 
the connected REF port on the router.

5. Use the Format field to select the switch timing that will be used by the router when switching 
inputs/outputs.

6. If you selected Custom in step 5, use the Custom (μs) field to specify the time (number of 
microseconds) from the start of the custom switching line to the actual switching event. The 
maximum value is 65,535μs.
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Configuring the SDI I/O Ports
This chapter provides a general overview of the available options for configuring the SDI I/O.

Before You Begin
Keep the following in mind when routing SDI signals:

• The NRG does not process SMPTE 352 packets. As a result, some of the supported SDI formats 
listed in the NRG Installation Guide will have multiple reported signal statuses in DashBoard. For 
example, 1080i 60/1080PsF 30 is reported when either 1080i 60Hz or 1080PsF 30Hz are detected.

• Dual-link and Quad-link signals can be routed through the NRG, but the NRG does not support 
gearboxing. DashBoard will report the detected format status for the individual links.

Setting the Signal Mode for a Source
The NRG is capable of switching video signals1 from 270Mbps to 12Gbps. This format flexibility 
permits SD, HD, 3G, 6G, and UHD video signals to be used seamlessly in the same system. 

To specify the signal mode for a source

1. Expand the NRG node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Double-click the NRG node.

The NRG interface displays. The following example shows the NRG-FR1 interface.

4. Locate the Sources table (located in the bottom left pane).

5. Locate the row for the input you wish to configure.

6. Select the cell in the Signal Mode column.

7. Choose one of the following:
• SDI Video — Identifies the input signal as SDI video. This is the default.

1. The NRG routers support SMPTE standards 259M, 292M, 296M, 372M, 424M, 425M (level A/B), 2081M, and 2082M.
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• MADI — Identifies the input signal as MADI (audio) only. The video data is ignored.
• DVB-ASI — Identifies the input signal as carrying MPEG-TS data up to 270Mbps.
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Database Interfaces
The NRG groups the database configuration options in a tree view in the DashBoard window. This 
chapter provides an overview of the Database interfaces, how to access the NRG Database tree, and 
provides an overview of each interface.

Database Tree View Overview
The NRG groups the database configuration options in a tree view in the DashBoard window. 
Expanding the top Database node enables you to access the interfaces to configure the connection 
points, matrices, destinations, sources, group, levels, soft panels, and salvos for the active database. 
Double-clicking a sub-node opens the corresponding interface in the rightmost pane of DashBoard.

Each sub-node offers specific database configuration options. This enables you to configure your 
routing system. Note that the currently active database name is displayed in parentheses beside 
the Database node in the tree view. For example, Figure 19 shows a router with the DB-202 
database activated. Unicode names are supported so that names may be defined in other 
languages or writing systems.

Figure 19  Expanded Database Nodes in the Tree View

Before You Begin
Throughout the Database interfaces, actual sockets (inputs and outputs) of a device (or matrix) are 
referred to by hierarchical dotted notation: Frame.slot1.port[#].Type.Channel where:

• Frame identifies the physical device housing the matrix/matrices (e.g. NRG-FR1)
• port[#] identifies the physical input or output socket (where in[#] represents an input, and 
out[#] represents an output).

• Type identifies the generic signal type (e.g. SDI).
• Channel identifies the audio channel within an SDI stream.

Accessing the Database Interfaces
The interfaces are accessed by expanding the Database node in the DashBoard Tree View and 
selecting the appropriate sub-node for the database feature you wish to edit.
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To access the Database interfaces

1. Locate the NRG node in the Tree View.

2. Expand the NRG node to display a list of sub-nodes.

3. Expand the Database sub-node to list the options available for creating, and defining your 
databases.

4. Double-click the Database Manager sub-node to display the options for managing the 
database(s) in your routing system. 

Use the Database Manager interface to:

• create a database. Refer to “Creating a New Database”.
• activate a database. Refer to “Activating a Database”
• backup and restore databases using the Import/Export options in the toolbar. Refer to 

“Importing a Database” or “Exporting a Database”

5. Expand the Configuration sub-node to provide a list of sub-nodes.

Each Configuration sub-node represents a specific database component that can be further 
defined by the user. 
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6. Double-click a sub-node in the Configuration tree to display its interface in the DashBoard 
window. 

For example, double-click the Destinations sub-node to display the options for mapping the 
outputs in your routing system. Refer to “Defining a Database”.

7. Expand the Control sub-node to access the configured soft panels in your routing system. Refer 
to “Soft Panels in DashBoard” for more information.

This following sections summarize the menus, fields, and options available in each Database 
sub-node starting with the first sub-node in the tree.

Database Manager Interface
The Database Manager helps you to create, edit, and manage your databases via a single interface. 
The Database Manager interface is organized into three distinct areas: a toolbar at the top, a table 
in the left pane, and a series of tabs in the right pane. (Figure 20) Note that the Database 
Configuration tab is only displayed for the active database.
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Figure 20  Example of a Database Manager Interface

Table 25 summarizes the buttons displayed in the Database Manager toolbar.

 
Table 25  Database Manager — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Activate Toggles the status of the selected inactive database to activate. This 
allows you to load another database to the routing system, and 
enables editing of the database settings and contents.

Add Enables you to create a new (blank) database. The list of available 
databases updates to include the new entry at the bottom of the table.

Duplicate Creates a copy of the selected database

Delete Enables you to delete the selected database.

Import Enables you to import a database file and include it in the Database 
Manger list of available databases

Export Enables you to export the selected database as a file that is then saved 
to a location on your DashBoard client computer

Legacy 
DB

Enables you to import a database (*.uda) that was created and saved 
in a previous software version.

Filter This enables a user to filter the interface entries to only databases that 
match the entered text.
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Table 26 summarizes the columns displayed in the table located in the left pane of the Database 
Manager. 

Database Configuration Tab
The right pane of the Database Manager displays the Database Configuration tab. (Figure 21) The 
options on this tab enable you to configure how often the database is saved, and view snapshots of 
previously saved databases. 

Figure 21  Example of an Active Database Configuration Tab

Table 27 summarizes the menus and options displayed in the Database Configuration tab.

 

Table 26  Database Manager — Database Table

Item Parameters Description
Name <text> The unique identifier for the device in the routing 

system. This name is also used when matrices are 
defined in the NRG system.

Status Active Indicates that the specified database is currently in 
use by this NRG

Inactive Indicates that the specified database is not 
currently loaded to this NRG

Table 27  Database Manager — Database Configuration

Item Parameters Description
Operation Mode

Auto save • Changes made to any database interface are automatically saved. 
• This is the default setting when a database is set to Active.
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Configuration Interfaces
The Database > Configuration node expands to display a tree of sub-nodes that enable you to 
further define the current database. Each sub-node provides access to a specific interface of the 
database. (Figure 22)

Figure 22  Database > Configuration Sub-nodes

Protect • All fields, except Aliases and labels, of the database are read-only and 
cannot be edited. 

• A blue border displays around each interface.
• A shield icon displays in the Status column for the database in the 

Database Manager table
• A shield icon displays in the bottom left corner of each interface to 

remind the user that the database is read-only.

Manual save • The database is editable but changes are not automatically saved.
• An orange border displays around each interface.
• The Cancel and Save buttons display in the bottom right corner of each 

database interface. 
• After making changes on any interface, the user must then click Save to 

save any changes. 
• Clicking Save on one interface applies any unsaved changes made to 

any interface.

Display IDs

Start at 0 Auto-generated ID numbering starts at 0. This is the default.

Start at 1 Auto-generated ID numbering starts at 1

Snapshots

Snapshot frequency 
(min)

# Determines how often the active database settings 
are auto saved. The default is 15 minutes.

Restore Returns the database to the settings during the selected snapshot

Create Immediately creates a snapshot of the currently active database

Date/Time Lists the saved snapshots by MM DD YY

Table 27  Database Manager — Database Configuration (Continued)

Item Parameters Description
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This section outlines each sub-node in order of appearance in the Configuration tree.

 An orange border displays around an interface when the current database has the Operation 
Mode set to Manual save. A blue border indicates that the current database is read-only and 
cannot be edited (the Operation Mode set to Protect). If the Operation Mode is set to Auto save, 
any unsaved changes made to the current database are automatically applied.

Routing Devices
The Routing Devices interface reports a list of devices detected in the routing system and their 
communication status with the primary device. (Figure 23)

Figure 23  Example of a Routing Devices Interface

Table 28 summarizes the buttons displayed in the toolbar located at the top of the Routing Devices 
interface. 

Table 29 summarizes the read-only fields displayed in the left pane of the Routing Devices 
interface. Each row of this table represents a device in your routing system. 

Table 28  Routing Devices — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to create a connection point to another device in the 
routing system

Delete Removes the selected device and its matrices from the active database

Filter Reduces the number of database entries visible on the Routing 
Devices interface.
This enables a user to filter the interface entries to only devices that 
match entered text.
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Device Communication Tab
Table 30 summarizes the tabs and menus displayed in the Device Communication tab, located in 
the right pane, of the Routing Devices interface. Select a device on the left pane to display its 
communication settings in the Device Communication tab.

Table 29  Routing Devices — Left Pane

Item Parameters Description
Name <name> The unique identifier for the connected matrix to be 

used by the database

Product Type <name> Indicates the type of device connected

Protocol <name> Indicates the communication protocol required by 
this device

Status (read-only) Running No communication errors are detected

Disconnected This device is no longer communicating with the 
routing system

Initializing Attempting to connect to this device. It is 
recommended to wait approximately 60 seconds to 
establish a connection.

IO mismatch The number of available I/O on the device does not 
match the values specified in the active database

Not available The device was added/edited while the database is 
operating in Manual save mode but is now 
disconnected from the NRG.
Click Save, located at the bottom right corner, and 
verify if a connection is now made to the device.

 Unknown 
State

A legacy database was imported and the protocol 
cannot be determined (this is usually for the NK 
devices). 
You will have to specify the protocol for the device.

Updates the database with the selected device 
matrix. 
If the device is reporting an IO Mismatch, click this 
button to refresh the database and verify if it clears 
the error.

Table 30  Routing Devices — Device Communication Tab

Item Parameters Description
Device name <name> Provides a unique identifier for the device in the 

database. This name is also used when matrices are 
defined in the routing system.

Communication
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Levels
The options in the Levels interface are organized into a table where each row represents a level and 
the columns provide the options for configuring that level. From this interface you assign a unique 
name to each level, a color that represents the level to make it easier to identify the level in a soft 
panel, and add a description of the level to aid identification. The levels defined in the Levels 
interface have a direct relationship with the Level entries in other database configuration tabs.

One level is automatically created in the default database.

Protocol Ultrix TCP The device uses the Ross Ultrix protocol to 
communicate (TCP)

GVG Native The device uses the third-party GVG protocol to 
communicate (TCP)

NRG TCP The device uses the Ross NRG protocol to 
communicate (TCP)

Probel SW-P-08 The device communicates via the Probel SW-P-08 
protocol (TCP)

Ross NK The device uses the Ross NK protocol to 
communicate (TCP)

RossTalk TCP The device uses the Ross Talk protocol to 
communicate (TCP only)

IP Address # Indicates the IP address assigned to the device 
within the network

Port # Indicates the ethernet port the devices is associated 
with on the network

Control

Device state enabled Direct communication is established between the 
NRG and this client device

disabled Communication between the NRG and this client 
device is unavailable

Table 30  Routing Devices — Device Communication Tab (Continued)

Item Parameters Description
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Figure 24  Example of the Database > Configuration > Levels Interface

For More Information on...
• levels for a database, refer to “Defining the Levels”.

Destinations
The Destinations interface enables the assignment of logical labels (used by remote control panels 
and soft panels) to physical outputs of the attached matrices or routers. The Destination interface is 
organized into a table with each row representing a Destination and each column representing a 
Level. (Figure 25) The table cells are physical outputs assigned to the Destination for that level. 
Initially, the destination label DST # is assigned to the physical output socket. A toolbar at the top 
includes options for managing the table entries. 

For More Information on...
• destinations for a database, refer to “Mapping the Destinations”.

Figure 25  Example of the Database > Configuration > Destinations Interface

Table 31 summarizes the buttons displayed in the toolbar of the Destinations interface.
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Table 32 summarizes the table columns displayed in the main area of the Destinations interface 
(from left to right). 

Table 31  Destinations — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Fill I/Os Displays a pane that enables you to insert destination labels with 
assignments for the entire device (including the AUX ports) or for a 
custom range

Edit Enables the reassignment of the physical ports to the selected 
destination

Add Enables you to add a single or range of new logical labels. These are 
added at the end of the current definitions

Select all Selects all entries on the Destinations interface

Deselect 
all

Entries are no longer selected on the Destinations interface

Move Up Moves the selected item higher in the table/list.

Move 
Down

Moves the selected item lower in the table/list.

Move to 
Top

Moves the selected item to the top of the table/list.

Move to 
Bottom

Moves the selected item to the bottom of the table/list.

Rename Displays a dialog that enables the renaming of a selected destination

Clear Clears the physical port mapping

Delete Removes the selected destination from the active database

Import Enables you to import an *.xlsx file that automatically maps the 
Destinations as defined by the spreadsheet entries

Export Enables you to save the current Destination mapping as an *.xlsx file 
on your DashBoard client computer

Reset IDs Replaces the current ID assignments to the default values (starting 
with 0 for the first entry)

View 
Columns

Displays a dialog that enables you to specify the Levels columns to 
show/hide on the Destinations interface. Note that the ID and Name 
columns are fixed (cannot be hidden).

Alias Applies the custom labels as defined in the Aliases interface
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Sources
The Sources interface is organized into a table where each row associates a name of the source 
with one or more physical matrix input sockets. This enables the assignment of labels (used by 
remote control panels and soft panels) to inputs of the attached matrices or routers. A toolbar at 
the top includes options for managing the table entries.

For More Information on...
• sources for a database, refer to “Mapping the Sources”.

Figure 26  Example of the Database > Configuration > Sources Interface

Table 33 summarizes the buttons displayed in the toolbar of the Sources interface. 

Table 32  Destinations Interface

Item Parameters Description
ID (read-only) # An auto-numbered field that is not used 

within the NRG system itself, however, 
third-party protocols that do not support 
labels will reference this field in their 
communications

Name <text> Assigns a unique identifier (label) for the 
destination in the routing system. This label 
is used by control interfaces/devices.

Description <text> Provides additional information or user 
entered notes about the output

Level # Specifies the physical output port 
associated with the destination and assigns 
it to the specified level. Unless you have 
given the port a different label via the 
Channel Alias interface, the port is labeled 
as: Frame.Slot.Port.Type.Channel.
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Table 34 summarizes the table columns displayed in the main area of the Sources interface (from 
left to right on the interface). 

Table 33  Sources — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Fill I/Os Displays a pane that enables you to insert source labels with 
assignments for the entire device (including the AUX ports) or for a 
custom range

Edit Enables the reassignment of the physical ports to the selected source

Add Enables you to add a single or range of new logical labels. These are 
added at the end of the current definitions.

Select all Selects all entries on the Sources interface

Deselect 
all

Cancels the previous selections

Move Up Moves the selected item higher in the table/list.

Move 
Down

Moves the selected item lower in the table/list.

Move to 
Top

Moves the selected item to the top of the table/list.

Move to 
Bottom

Moves the selected item to the bottom of the table/list.

Rename Displays a dialog that enables the renaming of a selected source

Clear Clears the physical port mapping

Delete Removes the selected source from the active database

Import Enables you to import an *.xlsx file that automatically maps the 
Sources as defined by the spreadsheet entries

Export Enables you to save the current Source mapping as an *.xlsx file on 
your DashBoard client computer

Reset IDs Replaces the current ID assignments to the default values (starting 
with 0 for the first entry)

View 
Columns

Displays a dialog that enables you to specify the Levels columns to 
show/hide on the Sources interface. Note that the ID and Name 
columns are fixed (cannot be hidden).

Alias Applies the custom labels as defined in the Aliases interface
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Aliases
The Alias interface provides a method for defining a set of virtual labels (alias) for one or more 
source or destination. An alias can be useful for defining label sets for use with devices that have 
limited screen real estate such as Remote Control Panels (RCPs). 

The default labels for the routing system are the labels as defined in the Source and Destination 
interfaces. An alias set is a group of labels that can be defined and then used with display limited 
devices. For example, a label Remote Camera will not display correctly on an RCP. An alias for this 
label may be RCAM. This will display correctly on character limited displays.

An alias set may only define a few aliases for the router. When using this set, the defined aliases are 
used but where no alias is defined for a given source or destination, then the label as defined within 
the source or destination interface is used.

 This re-naming is not necessary for router operation, but it may make your assignment of source 
and destination labels easier to identify when using your internal cable naming conventions. 

For More Information on...
• aliases for a database, refer to “Using an Alias Set”.

Figure 27  Example of the Database > Configuration > Alias Interface

Table 34  Sources Interface

Item Parameters Description
ID # Auto-numbered field (read-only). This is not used 

within the routing system itself, however, 
third-party protocols that do not support labels will 
reference this field in their communications.

Name <name> Assigns a unique identifier (label) for the source in 
the routing system. This label is used by control 
interfaces/devices.

Description Provides additional information or user entered notes about the input

Level # Specifies the physical input port associated with the source and assigns it to 
the specified level. Unless you have given the port a different label via the 
Channel Aliases interface, the port is labeled as: 
Frame.Slot.Port.Type.Channel.
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Table 35 summarizes the buttons displayed in the leftmost toolbar located at the top of the Alias 
interface. 

Table 36 summarizes the table columns displayed in the main area of the Aliases interface (from 
left to right on the interface). 

Table 37 summarizes the buttons displayed in the rightmost toolbar located at the top of the 
Sources, and Destinations tabs in the Aliases interface. 

Table 35  Aliases — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Creates a new alias set

Duplicate Creates a copy of the alias set

Delete Removes the selected alias set from the active database

Table 36  Aliases — Main Area

Item Parameters Description
ID # Auto-numbered field (read-only). This is not 

used within the routing system itself, however, 
third-party protocols that do not support labels 
will reference this field in their 
communications.

Name <name> Provides a list of configured alias sets. Select a 
row to display the alias set details on the 
rightmost pane.

Description Provides additional information about the alias set

Table 37  Alias > Sources or Destination — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Select all Selects all entries on the tab

Deselect 
all

Cancels the previous selections

Rename Assigns a new identifier to the selected row(s) for this alias

Clear Removes any recent changes 

Import Enables you to import a Microsoft® Excel® spreadsheet that lists the 
ports and the new identifiers for a specific alias set 

Export Enables you to save the specified alias to a Microsoft Excel 
spreadsheet file on your DashBoard client computer
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Table 38 summarizes the columns displayed in the Sources and Destinations tabs of the Aliases 
interface. 

Table 39 summarizes the options displayed in the Services tab of the Aliases interface. 

Cat/Index Categories
Category Index mode (or Cat/Index mode) enables you to organize the resources (sources, 
destinations, and/or levels) in a routing database to defined categories. This allows you to piece 
together or build up the final resource name from category names and index identifiers. Once you 
have defined your categories, you can create a custom soft panel using the category settings to 
arrange the sources, destinations, and levels.

The Cat/Index Categories interface organizes the lists of resources based on what is currently 
assigned to a category/index, and what resources are still available (unassigned). This information is 
also reported in the bottom toolbar of the Cat/Index Categories interface.

Figure 28  Example of the Database > Configuration > Cat/Index Interface

Table 40 summarizes the buttons displayed on the top toolbar. 

 The toolbar button function depends on the Category table selection or Index table selection.

Table 38  Aliases — Sources or Destinations Tabs

Item Description
Name Indicates the label as defined by the Sources or Destinations interface

Alias Provides a text entry for the label alias. 
Double-click the entry to edit, or click Rename. For example, re-name a 
port from NRG.slot1.in[7].SDI.ch1 to SDI IN 7.

Table 39  Aliases — Services Tabs

Item Description
Apply Applies the selected alias set to the external device matrix. Services are 

defined in “Enabling a Service”.

Clear The alias set is no longer applied to the external device matrix. This button 
is disabled if no alias sets are currently applied to the external device 
matrix.

Service alias set Reports the alias set currently applied and the number of services 
(devices) it is applied to.
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Table 41 summarizes the options displayed in the Assigned Resources area (bottom left pane) of 
the Cat/Index Categories interface. 

The right pane of the Cat/Index Categories interface displays a tab for each resource type. Select a 
tab to display the resources in the current database that are not assigned to a category/index. 

Table 40  Cat/Index Categories — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Creates a new entry in the selected Category or Index table. For 
example, a new entry would be added to the Category table in Figure 28.

Select all Selects all entries in the current table

Deselect 
all

Cancels the previous selections in the current table

Delete Deletes the selected entry from the current table (Category or Index). 
Automatically unassigned any resources.

Generate Automatically generates Category and Index entries based on the active 
database entries.
Categories are automatically defined by searching for space characters 
within the database logical source and destination names.

Default 
index

Generates the default indexes (0-9 and A-F)

Table 41  Cat/Index Categories — Assigned Resources Area

Item Parameters Description
Navigate Menus Displays a drop-down list of the available buttons 

and their labels

Show Levels Updates the Levels in Categories list

Levels in Categories Lists the current levels that are accessible via the 
defined Category/Index combinations

Assigned # Reports the number of levels assigned to the 
selected Category/Index combination

Show Sources Updates the Sources in Categories list

Sources in 
Categories

Lists the current sources that are accessible via the 
defined Category/Index combinations

Assigned # Reports the number of sources assigned to the 
selected Category/Index combination

Show Destinations Updates the Destinations in Categories list

Destinations in 
Categories

Lists the current destinations that are accessible via 
the defined Category/Index combinations

Assigned # Reports the number of destinations assigned to the 
selected Category/Index combination
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Table 42 summarizes the options displayed in each tab. 

Group Categories
The Categories interface enables you to categorize resources (levels, sources, and destinations) via 
a hierarchal system of tags. You can use categories to filter resources into manageable groups for a 
Category soft panel. 

The Group Categories interface is organized into two panes: the Group Categories tree (left pane), 
and the available resources tabs (right pane). The tree organizes all the created groups and 
sub-groups, and/or resources in a top-down hierarchy. (Figure 29) Note that the nodes are sorted 
by type and then by alphabetical order.

Figure 29  Example of Entries in a Group Categories Interface

Table 43 summarizes the toolbar buttons displayed in the left pane of the Group Categories 
interface. 

Table 42  Cat/Index Categories — Unassigned Resources Area

Button Label Description
Add Enables you to assign the selected resource(s) to the a new Cat/Index 

filter for destinations

Select all Selects all resources in the current tab

Deselect 
all

Cancels the previous selections on the current tab

Generate Automatically generates category tags based on the destinations in 
your database

Table 43  Group Categories Interface — Toolbar Buttons

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to manually add a new group (node) to the Group 
Categories tree
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Table 44 summarizes the options displayed in the right pane of the Group Categories interface. 
This panel displays a tab for each resource type, listing the available levels, sources, or destinations 
that can be assigned to the group categories.

 

Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for crosspoint transitions. The Salvos interface enables you to create, delete, re-name, and 
manage your salvos in an interface that is off-line. The Salvo interface layout arranges the 
crosspoints in a grid layout with sources in columns and the destinations in rows. The toolbar on 
the far right-side displays a button for each level available in the database with each button set in 
the color specified for that level.

For More Information on...
• salvos, refer to “Creating Salvos”.

Edit Enables you to edit the name assigned to a group

Move Displays the Move dialog that enables you to move a selected group 
and its contents to another group or to a new node in the tree

Delete Deletes the selected group(s) and all sub-groups

Generate Auto-generates the group categories based on the resource names 
from the current database

Table 44  Group Categories Interface — Right Panel

Item Description
Levels Displays the unassigned levels

Sources Displays the unassigned sources

Destinations Displays the unassigned destinations

Assign Select the resource(s) to add it to the group selected in the Group 
Categories tree

Table 43  Group Categories Interface — Toolbar Buttons (Continued)

Button Label Description
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Figure 30  Example of the Database > Configuration > Salvos Interface

Table 45 summarizes the buttons displayed in the toolbar located at the top of the Salvos interface.

 
Table 45  Salvos — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels

Add Enables you to create a new salvo for the active database

Duplicate Creates a copy of the currently selected salvo

Delete Deletes the selected salvo

Select all Selects all available destinations on the Salvos workspace.

Deselect 
all

Clears the Destinations column of selections

Capture Captures the current state of the routing system as a new salvo using 
one of the following methods:
Capture system status — uses the current routing state of the routing 
system.
Capture destination status — uses the current status of the selected 
destinations in this database.
Capture port status — uses the current status of the physical ports in 
the database.

Clear Clears the preset crosspoint selections for the current salvo. If 
destinations are selected, the option to only clear the selection is 
presented.

Levels Select to filter the displayed levels

Toggle Toggles the workspace between a grid view (default) and a table view. 
Note that editing is not available in table view.
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Table 46 summarizes the table columns displayed in the left pane of the Salvos interface. 

Table 47 summarizes the options displayed in the right pane of the Salvos interface. 

Panels
The Panels interface includes a series of sub-tabs that enable you to customize the soft panels 
(control panels within the DashBoard environment). You can choose to assign the resources (levels, 
sources, destinations, and salvos) from a database to the panel buttons. The soft panels display as 
sub-nodes in the Database > Control > Panels tree using the configured name. When you save a soft 
panel to the database, a node for the panel automatically displays in the Panels tree. The soft 
panels display in the tree according to their assigned Panel ID (where an ID of 1 is the highest, and 
ID of 2 is the second highest etc.).

The Panels interface is organized into two distinct areas from left to right: the Panels table and the 
Settings, Data, and Layout tabs. (Figure 31)

 Two default push button soft panels are automatically created in the default database: Control 
(confirm take) and Control (direct take). 

Find & 
Filter

Displays the Find dialog which enables you to:
enter search criteria to locate specific Sources or Destinations in the 
current workspace.
filter the workspace entries to only display sources and/or 
destinations that match entered text

Table 46  Columns of the Salvos Interface — Left Pane

Column Description
ID The auto-assigned identifier for a salvo

Name Provides a list of configured salvos for the currently loaded database. 
Double-click an item in the list to update the grid in the Salvos interface.

Table 47  Columns of the Salvos Interface — Right Pane

Button Description
Level # The display of levels is controlled via the Levels button on the top 

toolbar. Select one or more level buttons to include it in the next preset 
selection.

Follow Click to include all the Levels in the next preset selection.

Table 45  Salvos — Toolbar (Continued)

Button Label Description
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Figure 31  Example of the Database > Configuration > Panels Interface

Panels Table

The Panels area is located in the left pane, and displays a table with a toolbar at the top. The table 
lists the soft panels saved in the current database. The toolbar includes buttons that enable you to 
quickly add, copy, or delete selected soft panel(s) from the table.

Table 48 summarizes the fields and menus displayed in the toolbar of the Panels area. 

Table 48  Panels Area — Toolbar

Button Label Description
Navigate 
Menus

Displays a drop-down list of the available buttons and their labels.

Add Displays the Add Panel dialog. This dialog enables you to create a new 
soft panel entry.

Up Moves the selected panel higher in the table/list.

Down Moves the selected panel lower in the table/list.

Top Moves the selected panel to the top of the table/list.

Bottom Moves the selected panel to the bottom of the table/list.

Duplicate Creates a copy of the currently selected soft panel.

Delete Deletes the currently selected soft panel(s).
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Table 49 summarizes the table columns displayed in the Panels area. 

Settings Tab
The Settings tab is the first tab displayed on the right side of the interface. Use the options in the 
Settings tab to determine how the panel will perform tasks such as Take transitions, what data to 
include, or whether to include window/drawer elements (if applicable).

 Not all options are available for all panel types.

Table 50 summarizes the fields and menus displayed in the Settings tab. 

Table 49  Panels Area — Table

Item Parameters Description
Panel ID # Auto-assigns an ID number to the soft panel. This 

value determines the panel node placement in the 
hierarchy of the Soft Panel tree. This number can 
be over-written.

Name <name> Provides a unique identifier for the soft panel. This 
name also displays in the Databases > Control > 
Panels interface.

Description # Provides a textual summary of the soft panel or 
additional information about the panel.

Type (read-only) <text> Specifies the panel type that was assigned to the 
soft panel when it was created.

Table 50  Panels > Settings Tab

Item Parameters Description
Panel

Protection 
operation

Enable Displays the Lock and Protect buttons on the soft 
panel interface

Disable The Lock and Protect buttons do not display on the 
soft panel interface

Take operation Confirm Displays the TAKE button on the soft panel 
interface. 
The user must click TAKE to confirm a switch before 
a crosspoint route will occur.

Direct A TAKE button is not displayed on the soft panel 
interface. 
Any source button selection is acted upon 
immediately.

Machine control Enable Displays a Machine Control toggle button on the 
soft panel interface. 
When enabled (the button is lit blue), any source 
selection on the panel will also send a command to 
Ross NK-M series data routers to automatically 
make the reciprocal port switch.

Disable Does not display a Machine Control button on the 
panel
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Data Tabs
Selecting the Data tab updates the interface with sub-tabs to assign the resources (levels, sources, 
destinations, salvos, and alias sets) for the selected soft panel.

Selection operation Single The Multi Select button does not display on the 
MultiBus soft panel

Multi Displays the Multi Select button on the soft panel. 
Use this button to quickly select multiple 
destinations for a crosspoint switch.
This button is only applicable for MultiBus panels.

Nongroup 
resources

Hide Resources that are not assigned to a specific group 
are not displayed on the Group Category soft panel

Show All resources are displayed on the Group Category 
soft panel

Window

Vertical scroll bar 
width

Determines the width of the vertical scroll bar

Horizontal scroll bar 
height

Determines the height of the horizontal scroll bar

Icons display Enable The Destination and Source buttons will display the 
default icons based on the window type

Disable The Destination and Source buttons do not display 
icons; only the labels are displayed

Orientation Portrait Specifies a vertical layout where the soft panel is 
taller than it is wide. 
The windows are organized into columns (vertical 
panes) on the soft panel.

Landscape Specifies a horizontal layout where the soft panel is 
wider than it is tall.
The windows are organized into rows (horizontal 
panes) on the soft panel.

Drawer width Specifies the width of the drawer handle size on the soft panel

Take button size Specifies the dimension of the TAKE button on the soft panel. This is 
available only for the Ultritouch PB panels.

Viewable Data

Levels # Specifies the maximum number of levels available, 
as selectable buttons, on the soft panel

Sources # Specifies the maximum number of sources 
available, as selectable buttons, on the soft panel

Destinations # Specifies the maximum number of destinations 
available, as selectable buttons, on the soft panel

Salvos # Specifies the maximum number of salvos available, 
as selectable buttons, on the soft panel

Table 50  Panels > Settings Tab (Continued)

Item Parameters Description
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Use the options in the sub-tabs to specify the available resources for the panel, and organize them 
in a hierarchy. 

Figure 32  Example of the Panels > Data > Sources

Table 51 summarizes the fields and menus displayed in each sub-tab. 

Table 51  Data Sub-tabs

Item Description
Levels

Available Lists all the levels that are available in the database but are not 
assigned to the soft panel

Assigned Specifies which levels will be available on the soft panel

Sources

Available Lists all the sources that are available in the database but are not 
assigned to the soft panel

Assigned Specifies which sources will be available in the soft panel

Destinations

Available Lists all the destinations that are available in the database but are not 
assigned to the soft panel

Assigned Specifies which destinations will be available in the soft panel

Salvos

Available Lists all the salvos that are available in the database but are not 
assigned to the soft panel

Assigned Specifies which salvos will be available in the soft panel.

Alias Sets

Available Lists all the alias sets that are available in the database but are not 
assigned to the soft panel

Assigned Specifies which alias sets will be available in the soft panel. 
Note that the first alias set assigned will be the first set the user sees in 
the soft panel.
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Layout Tab
The Layout tab enables you to customize the contents and display settings of the windows and 
drawers of a soft panel. (Figure 33) The available settings depend on the panel type you are editing.

The Layout tab may be organized into the following areas:

• Home Windows — these options determine the contents and layout of the main (Home) window 
of a soft panel.

• Drawer Windows — these options determine the contents and layout of the navigation drawers 
on the left and right sides of the soft panel.

 The Layout tab is not available for the Matrix panel type.

Figure 33  Example of the Panels > Layout Tab

Table 52 summarizes the options displayed in the Layout tab.

 
Table 52  Layout Tab

Item Parameters Description
Home Windows

Total Width (%) 
(read-only)

# Reports the percentage of allocated space used by 
the Home Window components on the panel

Add Enables you to add a new window to the soft panel 
layout

Delete Removes the window from the soft panel layout

Default Loads the default window layout and widths

Windows data 
(read-only)

<text> Specifies the resource or window type that is 
included on the panel

Percent # Specifies the width of the window in a percentage 
of the overall soft panel size

Rows # Specifies the number of button rows in the window

Columns # Specifies the number of button columns in the 
window
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Buttons
Table 53 summarizes the buttons displayed in all Panel sub-tabs. 

Title bar Selected A header displays above each data type window to 
identify it on the panel. For example “Destinations” 
or “Sources”.

Cleared The data type windows are not identified by a 
header

Drawer Windows

Add Enables you to add a new data type to a drawer of 
the panel

Delete Removes the data type from the drawer of the 
panel

Default Loads the default drawer layout and widths

Position Specifies the drawer (left or right) on the soft panel

Windows data 
(read-only)

<text> Specifies the resource or data that is included in the 
drawer of the panel

Percent # Specifies the width of the window in a percentage 
of the overall drawer size

Rows # Specifies the number of button rows in the drawer 
window

Columns # Specifies the number of button columns in the 
drawer window

Title bar Selected A header displays above each data type in the 
drawer to identify it on the panel

Cleared The data type is not identified by a header in the 
drawer

Table 53  Button on the Panels Interface

Button Description

Moves the selected items in the Available list to the Assigned list.

 
Moves the selected item(s) from the Assigned list back to the Available list. 
These items will not be available on the panel.

Moves all the available items to the Assigned list.

Moves all the items from the Assigned list back to the Available list. These 
items will not be available on the panel.

Moves the selected item in the Assigned list up one position. This changes the 
order of the displayed items on the soft panel.

Table 52  Layout Tab (Continued)

Item Parameters Description
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Moves the selected item in the Assigned list down one position. This changes 
the order of the displayed items on the soft panel.

Moves the selected item in the Assigned list to the top of the list. This changes 
the order of the displayed items on the soft panel.

Moves the selected item in the Assigned list to the bottom of the list. This 
changes the order of the displayed items on the soft panel.

Organizes the list in descending alphabetical order. This changes the order of 
the displayed items on the soft panel.

Returns the list order to match the database list. 

Table 53  Button on the Panels Interface (Continued)

Button Description
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Creating a New Database
On initial power up, the NRG provides a default database that maps the sources and destinations to 
a single level. If your routing requirements differ from the default database, you can create and 
define a new database as required.

This chapter provides an overview of the Database Manager, and describes how to create a new 
database. The information in this chapter is applicable when the NRG is not a client device in a 
routing system that is controlled by an Ultricore BCS.

 If the NRG has its Product Info > Setup > Remote Controller Mode enabled and is connected to an 
Ultricore BCS, you create and manage your databases via the Ultricore BCS. Refer to the Ultrix 
and Ultricore Database Guide for details on database management with an Ultricore BCS.

For More Information on...
• adding resources to the database, refer to “Defining a Database”.

Database Configuration Overview
 A default database is created upon initial start-up of the NRG.

The generalized work flow of creating a new database is:

1. Create a new entry in the Database Manager table. Refer to “Creating a New Database”.

You can create as many databases as required, but only one database can be active at a time.

2. Activate the new database. Refer to “Activating a Database”.

3. Further define the new database by:

a. Establishing connection points to external devices (clients) as outlined in “Adding 
Connection Points”. To enable an NRG to function as the ‘primary’ of the routing system, 
you must establish communications with the ‘client’ devices. This step is only required if 
external routing systems are connected to the NRG. Refer to “Defining an External Matrix”.

b. Adding routing levels as outlined in “Defining the Levels”.

c. Assigning the physical output ports as outlined in“Mapping the Destinations”.

d. Assigning the physical input ports as outlined in “Mapping the Sources”.

e. If required, define virtual labels to apply to your destinations and sources. Refer to “Using an 
Alias Set”.

f. Create a salvo to capture a series of crosspoints to switch in the matrix that can be saved 
and later recalled for crosspoint transitions. Refer to “Creating Salvos”.

g. If required, define a new soft panel as outlined in “Creating a Soft Panel”.

Database Manager Overview
The Database Manager interface enables you to quickly create system input and output lists, assign 
those signals to system sources and destinations, and include multiple levels and matrices.

Use the Database Manager interface to:

• Create a New Database — You can create a number of database configurations depending on 
your routing system and its devices. Refer to “Creating a New Database”
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• Delete a Database — You can choose to permanently delete any configured database. Refer to 
“Deleting a Database”.

• Activate/Deactivate a Database — Select a database from a list of imported files to activate and 
apply its settings to your routing system. Note that only one database can be active at a time. 
Refer to “Activating a Database”.

• Create a Template — Use the Duplicate feature to create a copy of a current database to use as a 
template for new databases. Refer to “Copying a Database”.

• Import a Database — Enables you to import a saved database file and make it available in the 
Database Manager interface. Refer to “Importing a Database”. 

• Export a Database — Enables you to capture the active database configuration as a file that is 
saved to the Downloads folder on your DashBoard client computer. Refer to “Exporting a 
Database”. 

• Restore a Database — Enables you to quickly restore the active database to an earlier version. 
Refer to “Restoring a Database”.

Accessing the Database Manager
The Database Manager interface enables you to quickly define a database by auto-populating the 
applicable fields in the other database interfaces. 

To access the Database Manager

1. Display the Databases nodes as outlined in “To access the Database interfaces”.

2. Double-click the Database Manager sub-node.

The Database Manager interface opens.
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Creating a New Database
This section outlines how to create a new (blank or empty) database for a routing system. Once a 
new database is created, you can activate it and further define the database resources (levels, 
destinations, sources, salvos, etc.).

To create a new database

1. From the Database Manager interface, click  Add.

The Add dialog opens.

2. Use the Name field to type a unique identifier for the database.

3. Use the Default Configuration box to determine how to build the new database. Choose from 
the following:

• Select the box — the new database created with the default number of sources, destinations, 
a single level, and the two default soft panels. Note that once this database is activated, you 
can still edit its resources as required.

• Do not select the box — the new database is empty. You will need to populate the database 
using the Database sub-nodes (e.g. Levels, Sources, Destinations, Salvos, etc.).

4. Click Add database.

The Add dialog closes and a new row displays in the Database Manager table with the name 
entered in step 2. Note that the status of the new database is Inactive.

5. Ensure the new database is active. Refer to “To activate a database”.

6. Select the Database Configuration tab.

7. Use the Operation Mode options to determine if the database is editable and how changes are 
applied. Choose from the following:

• Auto save — Changes made to any database interface are automatically saved and applied. 
This is the default setting when a database is toggled to Active.

• Protect — All fields, except Aliases and labels, of the database are read-only and cannot be 
edited. A blue border displays around each interface. A blue Protected icon displays in the 
bottom left corner of every interface to remind the user that the database settings are now 
read-only.
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• Manual save — The database is editable. An orange border displays around each interface. 
The Cancel and Save buttons display in the bottom right corner of each interface. After 
editing any interface, the user must then click Save to apply any changes. Clicking Save on 
one interface applies changes made to any interface in the database. This mode is 
recommended if you are editing numerous database settings and want to ensure the 
changes are applied after each edit.

When using large databases, it is highly recommended to select Auto save. If you select Manual 
save, there may be a delay between saving the database and seeing the results of your edits.

 Note that setting the Operation Mode from Manual save to Auto save will automatically apply any 
unsaved changes.

 The Operation Mode set for an activated database is not retained. The Operation Mode will 
always revert to Auto save upon reactivation of the original database. For example, if you activate 
Database02 and set the Operation Mode to Manual save mode, then activate Database03, and 
then re-activate Database02, the Operation Mode in Database02 is reverted to Auto save. 

8. Use the Display IDs options to determine how auto-ID numbers are assigned within the 
database. Choose from the following:

• Starts at 0 — Entries in the database interfaces start at 0. The top row of each interface (e.g. 
Levels, Destinations, Sources, etc.) is assigned to 0, with subsequent rows numbered 1, 2, 3, 
etc.

• Starts at 1 — Entries in the database interfaces start at 1. The top row of each interface (e.g. 
Levels, Destinations, Sources, etc.) is assigned to 1, with subsequent rows numbered 2, 3, 4, 
etc.

9. Use the Snapshots options to specify how often the database is auto saved or to create a 
snapshot version immediately (by selecting the Create option). The default is 15 minutes.

Activating a Database
Each active database includes a unique setup. You must activate a database before you can 
configure the resources, and soft panels. This also enables you to quickly apply a different setup 
just by activating a different database. 

When one database is active, all other databases are automatically set to inactive.

To activate a database

1. From the Database Manager table, select the row for the database you wish to activate.

2. Click Activate from the top toolbar.

 The Operation Mode is set to Auto save when a database is activated.

3. Verify the following to ensure the database was activated:

• The Status field for the selected database reports active.
• The Status fields for all other databases report inactive.
• The Database node in the Tree View reports the active Database name. 

4. If required, use the Operation Mode options to determine if the database is editable and how 
changes are applied. Choose from the following:
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 Setting the Operation Mode from Manual save to Auto save will automatically apply any 
unsaved changes.

• Auto save — Changes made to any database interface are automatically saved and applied. 
This is the default setting when a database is toggled to Active.

• Protect — All fields, except Aliases and labels, of the database are read-only and cannot be 
edited. A blue border displays around each interface. A blue Protected icon displays in the 
bottom left corner of every interface to remind the user that the database settings are now 
read-only.

• Manual save — The database is editable. An orange border displays around each interface. 
The Cancel and Save buttons display in the bottom right corner of each interface. After 
editing any interface, the user must then click Save to apply any changes. Clicking Save on 
one interface applies changes made to any interface in the database. This mode is 
recommended if you are editing numerous database settings and want to ensure the 
changes are applied after each edit.

Managing the Databases
A database can be archived by saving it as an *.udb file to the Download folder on your computer. 
This enables you to import and export an archived database which is useful for:

• creating a safe, off-frame copy of a default database configuration
• importing a copy of a reference database that can be tailored to a specific application
• restoring a known backup copy of a database to your routing system

Overview
The following information is captured when you archive a database:

• Definitions of levels, destinations, and sources
• Salvos
• Category assignments
• Soft panels
• Alias sets
• Current crosspoint status

 The following information is not captured: hardware specifics, and license settings.

Copying a Database
Use the Duplicate feature to quickly create a copy of a selected database to use as a template for 
new databases.

To create a database template

1. From the Database Manager table, select the row for the database you wish to copy.

2. Click Duplicate from the top toolbar.

The Duplicate dialog opens.

3. Use the Name field to assign a unique identifier to the template.

4. Click Duplicate database.

5. Click Apply.

The Duplicate dialog closes. The Database Manager table displays a new row for the template.



102 • Creating a New Database NRG User Guide (v1-rev1)

 The database is not automatically activated. You must follow the procedure “To activate a 
database” to activate the new database before editing it.

Exporting a Database
You create an archive of a database (as a *.udb file) using the Export option in the Database 
Manager. This enables you to create a duplicate or template of a database and edit it settings 
without impacting the original file.

 The database does not need to be active.

To export a database to the archive

1. From the Database Manager table, select the row for the database you wish to export.

2. Click Export from the top toolbar.

The Export dialog opens.

3. Use the Save as field to specify the filename for the exported file.

4. Click Export database to specify the location to save the new *.udb file to.

5. Click Apply.

The Export dialog closes.

Importing a Database
Once a database is imported from the archive to your system, you can select it from the list of 
databases in the Database Manager.

 The database is not automatically activated. You must follow the procedure “To activate a 
database” to activate the imported database.

To import a database to the Database Manager

1. From the Database Manager toolbar, click Import.

The Import dialog opens.

2. Click Choose File.

3. Select the *.udb file you wish to import as follows.

4. Click Open.

The Select file field in the Import dialog reports the selected filename.

5. Use the Database name field to assign an identifier to the file. This name will display as a new 
row in the Database Manager.

6. Click Apply.

7. Verify that the imported database displays in the Database Manager.

Deleting a Database
 Ensure the database that you are about to delete is not currently active.

To delete a database

1. From the Database Manager table, select the row for the database you wish to delete.

2. Click Delete from the top toolbar.

The Delete database dialog opens.

3. Click Apply.
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Restoring a Database
The Database Manager automatically saves a backup (snapshot) every 15 minutes when a change is 
made to the active database. This enables you to quickly restore the active database to an earlier 
version. Use this function if an unwanted change was made to the database, to troubleshoot an 
issue with the database, or to verify an earlier state.

To restore the active database to a snapshot version

1. From the Database Manager toolbar, select the active database to restore.

2. In the Database Configuration tab, select the required backup from the Snapshots list.

The Snapshots list displays the available snapshots based on the date and time with the latest 
snapshot at the top.

3. Click Restore.

4. Follow the on-screen instructions.
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Defining a Database
This chapter outlines how to use the Database sub-nodes in DashBoard to further define a 
database for the NRG.

Overview
Each database consists of a collection of configuration files necessary for routing operation. In 
systems with multiple devices, the database resides within the primary NRG storage system. 
Multiple databases may be saved and accessed at any time, but only one database can be active at 
a time. 

The following information is captured in a database:

• Definitions of levels, sources, and destinations
• Salvos
• Category assignments
• Soft panels
• User assigned port labels (alias sets)
• Current crosspoint status

 The following information is not captured in a database: hardware specifics, and license settings.

Once a new database is created, you then define the devices included in the new database. Next 
you define the resources (levels, destinations, sources, salvos, and soft panels) for the new 
database. 

Before You Begin
Keep the following in mind:

• The NRG supports a maximum of 800 logical destinations with up to 4 levels each.
• Ensure that each external device in your routing system is installed and configure according to its 

documentation.
• Serial control of an external device is not implemented at this time.
• Connection to external devices may be categorized into two groups: controller and controllee.   

› Controllers are devices that will connect via what may be termed an incoming connection.
› Controllees are devices to be controlled by the NRG and connect via what may be termed an 

outgoing connection.
• Routing commands are issued to the primary NRG via remote control panels, external protocols, 

or DashBoard soft panels.
› Only the soft panels defined within the active database of the primary NRG may control the 

routing system.
› Any controllee (client) device will ignore routing commands not originating from the primary 

NRG while in the connected mode.

Adding Connection Points
A single NRG can communicate with multiple client devices such as other NRG routers, Ross remote 
control panels, Ross NK devices, and automation devices running third-party protocols. This section 
outlines how to add a new connection point based on the type of client device you want to connect 
to.
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The options in the Routing Devices interface enable you to specify the devices in your routing 
system. Once all the client devices are added to the Routing Devices interface, you will need to 
configure a connection point to each device. The steps required to define a connection point 
depend on the protocol (TCP, etc.) that the client device uses. Creating a connection point from a 
specific NRG router (which will function as the primary) to each client device enables the NRG to 
access the matrix of that client, and issue routing commands to these devices.

Before You Begin
Keep the following in mind when establishing a connection point from a primary NRG to client 
devices:

• Assign a unique name to each client device. This allows identification of each device throughout 
the setup process.

• Client device configuration (licensing, port configuration, etc.) is achieved via the client’s nodes 
within the DashBoard tree. 

• Client NRG-MV Multiviewers are configured via the NRG-MV node within the DashBoard tree of 
the client router that physically hosts that Multiviewer.

• Some communication protocols refer to source and destinations with a numerical index number. 
This number is listed in the ID column of the Source and Destination interfaces of the database.

Adding a Ross Device
This section briefly summarizes the steps required to manually add a new client device to the 
Routing Devices interface of the NRG. This will enable the NRG to communicate with devices using 
this protocol.

To add a client device

1. Display the Database nodes as outlined in “To access the Database interfaces”.

2. Double-click the Routing Devices node located under the Database node.

3. From the Routing Devices interface, click  Add.

The Add Device dialog opens with the Ross tab automatically selected.

4. If the client device is another NRG router:

a. Use the Protocol menu to select NRG-tcp.

b. Use the IP field to specify the IP address assigned to the client NRG in your network.

c. Use the Name field to type a unique identifier for the NRG.

5. If your device is a Ross NK product:

 The Ross NK series devices must be connected to the ethernet network by virtue of an Ross 
NK-IPS or NK-NET devices to enable the routing system to communicate with them.

a. Select the Ross NK tab.

b. Use the Protocol menu to specify the type of Ross NK protocol the device requires.

c. Use the IP field to specify the IP address assigned to the NK-IPS or NK-NET that is connected 
to the device you wish to add.

d. Click Get device list to update the entries in the Add Devices dialog.

e. Select the Add box for each NK device you wish to add.

6. If your device uses a third-party protocol, refer to “Defining an External Matrix”.

7. Click Apply.
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The Add Device dialog closes.

The Routing Devices table updates to include a new row for the client device.

Defining a Connection Point to a Client Device
Once a connection point is established between the primary NRG and its clients, the physical inputs 
and outputs the clients provide will display in the active database. These input and outputs ports 
are now ready for renaming (if required) and mapping to logical source and destinations in the 
database. 

 A connection point is created using the primary NRG interface. Do not attempt to create a 
connection from a client to the primary NRG.

 NRG-MV PiP and head destination mapping is required in the primary NRG database for each 
NRG-MV Head in use. The procedure is the same as the NRG-MV configuration for a stand-alone 
NRG router. 

To enable the connection point between the primary NRG and a client device

1. In the Routing Devices interface of the primary device, select the row for the client device you 
wish to create a connection point to.

The interface displays the Communication, and Info tabs for the selected client device. 

2. Select the Device Configuration tab.

3. Set the Device State field to disabled.

4. Use the Protocol menu to specify the type of communication protocol the client device 
requires.

5. Use the Device name field to edit the identifier assigned to the device within the database.

6. Use the IP Address field to edit the IP address assigned to the client device.

7. Use the Port field to specify the Port Number assigned to the client device.

8. Verify that the other fields are correct.

9. Set the Device State field to enabled.

 The changes are automatically applied once the Device Status is set to enabled.

Defining an External Matrix
The NRG provides support for many industry standard third-party protocols for interfacing to 
external devices such as control systems, and external routing matrices. Once a connection is made 
to the external device via the third-party protocol, you will need to define the matrix from that 
device. 

The database system does not automatically know the details of any connected third-party matrix 
(e.g. number of inputs, outputs, levels, etc.). This means that you must manually define the size and 
operating level for each external device within the active database. This section outlines how to add 
the details of the external matrix provided by your client device(s) to the database.

Connection via Ethernet
Incoming ethernet connections are defined within the control system by default and need no 
further configuration. Table 54 lists the available protocols and ports. The NRG can communicate 
with third-party external devices via a TCP connection. By default, NRG runs a server process for the 
following ethernet protocols:
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The available Protocol Server options depends on the type of protocol. Table 55 briefly summarizes 
the options for each protocol type. 

To set up an outgoing ethernet connection to a client device

1. In the Routing Devices interface of the primary NRG, select the row for the client device you 
wish to create a connection point to.

The interface displays the Communication, Matrix, and Info tabs for the selected client device. 

2. Click  Add.

The Add device dialog opens.

3. Select the Third Party tab.

4. Use the Protocol menu to select the third-party communication protocol the device uses. 

5. Use the IP field to specify the IP address assigned to the client third-party device in your 
network.

6. In the Name field, type a unique identifier for the client device. This name is used to identify the 
specific device within the database.

7. Click Apply.

The Add device dialog closes and a new row displays in the Routing Devices table.

8. In the Routing Devices table, select the row for the new device.

9. Select the Device Configuration tab.

Table 54  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

Table 55  Protocol Server Options

Protocol Option Notes
GVG Native Series 7000

L4 Echo • No — the Ethernet Layer 4 acknowledge is disabled. This is the default.
• Yes — the Ethernet Layer 4 acknowledge is enabled.

Probel SW-P-08

Protocol Variant • Use Last Req — NRG will respond using protocol variant 
(extended/non-extended) as per the received request format. This is 
the default.

• Non-Extended — NRG will always replay using non-extended 
formatting.

• Extended — NRG will respond with extended formatting.

Matrix Mode • No — NRG will use information from the LEVEL section of the protocol 
to control NRG levels.

• Yes — NRG will use information from the MATRIX_ID section of the 
protocol to control NRG levels.
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10. Set the Device State field to disabled.

11. Use the Port field to specify the Port Number assigned to the client device that the primary 
device will try to connect to.

12. Set the Device State field to enabled.

Defining the Levels
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). The NRG uses level definitions for easy identification and control of various routing matrices 
or parts of the system. The levels defined in the Database > Levels interface have a direct 
relationship with the Level entries in other database configuration interfaces.

 The quantity of levels determines how many independent IN/OUT ports may be grouped 
together as one source or destination selection.

 The NRG supports a maximum of 800 logical destinations with up to 4 levels each.

To define a level in the database

1. Display the Database nodes as outlined in “To access the Database interfaces”.

2. Double-click the Levels node located under the Database node.

The Levels interface opens.

3. Verify the ID field to specify the priority of each level.

 The ID field is a row number automatically defined by the routing system. This ID value 
corresponds to level numbers when used in remote control panel (RCP) configurations and 
third-party communications.

4. To re-name a level, type a unique identifier in its cell of the Name column. 

It is recommended to use words that describe the level such as VIDEO, AUDIO, etc.

5. To select a unique color that will represent the level in the soft panels:

a. In the Color column, double-click the cell for the level you want to configure.

b. Select the hue from the provided vertical color grid in the Color Select dialog.

c. Confirm that the field beneath the color grid displays the correct color for the level.

d. Double-click the cell again to close the Color Select dialog.
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6. Use the Description column to enter a brief summary of the level or provide additional 
information about the level use or purpose.

 The Description column is for identification purposes only and not required for operation.

To create additional levels

1. Select a row in the Levels interface.

 It is recommended to insert below the last row in the table.

2. Click  Add.

The Add Levels dialog opens.

3. Use the Levels options to specify the type of level to add.

4. Use the Level count to specify the number of new levels to add.

5. In the Name (prefix) field, type the label for the level(s). 

For example, type VIDEO into this field to create levels named VIDEO 1, VIDEO 2, etc.

6. In the Start count field, type the first number to be used in the series.

7. Use the Color option to assign a specific display color for the levels.

8. If required, use the Description field to enter text that helps to identify the levels.

9. Verify the Levels to add field reports the correct number of levels you wish to add.

10. Click Apply.

The Add Levels dialog closes.

The Levels table updates to display the new levels.

To delete an entry from the Levels table

1. Select the row for each level to delete.

2. Click Delete.

To reassign the IDs of the Levels table
• Click Reset IDs.

The ID assigned to all the Levels are updated where the first row (Level) is assigned ID 0, with 
consecutive rows assigned 1, 2, 3, etc.

Mapping the Destinations
This section outlines how to add destinations to an active database using the Add function in the 
Database > Destinations interface.

 The NRG supports a maximum of 800 logical destinations with up to 4 levels each.

To add destinations to the active database

1. Display the Database nodes as outlined in “To access the Database interfaces”.

2. Double-click the Destinations node located under the Database node.

The Destinations interface opens with the table auto-populated as defined if the Default 
Configuration box was selected when creating this database. If the box was not selected, the 
Destinations interface opens with an empty table.
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3. Click  Add.

The Add Destinations dialog opens.

4. Use the Name (prefix) field to specify the label for the new destination entries.

5. Use the Count field to specify the number of destinations in the new series.

6. If the Count value is greater than 1, use the Start count field to specify the first destination in 
the new series.

7. Verify the value reported in the Destinations to add field is correct.

8. Click Apply.

The new destination(s) are automatically added as rows to the bottom of the Destinations tab. 
Once you have created new entries in the Destinations table, you can map each entry to an 
output for each level.

  If you are defining the destinations in a database for use with NRG-MV, it is recommended to first 
define the destinations, then re-name the NRG-MV Head(s) and PiPs to clearly identify them in 
the database. Otherwise there may be duplicate channel assignments in the database.

To map a single destination

1. Locate the destination to map in the Destinations table.

2. If desired, type a new name for the destination in the Name cell.

3. Select the row for the destination to map.

 Use the auto-fill feature to quickly edit a destination, by locating the cell in the Destinations tab, 
type the text, and click the cell to display a pull-down menu of matching destinations to choose 
from.

 You can map multiple destinations by selecting the first cell in the table column, press and hold 
Shift, then selecting the last cell in the table column.

4. Click  Edit.

The Edit dialog opens to the left of the Destinations table.
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5. From the Devices area, select the client device.

6. From the Slots area, select the blade to map.

The Ports area auto-populates with the outputs available in the active database.

7. From the Ports area, select the output to assign to the destination.

 You can map multiple ports by selecting the first cell in the table column, press and hold Shift, 
then selecting the last cell in the table column.

The Channels area auto-populates with the video and audio channels available in the active 
database.

8. From the Channels area, select a row for each level to map.

 You can map multiple channels by selecting the first cell in the table column, press and hold 
Shift, then selecting the last cell in the table column.

9. Click Fill Destinations.

The Destinations table updates with the selected destination mapped.

10. Click  Edit to close the dialog.

To delete a destination from the database

1. In the Destinations table, select the destination(s) to delete. 

2. Click  Delete.

 You can delete the mapping assignment(s) but keep the destination entry in the database by 
selecting the destination row and clicking Clear.

Mapping the Sources
The Sources interface allows the mapping of physical and virtual input ports to your routing system 
inputs. This interface is organized into a table with each row representing a Source and each 
column representing a Level. At the top of the column is the name of the Level. The table cells are 
the input ports assigned to the source for that level.

 A database supports a maximum of 4096 sources.
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To add sources to the active database

1. Display the Database nodes as outlined in “To access the Database interfaces”.

2. Double-click the Sources node located under the Database node.

The Sources interface opens with the table auto-populated as defined if the Default 
Configuration box was selected when creating this database. If the box was not selected, the 
Sources interface opens with an empty table.

3. Click  Add.

The Add Sources dialog opens.

4. Use the Name (prefix) field to specify the label for the new source(s).

5. Use the Count field to specify the number of sources in the new series.

6. If the Count value is greater than 1, use the Start count field to specify the first source in the 
new series.

7. Verify the value reported in the Sources to add field is correct.

8. Click Apply.

To map an input to a source

1. Locate the source to map in the Sources table.

2. If desired, type a new name for the source in the Name cell.

3. Select the row for the source to map.

 You can map multiple sources by selecting the first cell in the table column, press and hold Shift, 
then selecting the last cell in the table column.

 Use the auto-fill feature to quickly edit a source, by locating the cell in the Sources table, type the 
text and click the cell to display a pull-down menu of matching sources to choose from.

4. Click  Edit.

The Edit dialog opens to the left of the Sources table.



114 • Defining a Database NRG User Guide (v1-rev1)

5. From the Devices area, select the client device.

6. From the Slots area, select the blade to map.

The Ports area auto-populates with the inputs available in the active database.

7. From the Ports area, select the input to assign to the source.

 You can map multiple ports by selecting the first cell in the table column, press and hold Shift, 
then selecting the last cell in the table column.

The Channels area auto-populates with the video and audio channels available in the active 
database.

8. From the Channels area, select a row for each level to map.

 You can map multiple channels by selecting the first cell in the table column, press and hold 
Shift, then selecting the last cell in the table column.

9. Click Fill Sources.

The Sources table updates with the selected source mapped.

10. Click  Edit to close the dialog.

To delete a source from the database

1. In the Sources table, select the source(s) to delete.

2. Click  Delete.

 You can delete the mapping assignment(s) but keep the source entry in the database by selecting 
the source row and clicking Clear.

Using an Alias Set
By default, a matrix (or router) port is identified via the labels set in the Destinations and Sources 
interfaces. An alias set enables you to customize virtual labels and apply to the ports if required. For 
example, you may wish to create an alias set that reflects the actual name/label text that the 
physical cable would be assigned. 

 This re-naming is not necessary for router operation, but it may make your assignment of source 
and destination labels easier to identify when using your internal cable naming conventions. 
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An alias set can include labels for sources, and/or destinations. You can choose to rename all labels, 
specific labels, a mix of labels, or whatever suits your requirements. By default, there are no 
pre-defined alias sets in an active database.

Creating a New Alias Set
Take care when determining label text. While a long name may be descriptive for the Source and 
Destination interfaces, many control devices have limited screen space and labels may be 
truncated.

 Unicode characters are not supported.

To create a new alias set

1. Display the Database nodes as outlined in “To access the Database interfaces”.

2. Double-click the Aliases node located under the Database node.

The Alias interface opens.

 The Alias interface is blank when no alias sets are defined yet.

3. Click  Add.

The Add dialog opens.

4. Use the Name field to assign a unique identifier to the alias set.

This name is displayed in the Alias set menu of other interfaces.

5. If required, enter additional information in the Description field.

6. Click Apply.

The Add dialog closes and the Alias page updates to include the new entry.

The   Sources and Destinations tabs now display a list of available matrices in the active 
database. Each tab indicates the port that is included in the active database using the labels 
assigned in the corresponding Database > Configuration interfaces.

To define the source aliases

1. Select the alias set you wish to define.

2. Select the Sources tab.

3. To define a single source label, select the row for the specific port label to edit.
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4. To define multiple source labels:

a. Select the first row.

b. Press and hold Shift.

c. Select the last row.

5. To define all source labels, click Select All.

6. Click Rename.

The Rename dialog opens.

7. Use the Name (prefix) field to type a label prefix. 

 Enter a trailing space to ensure a space between the prefix and the numerical counter.

8. Use the Start count field to specify the first number to be used in the series.

9. Use the New Names Preview field to verify the new label text.

10. Click Apply.

The Rename dialog closes and the Alias column updates to display the new virtual labels for this 
alias set.

To define the destination aliases

1. Select the alias set you wish to define.

2. Select the Destinations tab.

3. To define a single destination label, select the row for the port label to edit.

4. To define multiple destination labels:

a. Select the first row.

b. Press and hold Shift.

c. Select the last row.

5. To define all destination labels, click Select All.

6. Click Rename.

The Rename dialog opens.

7. Use the Name (prefix) field to type a label prefix. 

 Enter a trailing space to ensure a space between the prefix and the numerical counter.

8. Use the Start count field to specify the first number to be used in the series.

9. Use the New names preview field to verify the new label text.

10. Click Apply.

The Rename dialog closes and the Alias column updates to display the new virtual labels for this 
alias set.

To define the alias set for an external device matrix

1. Configure the device as outlined in “Enabling a Communication Service” and “Configuring 
the Service Settings”.

2. From the Alias table, select the row for the alias set you wish to apply.

3. Select the Services tab.

4. Click Apply selected.
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The Service alias set field updates to report the selected alias set, the number of services the 
set was applied to. The Clear button is now enabled in the toolbar.

Using Cat/Index Categories
This section outlines how to organize your resources (sources, destinations) using the Cat/Index 
Mode feature.

Cat/Index mode allows alpha-numeric extensions to labels to “build up” the final label selection. For 
example, CAM 1 - 6 may be expressed as a CAM label with numerical extensions 1 through 6. 
Similarly, alpha extensions may be used, for example, CAM A - E for Cameras A through E.

Destination and source names are split into substrings - the first substring is referred to as the 
category, and subsequent substrings as the indexes (e.g. Category CAM index 1 through 6). As 
source/destination names become more complex, an index may not be the final part of the 
selection name. For example, consider the source names CG TX 1 and CG TX 2; Cat/Index category 
mode may be configured so that a user selects CG, then TX, then either 1 or 2. This may be 
extrapolated to cover a large range of sources and destinations.

Configuring Cat/Index categories requires:

1. Creating the categories.

2. Creating the index filters.

3. Assigning the resources.

Once the Cat/Index categories are defined, you can perform switches on a hard or soft panel, based 
on the categories. 

Creating the Categories
You can assign each resource to a specific category or multiple categories in a database. Using 
multiple categories enable you to filter the resources, and organize them into logical groups. By 
default, categories are organized in alphabetical order. There are two methods for creating 
categories: auto-generate and manual.

• Auto generate — All previous categories will be deleted from the Category table and new ones 
are created based on the resource labels in your database.

• Manual — Choose to create a new category that is not based on the resource labels in your 
database. This is helpful when you want to customize the labels for the control panel with specific 
resources

To auto generate categories based on a database

1. Click Generate on the Cat/Index Categories interface.

The Auto-Generate dialog opens.

2. Click Apply.

The Auto-Generate dialog closes. The Category and Index tables are now populated based on 
the database labels.
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To manually create a new category

1. Select a row in the Category table.

2. Click  Add on the Cat/Index Categories interface.

The Add Category dialog opens.

3. Use the Name field to specify a unique identifier for the new category.

The entry must match a resource name prefix. For example:

• “CAM_” creates a category to categorize resources named CAM_xx where xx is any index.
• “CAM” creates a category to categorize resources named CAMxx where xx is any index.
• “cam” will not categorize any resources as the category names are case sensitive.

4. Click Apply.

The Add Category dialog closes and the new category displays at the bottom of the Category 
table.

In the following example, the user created a new category “CAM_”.

To create a new category based on the resources

1. From the right panel, select the tab for the resource type you wish to assign.

 If the tab is blank, all the resources of that type are assigned.

2. To manually add a new category:

a. Select a resource.

b. Click  Add.

The Add Category/Index dialog displays with the Category auto-populated based on the 
selected resource.
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In the following example, the user is reviewing the list of available Destinations.

c. Edit the fields as required.

d. Click Apply.

3. To auto-generate a new category, click Generate from the resource tab toolbar.

• The Category table displays the a new row for the generated category.
• The selected resource tab is now blank.

Creating the Index Filters
An index for a category enables you to filter the resources. As category names and indexes are 
entered, the bottom half of the Category table updates to indicate which resources of a given 
category is accessible on a control panel. There are two methods for creating the index filters: 
auto-generation, and manual.

 Unicode characters are not supported.

• Auto-Generate — use the Auto Generate tool to create categories and index filters based on the 
resource labels of the database. Or, use the Default Index tool to replace the only the entries in 
the Index table with filters based on the resource labels of the database.

• Manual — create an index filter that is not based on the resource labels of the database. This 
allows you to customize the filters used when creating a soft panel, or when using a control 
panel. 

To assign an index filter

1. Select a row in the Index table. 

2. Click  Add on the Cat/Index Categories interface.

The Add Index dialog opens.

3. Use the Name field to specify a new index filter. 

The entry must match a partial resource name. For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This 
will filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1.

• Note that you would not create an index of “TX 1” and a sub-index of “TX_”. You must choose 
one or the other.
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4. Click Apply.

The Add Index dialog closes and the new index filter is listed in the Index table.

In the following example, the user created index “CH9”.

Managing the Resources
This section outlines how to review the Levels, Sources, and Destinations currently assigned to a 
selected category.

To verify the assigned resources

1. Locate the lower half of the Cat/Index Categories interface.

2. Select a row in the Category table to display the assigned resources for that specific category. 

In the following example, the user is reviewing the resources for the CG_ category.

3. Click a Show button to display the resources in the table and highlights each category and index 
the resources are assigned to. 

In the following example, the user selected Show Sources.
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Using Group Categories
Group Categories allow you to organize database resources (sources, destinations, and levels) into 
folders and sub-folders with arbitrary group names. The group name is not required to match the 
resource names (it is similar to setting up file folders). This group categorization is useful when you 
need to group resources based on their operational regions, events, personnel credentials etc. 
Once you have defined your categories and tags for each level of a database, you can create a 
custom soft panel using the category settings to arrange the sources, destinations, and levels.

This section outlines how to organize the database resources into folders and sub-folders using the 
Group Categories feature. This is done in preparation for creating your custom soft panels using the 
category settings. Once the group categories are defined, you can perform switches, on a hard or 
soft panel, based on the group categories. 

Group categories are arranged in a hierarchy and displayed in a tree view. Each group is 
represented as a folder or node, and the resources included in that group are sub-nodes. Figure 34 
shows two main groups (Baseball and Football) where the Football group also has three sub-groups 
(Local, National, and State).

Figure 34  Example of the Group Categories Tree View

Configuring group categories requires:

1. Creating groups

2. Assigning the resources (destinations, sources, and/or levels) to groups

Auto Generating a Group
You can choose to create the groups based on the levels, sources, and destinations in your 
database or a combination. This requires the virtual labels for each resource to be consistent. For 
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example, if all destinations are labeled as DST #, a group will be created called DST with each 
destination (resource) listed as a separate node.

 Auto generating a group will delete the groups currently listed in the GroupCategories tree.

To auto generate a group

1. Click Generate on the Group Categories interface.

The Generate Groups dialog opens.

2. Select the box to include the resources in the group.

3. Click Apply.

The Generate Groups dialog closes and the GroupCategories interface displays the new 
groups. In the following example, two groups were auto-generated: DST and SRC.

Manually Adding a New Group
You can add a new group or sub-group using the methods described below. 

To manually add a new category group

1. Double-click the Group Categories node located under the Database node.

The Group Categories interface opens.

2. Select the GroupCategories node.

3. Click  Add.

The Add Group Category dialog opens.
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4. In the Name field, type a unique identifier for the new group.

 Unicode characters are not supported.

5. Click Apply.

The Add Group dialog closes and the new group Hockey displays in the GroupCategories tree.

To create a category sub-group

1. Expand the GroupCategories node.

2. Select the node to add the new sub-group to.

3. Click  Add.

The Add Group dialog opens.

4. In the Name field, type a unique identifier for the new sub-group.

 Unicode characters are not supported.

5. Click Apply.

The Add Group dialog closes and the new sub-group is added to the GroupCategories tree 
view.

In the example below, a new sub-group Studio 1 was created in the Baseball group.

Assigning the Resources to a Group
Once a group is created you can assign the required resources (destinations, sources, levels). 
Resources may be assigned to multiple groups if required.

 Auto generating the groups will also assign all available resources for that group. For example, if 
you selected to generate a group of Sources, the sources in the active database are automatically 
assigned to that group.
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To assign a resource to a group

1. In the GroupCategories tree, select the group you want to add a resource to.

2. In the right pane, select the tab for the type of resource you wish to assign to the group.

The right panel of the Cat/Index Categories interface displays a tab for each available resource 
type in the database. Select a tab to view a list of those resources that are not assigned. If a tab 
is blank, all the resources of that type are currently assigned to a category.

3. To assign a single resource, select the resource from the tab.

4. To select a series of resources:

a. In the selected tab, select the first resource in the series you want to assign.

b. Press and hold Shift.

c. Click the last row in the series.

5. Click  Add.

The GroupCategories tree updates to display the selected resources in the group.

In the example below, Dest 1 to Dest 6 were assigned to the Studio 1 group.

To move a resource to another group

1. In the GroupCategories tree, select the resource you want to move.

2. Click Move.

The Move Group Category dialog opens.

3. Select the new location for the resource.

In the example below, DST 3 will move from the Baseball group to the Hockey group.
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4. Click Apply.

The Move Group Category dialog closes.

The GroupCategories tree updates to display the resource in the new location. Notice that the 
resource is now removed from the original group.

To delete a resource from a group

1. In the GroupCategories tree, select the specific resource you want to delete from the group.

2. Click Delete.

The Delete dialog opens.

3. Click Apply.

The Delete dialog closes.

The GroupCategories tree updates to no longer display the resource in the group. 

To delete a series of resources from a group

1. In the GroupCategories tree, select the specific group you want to edit.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.
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2. In the middle pane, select the first resource in the series you want to delete.

3. Press and hold Shift.

4. Click the last row in the series.

5. Click Delete.

The Delete dialog opens.

6. Click Apply.

The Delete dialog closes.

The GroupCategories tree updates to no longer display the resources in the group. 

To move a group within the tree view

1. In the GroupCategories tree, select the group you want to move.

2. Click Move. 

The Move Group Category dialog opens.

3. Use the tree view in the dialog to select where to move the group to.

4. Click Apply.

The Move Group Category dialog closes.

The GroupCategories tree updates to display the group in the new location.

Creating Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for crosspoint transitions. The Salvo interface arranges the crosspoints in a grid layout with 
sources in columns and the destinations in rows. The available levels are displayed in a toolbar to 
the right of the grid.

For More Information on...
• using a front panel buttons for a salvo, refer to “Assigning a Salvo Button”.

To create a salvo

1. Display the Database nodes as outlined in “To access the Database interfaces”.

2. Double-click the Salvos node located under the Database node.

The Salvos interface opens.

The following example shows the Salvos interface when no salvos are created in the active 
database.



NRG User Guide (v1-rev1) Defining a Database • 127

3. Create a new salvo in the database as follows:

a. Click  Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Add salvo.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected. Notice 
that the salvo is flagged as empty.

 You can also click  to capture the current status of the routers.

4. Select the Level button for each router level to include in the salvo.

Each selected Level buttons is now lit.

5. To create a single crosspoint switch, use the cross-hairs to select the source/destination 
combination on the grid.

 A yellow warning icon displays when a salvo is empty (does not include any crosspoint switches).

6. To assign multiple destinations to the same source:

a. Select the button(s) in the Destination toolbar for each destination to include in the switch; 
or click Select all dest to include all the available Destinations.

b. Select the button in the Source toolbar for the source to use for the switch.

The grid updates to indicate the new selections. Notice that each level is represented by a 
corresponding slice of the crosspoint indicator. 

7. Select Follow (located under the Level buttons) to enable the levels to automatically follow the 
switches.

 Click  Clear presets to clear the workspace.
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Configuring the LCP Buttons
The NRG-FR1-LCP and NRG-FR2-LCP provide special tasks (functions) that can be assigned to any 
button on the front panel. These Local Control Panel (LCP) buttons are programmable back-lit 
buttons that also can be customized (brightness, and color). This chapter outlines the default 
button assignments, and the functions that can be assigned to a button.

 This chapter only applies to the NRG-FR1-LCP and NRG-FR2-LCP.

For More Information on...
• using the front panel buttons, refer to “LCP Operation”.

Overview
The Local Control Panel (LCP) buttons are organized into two distinct groups: the leftmost group 
include the function buttons, and the rightmost group include the source and destination buttons.

The number of function buttons depends on the router type. The NRG-FR1-LCP (Figure 35) provides 
8 function, 16 source, and 16 destination buttons. The NRG-FR2-LCP (Figure 36) provides 16 
function, 32 source, and 32 destination buttons. By default, each button is configured from the 
factory. You can choose to keep the default assignments, or reassign to other functions as required.

 An NRG-MV license is required to populate the PIP function buttons. Refer to “NRG-MV Setup” for 
details on this licensed feature. 

 The physical buttons do not display a text label. Figure 35 and Figure 36 show the default 
function assignments as a reference only.

NRG-FR1-LCP
The NRG-FR1-LCP is factory configured with the button assignments as depicted in Figure 35.

Figure 35  NRG-FR1-LCP Front Panel — Default Button Configuration

NRG-FR2-LCP
The NRG-FR2-LCP is factory configured with the button assignments as depicted in Figure 36.
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Figure 36  NRG-FR2-LCP Front Panel — Default Button Configuration

Default Button Function Assignments
Table 56 lists the functions assigned to buttons in the factory default configuration of the 
NRG-FR1-LCP and NRG-FR2-LCP. The default configuration is set to allow the routers to be used 
straight out of the box.

 The default configuration can be recalled by selecting NRG > System > LCP > Configuration > Load 
Defaults.

Displaying the LCP Interface in DashBoard
The options for customizing your LCP buttons and assigning functions are available via the LCP 
interface in DashBoard. This section outlines how to display the LCP interface in DashBoard. For an 
overview of the menus and settings in the LCP interface, refer to “LCP Interface”.

To display the LCP interface

1. Locate the NRG node in the Tree View of DashBoard

2. Expand the NRG sub-node.

3. Expand the System sub-node.

4. Double-click the LCP sub-node.

The LCP interface displays in the DashBoard window with the Configuration tab automatically 
selected. Notice that the interface provides a graphic representing the physical LCP buttons of 
the router (top), with a series of tabs underneath. Select a button to configure its settings. Select 
a tab to display the options.

Table 56  Default Button Functions

Function NRG-FR1-LCP NRG-FR2-LCP
Panel Lock (LOCK)  

Protect (PROT)  

Take (TAKE)  

Clear (CLR)  

Unassigned 4,0a

a. Requires one NRG-MV license.

12, 8a, 4b

b. Requires two NRG-MV licenses.

Destination (Dst) 16, 20a 32, 36a, 40b

Source (Src) 16 32

M1P1

LOCK TAKE

CLRPROT

M1P2 M2P1 M2P2

M1P3 M1P4 M2P3 M2P4

Src1 Src2 Src3 Src4 Src16Src5 Src6 Src7 Src14 Src15Src13Src8 Src9 Src10 Src11 Src12

Src17 Src18 Src19 Src20 Src32Src21 Src22 Src23 Src30 Src31Src29Src24 Src25 Src26 Src27 Src28

Dst1 Dst2 Dst3 Dst4 Dst16Dst5 Dst6 Dst7 Dst14 Dst15Dst13Dst8 Dst9 Dst10 Dst11 Dst12

Dst17 Dst18 Dst19 Dst20 Dst32Dst21 Dst22 Dst23 Dst30 Dst31Dst29Dst24 Dst25 Dst26 Dst27 Dst28

DESTINATIONS

SOURCESFUNCTIONS
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The following example shows the LCP interface for an NRG-FR1-LCP.

The following example shows the LCP interface for an NRG-FR2-LCP.

Setting the Button Brightness
The button brightness can be set through DashBoard. This setting is applied to all buttons on the 
NRG front panel.

To specify the button brightness

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Use the Panel Brightness field to set the LED brightness for the front panel buttons when the 
button is ‘on’; that is when it has been pressed, is already active, or when indicating an error by 
several quick flashes. The value range is from 0 (off) to 10 (maximum brightness). The default 
value is 5.

3. Click Send Configuration to LCP.
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Setting the Button Color
The Key Color tab lists the available functions, their default colors, and the currently assigned color. 
Assigning a color to a function sets all buttons assigned to that function to the same color.

To set the color of a button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Colors tab.

3. Locate the row for the function you wish to configure. You may need to scroll down the tab to 
locate the function.

4. Click the cell in the Selected column.

5. Select a color from the menu.

6. Click the cell in the Default column.

7. Select a color from the menu.

8. Click Send Configuration to LCP.

Assigning Functions to Buttons
Use the LCP > Key Assignments tab to assign functions to the buttons of the NRG-FR1-LCP or 
NRG-FR2-LCP. Any function can be assigned to any button. Each button can be assigned a function, 
with up to 3 parameters (Default, Shift1, Shift2). This function will be called when that button is 
pressed. Table 57 lists the available functions.

Table 57  Available Functions

Key Name Description
Chop A single button that starts a slow or fast toggle between the two most 

recently selected sources for a given destination. Refer to “Assigning a 
Chop Button”.

Crosspoint Switches the input, output and level/breakaway associated with this 
button. Refer to “Assigning a Crosspoint Button”.



NRG User Guide (v1-rev1) Configuring the LCP Buttons • 133

Assigning a Function
This section provides a general overview of how to assign a function to a front panel button. Details 
on specific functions are available in subsequent sections.

To assign a function to a front panel button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, select the button that you want to 
assign.

The Key Assignments table updates to highlight the row for the selected button. 

In the following example, the user selected button 3.

Destination (Dst) Changes the destination that the panel is controlling. 
• If the Dst button is not active, another Dst is selected. 
• If the Dst button is active, the relative destination is selected.
Refer to “Assigning Destination and Source Buttons”.

Level Toggles this level number from the current level pattern.

Macro Records events that can be replayed later. Refer to “Assigning a Macro 
Button”.

Panel Lock Locks the panel from all switches or function button operation. Refer to 
“Assigning a Protect Button”.

Protect Attempts to protect the currently selected output/level pair. Refer to 
“Assigning a Protect Button”.

Salvo Switches multiple configured crosspoints. Refer to “Assigning a Salvo 
Button”.

Shift Changes the source or destination page of the panel buttons.
There are four types of shifts that only apply to sources and 
destinations, all shift values that are not assigned are ignored. Refer to 
“Assigning a Shift Button”.

Source (Src) Switches the input using the current destination and level pattern. 
• If the Src button is not active, the default value is switched. 
• If the Src button is active, the relative source is switched.
Refer to “Assigning Destination and Source Buttons”.

TAKE The TAKE button confirms input button events. The user sets up a 
switch, and presses the TAKE button to confirm. Refer to “Assigning a 
TAKE Button”.

Take Clear The CLEAR button cancels input key events. 

Unassigned The button is not assigned any function.

Table 57  Available Functions (Continued)

Key Name Description
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4. Click the Key Mode cell in the highlighted row.

A list of available functions displays. Refer to Table 57 for a list of functions.

5. Select a function from the Key Mode menu.

The headers in the next three columns update depending on the selected function. The 
selected button also changes to the color assigned to that specific function (as defined in the 
Key Colors tab).

In the following example, the user assigned the Crosspoint function to button 3. The next three 
columns are now labeled as Destination, Source, and Mask. The button is lit orange.

6. Click Send Configuration to LCP.

Assigning a Crosspoint Button
When you make a switch, you need to select the destination, and then the source. When using a 
multi-level system, you may need to select the level(s) you are switching using a breakaway or level 
button prior to selecting the destination. This requires multiple button presses. To reduce this 
effort and the potential for error, common switch sequences may be set up in a crosspoint.
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 You should record relevant information for the crosspoint and include this in the label for the 
button.

To assign a crosspoint to a button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign  
a crosspoint to.

4. From the Key Mode list, select Crosspoint.

5. From the Destination list, select the physical output that connects to the item of destination 
equipment to which you want to switch.

6. From the Source list, select the physical input that connects to the item of source equipment 
that provides the required signal.

7. From the Mask list, select the breakaway level that you want to use for the switch.

8. Click Send Configuration to LCP.

Assigning a Chop Button
If you want to toggle two different sources to the same destination, assign a CHOP button to the 
NRG. For example, the destination may be the monitor that you are viewing, and the sources may 
be feeds from two different camera locations.

To assign a chop button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
a chop to.

4. From the Key Mode list, select Chop.

5. Set the Toggle Rate (slow or fast).

6. Click Send Configuration to LCP.

Assigning Destination and Source Buttons
Destination and source buttons map the physical connections in the database to the front panel.

 The number of inputs and outputs are defined by the active database. Changes to the database 
will overwrite any manual changes made on the front panel. Refer to “Mapping the 
Destinations” and “Mapping the Sources”.

Assigning a Destination to a Button
By default, the bottom row of the NRG-FR1-LCP (1-16) and the two bottom rows of the NRG-FR2-LCP 
(1-32) are assigned as destinations.

To assign a destination to a button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
a Dst function.
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4. From the Key Mode list, select Destination.

5. Use the Default list to select the physical output that connects to the item of destination 
equipment.

 You can use the State options to assign three physical outputs to the same button: Default, Shift 
1, and Shift 2. When Shift buttons are assigned to the NRG, the physical output assigned to that 
button on that shift page is used for the switch. Refer to “Assigning a Shift Button”.

 If you have virtual routing enabled in the NRG, the output that you enter represents the virtual 
destination as set up in the Ultricore BCS control system. Refer to the Ultrix and Ultricore 
Database Guide.

6. Click Send Configuration to LCP.

Assigning a Source to a Button
By default, the top row of the NRG-FR1-LCP (1-16) and the top two rows (1-32) of the NRG-FR2-LCP 
are assigned as sources.

To assign a source to a button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
a Src function.

4. From the Key Mode list, select Source.

5. Use the Default list to select the physical input that connects to the item of source equipment.

 You can use the State options to assign three physical inputs to the same button: Default, Shift 
1, and Shift 2. When Shift buttons are assigned to the NRG, the physical input assigned to that 
button on that shift page is used for the switch. Refer to “Assigning a Shift Button”.

 If you have virtual routing enabled in the NRG, the input that you enter represents the virtual 
source as set up in the Ultricore BCS control system.

6. Click Send Configuration to LCP.

Assigning a Level Button
Assigning a level to a button enables you to switch to a specific level in the database by pressing the 
physical button on the front panel.

To assign a level to a button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
a Level function.

4. From the Key Mode list, select Level

5. Use the Default list to select the level from the router database. 

6. Click Send Configuration to LCP.
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Assigning a Macro Button
A macro is a sequence of events (e.g. switches) that are assigned to a single button. This section 
provides instructions for creating and editing macros, and assigning a macro to a button.

For More Information on...
• macros, refer to “Using Macros”.

Configuring a Macro in DashBoard
Macros can be configured in DashBoard using the options on the LCP > Macros tab. You can 
configure up to 40 macros on a single NRG.

To configure a macro using DashBoard

1. Display the LCP interface as outlined in “To display the LCP interface”. 

2. Select the Macro tab.

3. Locate the row for the macro you wish to configure.

 Each event in a macro is a row within that Macro area.

4. Click Add Event.

In the following example, the user is defining Event 1 of Macro 1.

5. From the first menu, select the task to perform for the event. Choose from the following:

• Switch — performs a standard crosspoint switch.
• Macro — performs a macro within the executed macro. The Output column is the macro 

number and the other columns have no effect.
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• Protect — creates a protect condition on the destination of the selected crosspoint. The Dst 
column is the Output number, the Protect column is the protect status (select Enable to add a 
TAKE protect for this destination, or Disable to release the protect on this output).

• Salvo — performs a salvo within this macro. The Output column is the salvo ID and the other 
columns have no effect. Refer to “Creating Salvos”.

The column labels and settings change depending on the event/task selected. Refer to “Macros 
Tab” for information on the available options. For example, iIf you selected Switch:

a. From the Destination list, select the destination for the event.

b. From the Source list, select the source for the event.

c. From the Selects area, select the level(s) affected by the macro. A selected level is indicated 
by a blue square. Note that an NRG controlled system supports a maximum of 4 levels.

 Each function can occur on any available level, independent of any other function within the 
same macro event.

6. Repeat steps 4 to  for any remaining events of the macro.

7. Click Send Configuration to LCP.

To assign a macro to a button

1. Display the LCP interface as outlined in “To display the LCP interface”. 

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to the macro.

4. From the Key Mode list, select Macro.

5. From the Macro list, select the macro number that you want to assign to this button.

6. Click Send Configuration to LCP.

Assigning a Protect Button
A Protect button (PROT) can be configured in one of two different modes of operation (only one 
mode can be configured at a time):

• Protect mode — places a block on the current destination, preventing it from being controlled 
(selecting other sources) by any other control device (e.g. soft panels, third-party control devices, 
remote control panels). The NRG that instigates the Protect will be the only control device that 
may control the protected destination.

• Lock mode — places a block on the current destination, preventing it from being controlled 
(selecting other sources) by ALL remote control devices (e.g. soft panels, third-party control 
devices, remote control panels). 

 A PROT button can be pressed and held to engage Lock for that NRG. Refer to “Assigning a 
Panel Lock Button”.

Assigning a Protect Button
To prevent switching of critical crosspoints by others, assign a protect button for use on the NRG. 
The protect function ensures that the selected destination can only receive the selected source 
across the selected levels. Once protected, the selected levels on a destination cannot be switched 
by other remote control panels (or by the current control panel if Block All Panels is selected). The 
source is not protected and can be freely routed to other destinations if required. You can protect 
any number of destinations.
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To configure the Protect button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to a Protect or Destination Lock function.

4. From the Key Mode list, select Protect.

5. Click Send Configuration to LCP.

6. Select the Configuration tab.

7. Use the Protect mode menu to determine the mode of protection that you want to use for the 
button. Choose from the following:

• Block Other Panels — The button functions as a Protect. The protected destination and 
level(s) cannot be switched to another source by other remote control panels. The protected 
destination and level(s) can be switched to another source on the current control panel.

• Block All Panels — The button functions as a Lock. The protected destination and level(s) 
cannot be switched to another source by the current control panel or other remote control 
panels.

8. Click Send Configuration to LCP.

Assigning a Panel Lock Button
A Panel Lock (LOCK) button can be used to place a lock on all buttons of the front panel, it will not 
respond to button presses when enabled. By default, this button is disabled (unlocked).

To assign a Panel Lock button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to a Panel Lock function.

4. From the Key Mode list, select Panel Lock.

5. Click Send Configuration to LCP.

Assigning a Salvo Button
A salvo is a predefined list of switch events. Salvos are stored within the router database. Salvo 
names are defined in the database. This section provides instructions for assigning a salvo to a 
button.

For More Information on...
• salvos in the database, refer to “Creating Salvos”.

To assign a salvo to a front panel button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to the salvo.

4. From the Key Mode list, select Salvo.

5. Use the Salvo list to select the salvo to assign.
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6. Click Send Configuration to LCP.

Assigning a Shift Button
A Shift button enables you to access another page of source or destination locations. This is useful 
for switching larger routing systems when you do not have enough buttons for each source or 
destination. A Shift button is applicable to a source or a destination button. 

To assign a Shift button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to a Shift function.

4. From the Key Mode list, select one of the following:

• DST Shift # — The selected button is now a Shift for the Destinations. You can assign up to 
two SHIFT buttons for the Destinations. Refer to “Assigning a Destination to a Button” to 
learn more about assigning destinations to additional pages.

• SRC Shift # — The selected button is now a Shift for the Sources. You can assign up to two 
SHIFT buttons for the Sources. Refer to “Assigning a Source to a Button” to learn more 
about assigning sources to additional pages.

5. Click Send Configuration to LCP.

Assigning a TAKE Button
A TAKE button confirms input button events. By default, a TAKE button is configured on the front 
panel. All switches are activated by pressing the TAKE button instead of a source/crosspoint/macro 
/salvo button. 

 If a TAKE button is not assigned, events are immediately executed without confirmation.

To assign a TAKE button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to a TAKE function.

4. From the Key Mode list, select TAKE.

5. Click Send Configuration to LCP.

Assigning a TAKE CLEAR Button
The TAKE CLEAR (CLR) button cancels input button events.

To assign a TAKE CLEAR button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you want to assign 
to a TAKE CLEAR function.

4. From the Key Mode list, select CLEAR.

5. Click Send Configuration to LCP.
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Clearing a Button Function
A button labeled as Unassigned in the LCP interface indicates that the button does not have a 
function assigned to it and therefore does nothing when pressed. Select it to clear a button of any 
function assignment. If a button is not used for any function it should be unassigned.

To clear a function from a button

1. Display the LCP interface as outlined in “To display the LCP interface”.

2. Select the Key Assignments tab.

3. On the simulated NRG panel at the top of the interface, click the button that you wish to no 
longer use for a specific function.

4. From the Key Mode list, select UNASSIGN.

5. Click Send Configuration to LCP.
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LCP Operation
This chapter provides a general outline of how to use the front panel buttons on the NRG-FR1-LCP 
and NRG-FR2-LCP.

Before You Begin
Keep the following in mind:

• Unless otherwise stated, the default panel configuration is used. 
• The images in this chapter are used to illustrate the behavior of the button and not the default 

color assigned to the function/button.
• While an NRG-FR1-LCP may be used as an example, the operation is the same for the 

NRG-FR2-LCP.

Selecting a Destination
Selecting a destination (Dst) button changes the virtual destination the NRG controls or switches 
the next time a Source (Src) button is pressed. When a Dst button is pressed, the button and its 
source status button (if a preset exists) will be illuminated. 

 If there are no destination buttons assigned to a custom LCP, it operates according to the Cutbus 
mode setting (if configured). Refer to “Cutbus Mode” for details.

Figure 37 shows that the user selected Dst4 which has a preset of Src2 on an NRG-FR1-LCP. Notice 
that Src2 is illuminated (as the status preset).

Figure 37  Example of Selecting a Destination on the NRG-FR1-LCP Front Panel

Figure 38 shows that the user selected Dst4 which has a preset of Src2 on an NRG-FR2-LCP. Notice 
that Src2 is illuminated (as the status preset).

Figure 38  Example of Selecting a Destination on the NRG-FR2-LCP Front Panel

Selecting a Source
Source switching is performed by pressing a preset Src button. Selecting a Src (when a TAKE button 
is not assigned) results in the NRG requesting the selected source to be switched by the router to 
the current destination. 

If the switch request was successful, the preset Src button is illuminated. If the switch was not 
successful or generated errors, the button will flash several times quickly to indicate that an error 
has occurred. If a TAKE button is assigned, the TAKE button will be illuminated and the preset Src 
button will flash (this indicates that TAKE is armed). To perform the switch, press the TAKE button 
or press the CLR button to cancel.
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Figure 39 shows that the current destination Dst4 which as the preset Src8 and TAKE. The user 
selected Src6 arming the TAKE.

Figure 39  Example of Selecting a Source and TAKE on an NRG-FR1-LCP

Figure 40 shows the results after a successful TAKE is issued.

Figure 40  Example of After Selecting a Source and TAKE on an NRG-FR1-LCP

Using a Shift Button
Shift buttons allow the different pages or sets available to preset Src and Dst buttons to be 
accessed. Up to three different sets of Src and/or Dst buttons may be accessed from the panel. The 
SRC Shift buttons change the current set of Src buttons available on the panel and the DST Shift 
buttons change the current set of Dst buttons available. All other buttons are not affected by SHIFT 
buttons.

 Shift buttons are not available on the default configuration. Refer to “Assigning a Shift Button” 
for details on configuring a Shift button.

When no SHIFT buttons are selected, the buttons are on the first or default page/set. By pressing a 
specific SRC Shift or DST Shift button, the panel immediately changes its relevant sources or 
destinations to the specified set. A Shift button is active when illuminated. Pressing a Shift button 
again, toggles it to the default button set. As the sets change if a Src or Dst button matches the 
currently controlled destination or the source status that button will be illuminated.

Using a Crosspoint Button
CROSSPOINT buttons perform a preset crosspoint switch in a single button press, and the button 
will illuminate to indicate the state of that crosspoint. When a crosspoint switch is performed the 
panel’s current destination, and source changes to those specified in the CROSSPOINT button 
assignment.

If a CROSSPOINT button’s preset destination and source status matches that destination’s source 
status in the router on all levels the button will be illuminated. If a TAKE button is assigned, the 
TAKE button is illuminated and the preset CROSSPOINT button flashes (this indicates that TAKE is 
armed).

 A CROSSPOINT button is not available on the factory default configuration. Refer to “Assigning a 
Crosspoint Button” for details on configuring this button.

Selecting a Level
A LEVEL button selects the router level to execute switches on. In the factory default mode, there 
are no level buttons assigned to the LCP since there is only one level in the default database. If a 
single level exists, it is asserted. Up to 4 levels can be configured in the active database.
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Using Macros
Macros can be used to initiate multiple switches in one quick button press. Several MACRO buttons 
can be assigned to one panel and then different macros recorded to each button. When users are 
required to regularly switch between two or more static switch assignments, macros can be used to 
switch these in one easy button press.

A macro is an event playback feature similar to a salvo. A salvo will only trigger a series of switches, 
whereas a macro will record a series of events for express playback at a later time. When the macro 
is played back, it will activate a sequence of switches to configure the router. Macros can be 
extremely valuable in minimizing repetitive button presses by configuring multiple switch events 
(source, destination and crosspoint) to one button.

A macro event comprises a source, destination, crosspoint, macro, or protect button press. When 
appending one macro to another, this is counted as one (1) event. 

For More Information on...
• creating macros using DashBoard, refer to “Assigning a Macro Button”.

Overview
A MACRO button can store a maximum of 84 events and users can assign up to 40 MACRO buttons 
on the NRG panel. It is recommended that users with only a single, unlinked router only assign two 
or three MACRO buttons. Users who have several linked routers may find it convenient to have one 
NRG set aside solely for the purpose of macros and assign as many MACRO buttons as is required.

 Pressing a SHIFT button when recording a macro does not count as an event, as the macro 
recorder simply recognizes that the button that is actually pressed is the relevant source or 
destination.

Defining Macros from the Front Panel
To define a macro, you first need to start Macro Recording mode via the front panel.

1. Hold down the MACRO button for about three seconds.

The MACRO button will flash quickly to indicate that the panel is initiating Macro Recording 
mode.

2. Release the MACRO button.

The MACRO button will flash slowly to indicate that the panel is in Macro Recording mode.

3. Enter the events you wish to record, as you would if you were to activate a switch.

Button presses will be acknowledged by a quick flash on the button you have entered into the 
macro.

4. When you have finished entering switch events, press the MACRO button.

The MACRO button will stop flashing to indicate the panel has exited Macro Recording mode.

Appending Macros
Appending macros is a feature that allows the addition of more events (or another macro) to an 
already existing macro using the front panel.

To append a macro, you first need to enter Macro Recording mode, and then enter Macro 
Recording mode again to append the macro.

1. Hold down the MACRO button for about three seconds.

The MACRO button will flash quickly to indicate that the panel has initiated Macro Recording 
mode.
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2. Release the MACRO button.

The MACRO button will flash slowly to indicate that the panel is in Macro Recording mode.

3. Hold down the MACRO button again (this will play back the macro internally so that it may be 
appended).

The MACRO button will flash quickly.

4. Release the MACRO button.

The MACRO button will again flash slowly to indicate that the panel is in Macro Recording 
mode.

5. Enter the events you wish to record as you would if you were to activate a switch.

Button presses will be acknowledged by a quick flash on the button you have entered into the 
macro.

6. When you have finished entering switch events, press the MACRO button.

The MACRO button will stop flashing to indicate the panel has exited Macro Recording mode.

When appending macros or adding one macro to another, if you use a single input or output in 
more than one macro, it will override the previous status of that button.

Adding one Macro to another Macro
Adding one macro to another can be useful when you have more than one macro that shares the 
same output status (the same source to destination switch assignments) but where one macro also 
has output status that the other macro has not assigned.

As the macro function is only an event recorder, other macros are stored as one single event, not 
the sum of the events in that macro. Similarly, if a macro that has already been added to another 
macro is changed, the appended macro when played back will reflect that change.

Figure 41  Example of Adding one Macro to Another Macro

In the example above, the Macros are as follows:

• MCR1 = Src 1 to Dst 1, 2 and 3, and also sends Src 2 to Dst 7, 8, and 9.
• MCR2 = Src 1 to Dst 4, 5, 6 and 7, and also sends Src 2 to Dst 8 and 9.

In this example, because Dst 7 is used twice, the last status added will be the one used when the 
macro is played back. The final status of MCR1 when it is played back will be as such will be:

• Src 1 to Dst 1, 2, 3, 4, 5, 6, and 7.
• Src 2 to Dst 8 and 9.

To cancel recording or appending a Macro, press the MACRO button after entering Macro 
Recording mode.
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Macros can not be canceled after entering events in Macro Recording mode. If a mistake has 
been made, you will have to exit Macro Recording mode and enter it again to re-enter events you 
wish to be played back.

Using a Macro
Ensure you recorded a macro and assigned it to a physical button on the front panel.

To use a macro

1. Create a macro.

2. Press the required MACRO button on the NRG front panel.

3. If a TAKE button is assigned, press TAKE.

Using a Salvo
Salvos are a selected series of crosspoints to switch in the routing matrix that can be saved and 
later recalled for crosspoint transitions. 

To select a salvo via the front panel

1. Create a salvo as outlined in “Creating Salvos”.

2. Press the assigned Salvo button on the front panel.

3. If a TAKE button is assigned, press TAKE.

Using the Protect Button
The PROT button is used to lock the current destination from use by other sources, as well as from 
other linked panels. The PROT button is especially useful in instances where a destination must be 
held after a switch has been made.

 A PROT button is available on the factory default configuration.

The operating mode of the PROT button is determined by the configured mode in DashBoard. 
Refer to “Assigning a Protect Button”.

Using the Panel Lock
A panel may be locked to prevent unwanted button presses (particularly accidental switches). 

The Protect (PROT) function and the Panel Lock (LOCK) function are interchangeable. If both 
function buttons are configured on one panel, a panel lock can be activated from one button, and 
deactivated from the other.

To activate the panel lock from the front panel

1. Hold down the PROT button for about three seconds.

The PROT button will flash quickly to indicate that the panel lock has been activated.

2. Release the PROT button.

The PROT button will flash slowly to indicate that the panel is locked.
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Using the TAKE Button
A TAKE button is used to activate the selected switch. When a TAKE button is assigned, the selected 
source/crosspoint/macro button and the TAKE button flash to indicate that the NRG is waiting for 
TAKE to be pressed.

 A TAKE is also required macro/salvo/crosspoint button selections and Cutbus mode.

 A TAKE button is available on the factory default configuration.

1. Press the required Dst button.

2. Press the required Src button.

The Src button on the panel flashes and the TAKE button illuminates.

3. To activate the switch, press the TAKE button.

The entered crosspoint change will be completed immediately after the TAKE button has been 
pressed. This enables you to preset a crosspoint change before the switch is required. The 
pending switch can be aborted by pressing any button other than the TAKE button.

Using the TAKE CLEAR Button
Use the CLR button to cancel input button events. 

 A CLR button is available on the factory default configuration.

Using the CHOP Button
The CHOP button enables the user to alternate between two sources.

When CHOP is enabled, all other buttons are disabled.

1. Pressing CHOP will alternate the two previously selected sources for a given destination.

2. Pressing CHOP once will start a slow chop.

3. Pressing CHOP again will increase the speed of the chop to a fast chop and pressing again will 
discontinue the chop mode. 

Cutbus Mode
Cutbus is a configuration that creates a default switching panel that only affects assigned outputs 
on a particular router. The NRG has two modes of cutbus operation: normal, or off. This section 
provides instructions on how to create a default switching panel that only affects assigned outputs 
on a particular router.

Keep the following in mind:

• All destinations/crosspoints must be removed from the panel. 
• If a TAKE is assigned, and TAKE must be issues for switch to occur. 

Normal Cutbus Mode
Cutbus is a configuration that creates a default switching panel that only affects assigned outputs 
on the router. The front panel operates in either Single Cutbus mode or Dual Cutbus mode.

• Single Cutbus Mode — on the Configuration tab in DashBoard, Cutbus Dest 1 equals Cutbus Dest 
2. 
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• Dual Cutbus Mode — on the Configuration tab in DashBoard, Cutbus Dest1 does not equal 
Cutbus Dest 2. 

To set up normal Cutbus operation

1. Display the LCP interface as outlined in “To display the LCP interface”.

The Configuration tab is automatically selected.

2. Ensure that there are no destinations or crosspoints assigned to any buttons on the NRG.

3. From the CutBus Mode options, select Normal.

4. From the Cutbus Dest 1 box, enter or select the destination output for the top row of buttons.

5. From the Cutbus Dest 2 box, enter or select the destination output for the bottom row of 
buttons to use dual cutbus mode. Set the destination to the same destination as Cutbus Dest 1 
if you want to use single cutbus mode.

6. Click Send Configuration to LCP.

Linked LCP Operation
When multiple NRG routers are linked together, button behavior remains as above (with single 
panel system), although the following details must be noted when linking routers:

• Pressing CHOP will alternate between two sources, including cases when the sources are on 
different physical routers.

• Pressing TAKE will activate a take, including cases when the Src button is on a different router to 
the TAKE button.

• If any linked router has a TAKE button, the linked device enters TAKE mode when a Src or 
CROSSPOINT button is pressed.

• Locking one physical router will also lock all linked routers. 
• Entering Macro Recording mode causes all linked routers to be in Macro Recording mode, switch 

events and protects can be added from different physical routers.
• Macros cannot be appended or added across routers.
• SHIFT buttons control source and destination for the whole linked router.
• Dst buttons control the destination for the whole router.
• LEVEL buttons control the level mask for the whole router. 
• If an NRG router is added to an operating linked router, the newly linked router changes its states 

in regards to TAKE, PANEL LOCK, and Cut-bus mode accordingly.
• If a linked NRG is added to an operating linked device that is in TAKE, CHOP, PANEL LOCK, or 

Macro Recording mode, it starts in that mode.
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Soft Panels in DashBoard
A soft panel is a software implementation of a physical remote control panel (RCP). The soft panel 
configurations are part of a database. Any instance of DashBoard connecting to the NRG has the 
defined soft panels available. You can customize a soft panel by defining the sources, destinations, 
levels, and/or salvos that will be available on the soft panel interface. 

This chapter outlines how to create, display, and use the soft panels for your NRG router.

Before You Begin
Keep the following in mind when managing your soft panels in DashBoard:

• Soft panels require the setup of the database resources (sources, destinations, levels, salvos, 
aliases, and port assignment) to be complete.

• If the database changes, you will need to verify each soft panel configuration to ensure the 
correct resources are still visible.

• The NRG does not support Unicode characters in database entries and soft panel fields.
• Two default push button soft panels are automatically created in the default database: Control 

(confirm take) and Control (direct take). 

Default Soft Panels Overview
By default, two Push Button soft panels are available in the default database: Control (confirm take) 
and Control (direct take). Each default soft panel is organized into a landscape format with five 
distinct areas. 

For More Information on...
• using the default soft panels, refer to “Crosspoint Switches via a Default Soft Panel”.

Figure 42 is an example of the Control (confirm take) Push Button soft panel.

Figure 42  Example of the Default Control (confirm take) Soft Panel
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Figure 43 is an example of the Control (direct take) Push Button soft panel.

Figure 43  Example of the Default Control (direct take) Soft Panel 

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a button to 
arm that destination for subsequent panel operations. Beneath each destination button is 
displayed the current source for that destination.

›  — the current destination is locked. No switches can be made on this destination.

›  — the current destination is protected. Only the panel that initiated the protect may switch 
this destination.

2. Sources Area

The Sources area displays the available sources for router control. Select a button to control the 
crosspoint for the currently selected destination.

3. Levels Area

Each router level is represented as a button in the color defined in the active database. Select a 
button to include that level in the next crosspoint switch. A lit button indicates that the 
corresponding level will be included in the next transition. 

4. Operation Area

The bottom toolbar of each soft panel provides buttons for soft panel and router control:

› Alias — click this button to apply a virtual label set to the soft panel source and destination 
buttons. Refer to “Using an Alias Set” for details on creating virtual labels in your database.

› Protect — when selected, it prevents switching of the selected destination except by the panel 
that initiated the protect. If you are using a soft panel with the Protection Operation set to 
Disable, the Protect button is not displayed. 

› Lock — click this button to prevent switching of the selected destination by an control device. 
Only the panel that initiated the lock may change the lock status. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock button is not displayed. 

› View — displays the current crosspoint switch requests currently in the preset list. Individual 
crosspoints may be removed via the list view.

1) Destinations Area 2) Sources Area 3) Levels Area 4) Operation Area 5) Additional Toolbar
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› Clear — clear the list of all crosspoint selections (clears the current TAKE queue).
› Preset — adds the current destination/source/level selection to a preset list. This enables the 

user to add more switches and execute them all with a single take operation. The preset 
function is only available for the Control (confirm take) soft panel. Use this button to queue up 
multiple TAKE commands. Select a destination/source combination, then click Preset. Select 
another destination/source combination then click Preset. A following TAKE command will 
execute all the Preset switches. To view the switch commands queued by the Preset, click View.

› Show Take Errors — displays a summary of the error conditions that were detected each time 
a switch command was executed. Click Close to the exit the dialog.

› TAKE — is lit when the current destination/source selection is ready to be requested of the 
router. This button is only available for the Control (confirm take) soft panel.

5. Additional Toolbar

The following additional buttons are available:

› Current — the status of the last crosspoint switch.
› Pending — the status of the upcoming crosspoint switch.
› User — This button shows current lock/protect status of each levels (and the soft panel name 

that is currently owned it). Since the soft panel does not recognize the names of remote control 
panels (RCP) to retrieve their name, a “owner #” name is used. 

› Follow — Click this button to select all levels in the panel. Clicking TAKE after pressing Follow 
will then switch all crosspoints at the same time on all available levels. Note that on Matrix 
panels, the Follow button is located under the Levels buttons.

› Clear — discards all selections on the panel interface.
› Clear SEL Src — clears individual source selections by selecting the levels to be cleared.

Types of Soft Panels
This section briefly outlines the types of soft panels you can choose to create in your active 
database.

Matrix Panels
Matrix panels enable you to perform direct and confirm take transitions, and salvo definitions using 
a grid of sources and destinations. Each level is represented as a button in the color defined in the 
active database. Notice that the crosspoints are represented in the same color as the applicable 
level. 

The number of Destinations and Sources and their labels in the matrix are specified using the 
Destinations and Sources interfaces. Click within the matrix or click the Destination and Source 
buttons to select the crosspoints for switching the selected levels.
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Figure 44  Example of a Matrix Soft Panel

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a button to 
arm that destination for subsequent panel operations.

2. Sources Area

The Sources area displays the available sources for router control. Select a button to control the 
crosspoint for the currently selected destination.

3. Levels Area

Click a level button to include that level in the next crosspoint switch. A lit button indicates that 
the corresponding level will be included in the next transition. The color and name of the button 
are specified using the Levels interface. 

4. Operation Area

This area can include the following buttons:

› TAKE — Click this button to execute the switch between crosspoints. If you are using a soft 
panel with its Take operation set to Direct, a TAKE button is not displayed because the 
transitions will occur automatically after a crosspoint switch is selected.

› Lock — Click this button to prevent switching of the selected crosspoints. When creating the 
soft panel, if the Protection operation was set to Disable, the Lock and Protect buttons are not 
displayed.

› Protect — Click this button to prevent switching of the selected crosspoints except in the 
DashBoard client session the Protect was initiated in.

› Free — Click this button to end a lock or protect on the selected crosspoints.
› Salvo — Click this button to display the Salvo menu. Refer to “Creating Salvos”.
› Advanced — Click this button to display the Advanced menu. The following options are 

available:
› Clear All Presets — Removes all selections currently made on the soft panel and returns 

the panel to its default destination and source selections.
› Clear Dest Presets — Removes only the selections made on the Destinations bus.

1) Destinations Area 2) Sources Area 3) Levels Area 4) Operation Area
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› Diagonal Presets — The destination and source crosspoint selections are automatically 
made starting at the top left corner and progressively moving down the grid in a 1:1 
pattern. For example, Src1 and Dest1, Src2 and Dest2, Src3 and Dest3 etc.

› R-Diagonal Presets — The destination and source crosspoint selections are automatically 
made starting at the top right corner and progressively moving down the grid in a 1:1 
pattern. For example, Src10 and Dest1, Src9 and Dest2, Src8 and Dest3 etc.

› Setup Automation — Automatically loops the crosspoint switches for the specified length 
of time.

› Stop Automation — Stops the automatic loop of crosspoint switches that was initiated 
using the Setup Automation option.

› Machine Control (not shown) — If you are using a soft panel with the Machine control set to 
Enabled, the MACHINE CONTROL button is displayed. 

› Find — Click this button to quickly navigate to known source or destination names.
› Filter — Click this button to reduce the number of source and/or destinations visible in a 

matrix panel. This enable a user to filter a matrix panel view to only source/destinations that 
match entered text.

› Show Take Errors — Click this button to display a summary of the number of failed TAKE 
transitions.

MultiBus Panels
A MultiBus Panel provides breakaway control and status monitoring of several destinations 
simultaneously. 

Figure 45  Example of a MultiBus Panel

1. Destination Bus

Each button in this crosspoint row represents a configured output for the selected router. 
Selecting a button includes the destination in the next crosspoint switch. The number of 
destinations and label for each button is defined by its entry in the Destinations interface. A 
destination selected to be included in the next crosspoint switch will have a lit button. For 
example, DST_5 is selected in Figure 45.

1) Destination Bus 4) Preset Button 7) Level Button(s)

2) Lock Button 5) Clear Button 8) Follow Button

3) Take Button 6) Multi Select Button 9) Source Bus
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2. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock button is not displayed.

3. Take Button

Click this button to execute the switch between the selected crosspoints. If you are using a soft 
panel with the Take operation set to Direct, a TAKE button is not displayed because the 
transitions will occur automatically after a crosspoint switch is selected.

4. Preset Button

When this button is lit, a new crosspoint switch is set up on the soft panel. At least one source, 
once destination, and one level are selected on the interface (the Dest and Src buttons are lit 
blue to indicate their inclusion in the next switch). 

When this button is not lit, the crosspoint switch setup is still valid but is no longer indicated on 
the soft panel.

If you are using a soft panel with the Take Operation set to Confirm, the crosspoint switch will 
take effect the next time the TAKE button is selected. If you are using a soft panel with the Take 
Operation set to Direct, a TAKE button is not displayed because the transitions occurred 
automatically (hot-punch operation).

5. Clear Button

Clicking this button clears the selections made for the next crosspoint switch in the soft panel 
interface.

6. Multi Select Button

Clicking this button enables you to perform a switch on multiple crosspoint combinations. If you 
are using a soft panel with the Selection Operation set to Single, a Multi Select button is not 
displayed.

7. Level Button(s)

Click a level button to include the level in a crosspoint that you are configuring in the matrix. A lit 
button indicates that the corresponding level will be included in the next transition. The color and 
name of the button are specified using the Levels interface. Figure 45 illustrates a MultiBus 
panel with four levels (the maximum number of levels that the NRG supports).

8. Follow Button

Click this button to select all levels in the matrix. If you are using a soft panel with the Take 
operation set to Confirm, pressing TAKE after pressing Follow will then switch all crosspoints at 
the same time on all available levels.

9. Source Bus

Each button in this crosspoint row represents an input in the routing system. Selecting a button 
includes the source in the next crosspoint switch. The label for the button is defined by its entry 
in the Sources interface of the Database. A source selected to be included in the next crosspoint 
switch will have a lit button. For example, in Figure 45 the Src_1 is selected for the next transition 
while the Src_4 is the current source in use. 

Salvo Buttons (not shown)

This area displays a button for each salvo available to this soft panel. Selecting a button will 
execute the related salvo.

Machine Control Button (not shown)

If you are using a soft panel with the Machine control set to Enabled, the MACHINE CONTROL 
button is displayed. 
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Group and Cat/Index Panels
Category panels organize sources, destinations and levels based on the settings in the Group 
Category and Cat/Index interfaces. The soft panel interface for each category type (Group, 
Cat/Index) is similar in layout and available buttons. (Figure 46, Figure 47)

 The Group and Cat/Index categories must be first configured in the database. Refer to “Using 
Group Categories” and/or “Using Cat/Index Categories” for details.

Figure 46  Example of a Group Category Soft Panel

Figure 47  Example of a Cat/Index Soft Panel

1. Group Window

This area of the soft panel interface may include the following buttons:

› DESTINATIONS, SOURCES, LEVELS — Clicking one of these buttons updates the crosspoint 
area to display the selected resource (destinations, sources or levels) available as per the 
selected category. The button labels update to display the assigned labels. Note that the NRG 
supports a maximum of 4 levels.

1) Group Window 2) Status Window 3) Control Area
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› TOP — Click this button to return the crosspoint area to display the selected resources. This 
button is only available on the Group Category soft panels.

› BACK — Click this button to return the navigation to the previous category selection (back one 
level).

› RESET — Click this button to clear all selections on the interface. This button is only available 
on the Cat/Index soft panels.

› SELECT — This button is only available on the Cat/Index soft panels.

When using a Group Category soft panel and the Info > Non-group Resources setting is set to 
Hide, only the resources assigned to a group are displayed on the soft panel.

2. Status Window

The bottom right corner of each soft panel includes a status window. For each level in the list of 
available levels, a corresponding status indicator display will indicate the current source for the 
currently selected destination.

The following buttons are located on the right-side of the soft panel interface:

› Level buttons — Click a level button to include the level in a crosspoint that you are configuring 
in the matrix. A lit button indicates that the corresponding level will be included in the next 
transition. The color and name of the button are specified using the Levels interface.

› CURRENT — This button updates the level display area to show the current status for all 
displayed levels.

› PENDING — This button updates the level display area to show status for the currently 
pending operation (if selected source has not been switched yet. e.g. before TAKE is pressed).

› USER — This button shows current lock/protect status of each levels (and the soft panel name 
that is currently owned it). Since the soft panel does not recognize the names of remote control 
panels (RCP) to retrieve their name, a “owner #” name is used. 

› FOLLOW — Click this button to select all levels in the matrix. Clicking TAKE after clicking 
FOLLOW will then switch all crosspoints at the same time on all available levels.

› CLEAR — Click this button to clear all selections on the interface.
› CLEAR SEL SRC — Click this button to clear individual source selections by selecting the levels 

to be cleared.

3. Control Area

The bottom toolbar of the soft panel interface can include the following buttons:

› Protect — Click this button to prevent switching of the selected destination except by the 
panel that initiated the protect. If you are using a soft panel with the Protection Operation set 
to Disable, the Protect button is not displayed.

› Lock — Click this button to prevent switching of the selected destination by an control device. 
If you are using a soft panel with the Protection Operation set to Disable, the Lock button is 
not displayed.

› View — Click this button to display the VIEW dialog. This dialog lists the current TAKE 
commands in the queue. Individual items may be removed from the queue via the options in 
the View dialog.

› Clear — Click this button to clear the current TAKE queue.
› Preset — Use this button to queue up multiple TAKE commands. Select a destination/source 

combination, then click Preset. Select another destination/source combination then click 
Preset. A following TAKE command will execute all the Preset switches. To view the switch 
commands queued by the Preset, click View.

› Salvo — Click this button to display a list of available salvos in the active database.
› Show TAKE Errors — Click this button to display a summary of the error conditions that were 

detected each time a switch command was executed. Click Close to the exit the dialog.
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› TAKE Button — Click this button to execute the switch between the selected crosspoints. If you 
are using a soft panel with the Take Operation set to Direct, a TAKE button is not displayed 
because the transitions will occur automatically after a crosspoint switch is selected.

Group PB Panels
In a Group PB soft panel, the destinations and sources are determined by the Group Categories 
interface but organized into a vertical layout that is similar to the Ultritouch PB panel. 

Figure 48  Example of a Group PB Soft Panel

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a button to 
arm that destination for subsequent panel operations.

2. Sources Area

The Sources area displays the available sources for router control. Select a button to control the 
crosspoint for the currently selected destination.

3. Control Area

The bottom toolbar of the soft panel interface can include the following buttons:

› Lock — Click this button to prevent switching of the selected destination by an control device. 
If you are using a soft panel with the Protection Operation set to Disable, the Lock button is 
not displayed.

› Protect — Click this button to prevent switching of the selected destination except by the 
panel that initiated the protect. If you are using a soft panel with the Protection Operation set 
to Disable, the Protect button is not displayed.

Creating a New Soft Panel
A soft panel can be as simple or complex in its layout as you require. You select a panel type, assign 
a unique name, and configure the settings of the soft panel (such as adding a Lock and/or Protect 
button, the maximum number of resources to display, etc.). Then you specify which destinations, 
sources, levels, and salvos to display on your panel. 

1) Destinations Area 2) Sources Area 3) Control Area
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When you create a new soft panel, you select from the existing soft panel types which determines 
the options to add to the panel. You then assign a Panel Name and ID to display in the tree view 
using the nomenclature “Name [#]” where [#]is the Panel ID.

To create a soft panel

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

2. Click  Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. 

This will be used to identify the panel in the Control > Panels tree.

4. If required, use the Description field to provide a textual summary of the panel.

5. Use the ID field to determine the position of the panel in the Control > Panels tree where a 
value of 1 is the highest priority and listed as the first tree node. Refer to Figure 49.

 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

6. Use the Style menu to specify the type of panel to create. Choose from the following:

• Matrix — organizes the destinations and sources in a grid layout. Refer to “Matrix Panels” 
for layout details.

• MultiBus — organizes the destinations and sources into separate rows (buses) of buttons. 
Refer to “MultiBus Panels” for layout details.

• Group Category — the hierarchy of the destinations and sources are determined by the 
values in the Group Categories interface. Refer to “Using Group Categories” and “Group and 
Cat/Index Panels” for details.

• Push Button — organizes the destinations and sources in a distinct vertical layout. Refer to 
“Crosspoint Switches via a Default Soft Panel” for details.

• Cat/Index Category — the hierarchy of the destinations and sources are determined by the 
values in the Cat/Index interface. Refer to “Using Cat/Index Categories” and “Group and 
Cat/Index Panels” for details.

• Ultritouch PB — the resources are organized into a customized layout that is pre-sized for 
an Ultritouch hard panel. Refer to the Ultritouch User Guide for details.

• Ultritouch 4RU Split — a customized layout that is pre-sized for an Ultritouch-4RU. Refer to 
the Ultritouch User Guide.

• Group PB — the destinations and sources are determined by the Group Categories interface 
but organized into a vertical layout that is similar to the Ultritouch PB panel. Refer to “To 
configure a Group PB panel” and “Group PB Panels”.

7. Click Apply.

The Add Panel dialog closes.

The new panel name is added to the left pane Panels tab and automatically selected in the tab 
for editing. In the example below, the user created a new soft panel named “Matrix” with a 
Panel ID of 1.
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8. Select the Settings tab.

9. Use the Protection operation menu to provides options for preventing crosspoint switches. 
Choose from the following:

• Enable — The Lock, Protect, and Free buttons display on the soft panel. 
• Disable — The Lock, Protect, and Free buttons do not display on the soft panel. These 

protection options will not display on the soft panel.
• Enable w/ Override — Use this soft panel to override any locked/protected destination on or 

from another panel. When a source or destination is locked by an unknown panel, use this 
mode to force a clear of the protect/lock status.

10. Use the Take operation menu to configure the TAKE button for the soft panel. Choose from 
the following:

• Confirm — Displays a TAKE button on the soft panel. You must select TAKE to perform a 
crosspoint switch.

• Direct — The soft panel does not display a TAKE button. A crosspoint switch occurs 
automatically after each destination/source selection is made by the user via the soft panel.

11. Use the Machine control menu to control whether a TAKE request directed to an Ross NK 
series data router automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select Machine 
Control to enable the reciprocal port switches on a Ross NK series router.

• Disable — The soft panel does not display a Machine Control button.

12. Use the Viewable Data options to specify the maximum number of resources to display on the 
soft panel. The options are determined by the resources assigned on the Data tab. 

• Levels — Sets the maximum number of levels visible at one time. Refer to “Adding Levels to 
a Soft Panel”.

• Sources — Sets the maximum number of sources visible at one time. Refer to “Adding 
Sources to a Soft Panel”.

• Destinations — Sets the maximum number of destinations visible at one time. Refer to 
“Adding Destinations to a Soft Panel”.

• Salvos — Sets the maximum number of salvos visible at one time. Refer to “Adding Salvos to 
a Soft Panel”.
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Adding Levels to a Soft Panel
You can specify the levels, their hierarchy on the soft panel, and how many are viewable at once on 
the soft panel. For example, if you configure the Settings > Viewable Data > Levels to 2 but have 
assigned 4 levels to the panel, the first two levels will be visible by default. You would then use the 
options on the Data > Levels tab to select the levels and determine their hierarchy on the soft panel.

To specify the levels for the soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Levels tab.

4. To add a level to the soft panel:

a. From the Available list, select the level you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level.

5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected levels.

7. Use the  buttons above the Assigned list to determine the hierarchy in 
which the levels are displayed on the soft panel.

Adding Sources to a Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which 
they are displayed in the crosspoint row of the panel. For example, the router may have 16 sources 
but you only want to make 8 selectable on the crosspoint row of your soft panel. You can also 
specify the order in which the sources are displayed on the soft panel.

To specify the sources for the soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Sources tab.

4. To add a source to the soft panel:

a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available sources in the database to the soft panel, click .

6. To assign multiple sources to the soft panel:
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a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

7. Use the  buttons to determine the order in which the sources are 
displayed on the soft panel.

Adding Destinations to a Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in 
which they are displayed in the crosspoint row of the soft panel. Updating the Settings > Viewable 
Data > Destinations field configures how many destinations options are visible at once. For 
example, the database may have 32 destinations but you only want to make 4 outputs selectable on 
the crosspoint row of your soft panel. You would then set the Destinations field to 4 and then 
specify the order in which the four destinations are displayed on the soft panel.

To specify the destinations for the soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Destinations tab.

4. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

5. To assign all the available destinations in the database to the soft panel, click .

6. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected destinations.

7. Use the  buttons to determine the hierarchy in which the destinations are 
displayed on the soft panel.

Adding Salvos to a Soft Panel
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for crosspoint transitions. Before you can add salvos to a soft panel, you must configure 
them as outlined in “Creating Salvos”. 
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To specify the salvos available on a soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Salvos tab.

4. To add a salvo to the soft panel:

a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available salvos in the database to the soft panel, click .

6. To assign multiple salvos to the soft panel:

a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

7. Use the  buttons to determine the order in which the salvos are displayed 
on the soft panel.

Adding an Alias Set to a Soft Panel
By default, a matrix (or router) port is identified via the Frame.Slot.Port.Type.Channel 
nomenclature. An alias set enables you to customize virtual labels and apply to the ports if 
required. This re-naming is not necessary for router operation, but it may make your assignment of 
source and destination labels easier to identify.

For More Information on...
• configuring an alias set, refer to “Using an Alias Set”.

To apply an alias set to a soft panel

1. From the Panels table, select the soft panel to edit.

2. Select the Data tab from the right pane.

3. Select the Alias Sets tab.
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4. To apply a alias set to the soft panel:

a. From the Available list, select the alias set you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected set.

5. To apply all the available sets in the database to the soft panel, click .

6. To apply multiple aliases to the soft panel:

a. From the Available list, select the first set you wish to apply to the soft panel.

b. Press Shift.

c. From the Available list, select the other set(s) you wish to apply to the soft panel.

d. Click .

The Assigned list updates to include the selected sets.

7. Use the  buttons to determine the order in which the sets are applied on 
the soft panel.

Customizing the Soft Panel Layout
Some soft panel types also provide options for defining the Home and Drawer windows that display 
on the final panel. You can chose to use the default settings, or customize the width and number of 
rows/columns in each window independently.

 This section provides a summary of the layout options and settings. Some options may not be 
available for all panel types.

To customize the layout of a soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab. 

2. Select the Settings tab.

3. To re-size the scroll bars on your soft panel:
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a. Use the Vertical Scrollbar Width field to determine the size of the bar that enables the user 
to scroll along the vertical axis of the soft panel.

b. Use the Horizontal Scrollbar Height field to determine the size of the bar that enables the 
user to scroll along the horizontal axis of the soft panel. 

4. Use the Icons display menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

5. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — a horizontal layout; the panel is taller than it is wide. 
• Landscape — a vertical layout; the soft panel is wider than it is tall.

6. Use the Drawer Width menu to specify the width of the drawer handle size.

7. Use the Take button size menu to determine the size of the TAKE button on your soft panel.

8. If you set Style to Matrix or MultiBus, use the Viewable Data fields to restricted how many 
options you can view at a time: 

• Levels — sets the number of viewable levels of the soft panel.
• Sources — sets the number of viewable sources on the soft panel.
• Destinations — sets the number of viewable destinations on the soft panel.
• Salvos — sets the number of viewable salvos on the soft panel.

9. If you set the Style to Group Category, use the Nongroup Resources options to determine if 
resources that are not assigned to a specific group are displayed. Choose from the following:

• Hide — The unassigned resources are not displayed on the soft panel.
• Show — All resources are displayed on the soft panel.

10. If you set the Style to Push Button, Ultritouch PB, Ultritouch 4RU Split, or Group PB, 
proceed to “To configure a Group PB panel”.

To configure a Group PB panel

1. Create a new Group PB soft panel as outlined in the procedures “To create a soft panel” and 
“To customize the layout of a soft panel”.

The Settings tab is automatically selected.

2. Use the Icons Display menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

3. Select the Layout tab.

4. In the Home Windows table, specify the order that the windows will display in the completed 
soft panel layout as described in “To customize the Home Window of a soft panel”.

 By default, the windows are organized in the following order (left to right): Destinations, Sources, 
and Operation.

5. In the Drawer Windows table, specify the order of the windows that display on the soft panel. 
Refer to “To define the drawer elements of the soft panel” for details.

 To configure an Output Monitor window for a Group PB soft panel, refer to the Ultritouch User 
Guide.
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Customizing the Home Window
The order of the rows in the Layout > Home Windows table determine the order of the windows 
that display on the soft panel. For example, if the first row is assigned to Destinations, the first 
window next to the main toolbar of the soft panel will display the Destinations buttons.

To customize the Home Window of a soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab. 

2. Select the Layout tab.

In the following example, the user is configuring an Ultritouch Push Button soft panel.

3. Locate the Home Windows area of the tab.

4. To add a data type to the Home window of the soft panel:

a. Select a row in the Home Windows table.

b. Use the Up, Down, Top, Bottom, Sort buttons (located in the toolbar to the right of the 
table) to move a highlighted row to the desired position.

c. Click  Add.

The Add Window dialog opens.

d. Use the Window menu to specify the first window to include in the soft panel.

 You cannot have multiples of the same window in either Home windows or Drawer windows.

e. Click Apply.

The Add Window dialog closes and the Home Windows table updates to display the 
selection.

5. Repeat step 4 for each data type you want to include on the Home window.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display.
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Defining the Drawers on a Soft Panel
Soft panels can also include fly-out menus (drawers) that operate like horizontal drop-down menus. 
You can specify what menus, functions, and settings each drawer includes. The order of the rows in 
the Drawer Windows determine the order the drawer elements display on the soft panel. For 
example, if the first row is assigned to Status, when the drawer opens the first listed element will be 
Status.

 Not all Home Window options are available as drawer options.

To define the drawer elements of the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Layout tab.

3. Locate the Drawer Windows area of the tab.

4. Select a row in the Drawer Windows table.

5. Click .

The Add Drawer dialog opens.

6. Use the Type menu to specify the location of the drawer, in relation to the main window.

For example, if you select Type > Left and Style > Salvos, the drawer element will display on 
the left side of the main window.

7. Click Apply.

The Add Window dialog closes and the Drawer Windows table updates to include the 
selection.

8. Repeat steps 5 to 7 for each drawer option you want to include in the soft panel.

9. To customize a drawer size:

a. Use the Width field to specify the percentage of the allocated drawer space.

b. Use the Rows field to specify the number of rows in the drawer will display.

c. Use the Columns field to specify the total number of columns in the drawer will display.

10. Repeat step 9 for each drawer of the soft panel you wish to re-size.

Managing the Soft Panels
This section outlines how to copy an existing soft panel, edit an existing soft panel, and delete a soft 
panel from the database.
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Copying a Soft Panel
Once a soft panel is configured, you can copy it and use it as a template for creating additional soft 
panels.

 Ensure the soft panel is currently not in use.

To copy a soft panel

1. Select the soft panel name from the Panels table.

2. Click Duplicate.

The Duplicate dialog opens.

3. Click Duplicate panel.

The Duplicate dialog closes and the Panels interface updates to display the copied panel. 

A copy of a soft panel is automatically named “x(copy)” where x is the name of the original 
panel. 

4. Type a unique identifier in the Panel Name field. 

This name is used to identify the panel in the Control > Panels tree (see Figure 49).

Editing a Soft Panel
You can edit any soft panel that is not currently in use.

 You cannot edit the Panel Style of an existing soft panel.

To edit a soft panel

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

2. From the Panels list in the left toolbar, select the soft panel to edit.

The Panels interface updates to display the settings for the selected soft panel. The Settings 
tab, in the right pane, is automatically selected.

3. If required, use the  buttons to determine the position of the panel in the 
Panels list. This also determines the priority of the panels in the Control > Panels tree (see 
Figure 49).

4. Edit the resources for the panel using one of the following procedures:

• “To specify the levels for the soft panel”
• “To specify the sources for the soft panel”
• “To specify the destinations for the soft panel”
• “To specify the salvos available on a soft panel”
• “To apply an alias set to a soft panel”

Deleting a Soft Panel from the Database
 Ensure the soft panel is currently not in use.

To delete a soft panel from the database

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

2. Select the soft panel row from the Panels list.
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3. Click Delete.

The Delete dialog opens.

4. Click Apply.

The Delete dialog closes.

The selected panel is removed from the Panels list and the Control > Panels tree.

Displaying a Soft Panel in DashBoard
Once created, the soft panel is listed as a sub-node in the NRG > Control tree. The hierarchy of the 
nodes in the tree is determined by their Panel ID which is assigned when the soft panel is created in 
the database. Double-click a sub-node to display the corresponding soft panel in the DashBoard 
window. In Figure 49 there are five soft panels in the tree view including the default panels (the top 
two sub-nodes).

Figure 49  Example of Soft Panel Nodes

The steps for displaying a soft panel interface in DashBoard is the same for every type of panel.

To display a soft panel in the DashBoard window

1. Expand the main NRG node.

2. Expand the Control sub-node.

The Control tree displays with each sub-node representing an available soft panel.

3. Double-click the node for the desired soft panel.

The selected soft panel opens in the DashBoard window.

Crosspoint Switches via a Default Soft Panel
This section outlines how to use the default soft panels to perform a crosspoint switch.

To make a crosspoint switch using one of the default soft panels

1. Display a soft panel as outlined in “Displaying a Soft Panel in DashBoard”.

2. Select a button from the Destinations area.

The Status field reports the selected button. 

3. If you are using the Control (direct take) soft panel, select a button from the Sources area.

The crosspoint switch automatically occurs. In the following example, the user selected to 
switch DST 3 to SRC 3.
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4. If you are using the Control (confirm take) soft panel:

a. Select a button from the Sources area. The button is now lit blue.

b. Verify that the TAKE button is lit. 

In the following example, the user selected to switch DST 1 from SRC 2 to SRC 1. The TAKE 
button is now lit.

c. Click TAKE to perform the crosspoint switch.

After the switch, the SRC 2 button will no longer be lit and the SRC 1 button will be lit green.

Crosspoint Switches via a Push Button Soft Panel
 This section is applicable for push button soft panels created by the user and not one of the 

default soft panels.

The Push Button soft panel is organized into three distinct windows. The order and width of each 
window can be customized using the options in the Panels > Settings interface.
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The buttons and options in a Push Button soft panel are dependent on the current database, and 
how the soft panel was defined in the Panels interface. You can also use the Filter fields in the 
Destinations and Sources area of the panel to provide access based on the search criteria entered 
into each Filter field.

To make a crosspoint switch on a single level using a Push Button Panel

1. Display the Push Button soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select the Level you want to perform the crosspoint switch.

3. Select a button from the Destinations window.

The Status field reports the selected button. 

4. Select a button from the Sources window.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

5. Click TAKE.

To make a crosspoint switch on multiple levels using a Push Button Panel

1. Display the Push Button soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select each level from the Levels window or click FOLLOW to include all levels.

The Level buttons are lit in the right most toolbar.

3. Select a button from the Destinations window.

The Status area updates to display report the selected destination. 

4. Select a button from the Sources window.

The Status area updates to display only the selected source. 

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

5. Click TAKE.

Crosspoint Switches via a Matrix Panel
Crosspoint selections can be made using the cross-hairs or clicking the required Destination and 
Source buttons on the matrix soft panel. This section provides instructions using the cross-hairs for 
crosspoint selections.

To make a crosspoint switch using a single level

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select a level from the toolbar.

The button is now lit.

3. Select the source and destination intersection inside the matrix.

The selection is represented as an icon set in the color that matches the level. The TAKE button 
is now lit.

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

4. Click TAKE.
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The icon on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch between multiple sources and destinations on a single level

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select a level from the toolbar.

3. Select the first source and destinations inside the matrix.

4. Select the additional crosspoints to switch.

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

5. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch using multiple levels

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select each level from the toolbar or click Follow to include all levels.

3. Select the first source and destination inside the matrix.

4. Select the additional crosspoints to switch.

When multiple levels are selected, the circle on the crosspoint is divided into colored sections 
with each section representing a level. 

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

5. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To perform a crosspoint switch on multiple destinations with a single source

1. Display the matrix soft panel in the DashBoard window as outlined in “To display a soft panel 
in the DashBoard window”.

2. Select each level from the toolbar or select Follow to include all levels.

3. Click Select All located at the top left corner of the interface.

All the Dest buttons on the Matrix panel are now lit and selected.The Select All button is 
labeled Clear All.

4. From the top toolbar, select the Src button to switch.

The matrix updates to indicate the crosspoint switches that will occur on the next transition to 
the same source and the TAKE button is now lit. 

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

5. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.
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Crosspoint Switches via a MultiBus Panel
The layout of a MultiBus panel is similar to a production switcher layout where the destinations are 
arranged into a row of buttons near the top of the panel and the sources are arranged on a row 
near the bottom. 

To make a crosspoint switch on a single level using a MultiBus panel

1. Display the MultiBus soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. From the left toolbar, select the button for the level you want to perform the crosspoint switch.

3. Select a button from the Source bus (located at the bottom of the interface).

The button is now lit.

4. Select a button from the Destination bus (located at the top of the interface).

The Dest, and Preset buttons are now lit.

In the example below, the first level is selected (VID) and OUT 4 will switch with CAM 1.

 If the soft panel has its Take operation set to Direct, the Take button does not display and the 
switch occurs automatically.

5. Click Take.

To make a crosspoint switch using multiple levels

1. Display the MultiBus soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select each level from the toolbar or select Follow to include all levels.

When multiple levels are selected, the center row of the panel reports the level status using a 
horizontal bar to represent the level.

3. On the Destination bus, select the button for the outputs to include in the crosspoint switch.

4. On the Source bus, select the button for the input.

The Destination, Source, Preset, and Take buttons are now lit. 

In the following example, STUDIO 1 will switch with CAM 3 on Levels VID and AUD 3.
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 If the soft panel has its Take operation set to Direct, the Take button does not display and the 
switch occurs automatically.

5. Click Take.

Using the Multi Select Function
Use the Multi Select button when you want to group multiple destinations to use a single source 
during the next crosspoint switch. 

To use the Multi Select function

1. Display the MultiBus soft panel in the DashBoard window as outlined in “To display a soft 
panel in the DashBoard window”.

2. Select the level(s) from the left toolbar.

3. Click Multi Select.

The Multi Select button is now lit.

4. Select the buttons from the Destination bus located near the top of the interface.

The Destination buttons are now lit.

5. Select a button from the Source bus located near the bottom of the interface.

The Source, Preset, and Take buttons are now lit.

In the example below, Levels 2 and 4 are selected, and DST_28-1, DST_28-3, and DST_28-6 will 
switch with Src_28-6.



176 • Soft Panels in DashBoard NRG User Guide (v1-rev1)

 If the soft panel has its Take operation set to Direct, the TAKE button does not display and the 
switch occurs automatically.

6. Click TAKE.

Crosspoint Switches via a Group or Category Panel
The buttons and options in a Category soft panel are dependent on the categories defined for the 
current database, and how the soft panel was defined in the Panels interface. Instead of displaying 
all sources, destinations, and levels at one time, a Category soft panel provides access based on the 
categories and the indexes you created.

To make a crosspoint switch using a Group Category Panel

1. Display the Group Category soft panel in the DashBoard window as outlined in “To display a 
soft panel in the DashBoard window”.

2. From the status window, highlight the level(s) you wish to include in the crosspoint switch.

• Selected levels highlight in the level defined color.
• Non-selected levels are indicated by a gray button with white text.

3. To select a destination:

a. Click DEST from the category navigation tools.

b. Navigate to the desired group using the displayed groups in the main group window. 

Only groups containing destination assignments will be displayed unless the Non-group 
Resources option for this soft panel is set to Show.

c. Select a button from the available category destinations located in the main group window.

4. To select a source:

a. Click SRC from the category navigation tools.

b. Select a button from the Source bus located in the middle of the interface.

 If your Category soft panel was created with the Take Operation set to Confirm, the TAKE button 
is lit. Otherwise the crosspoint switch automatically occurs.

5. Click TAKE.
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Using the Lock and Protect Features
Whether your soft panel includes the Lock and Protect features is determined by the Settings > 
Protection Operation option. To display these buttons, ensure the Protection Operation is set to 
Enable.

 If the soft panel Protection operation is set to Enable w/ Override and a source or destination 
is locked by an unknown panel, you can force a clear of the protect/lock status.

Using a Lock
The Lock button provides the option to protect destination/level pairs. When another control panel 
or DashBoard client attempts to switch that combination, the request will be denied.

To lock a destination/level pair

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Select the destination/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To clear a lock

• Click the Unlock button.
The label on the button changes to Lock and the button remains lit.

Using a Protect
A soft panel can be locked by clicking the Protect button. The button is lit until pressed again.

This feature protects the currently selected destination/level pair from use by other sources, as well 
as from other linked panels. The Protect button is especially useful in instances where a 
destination must be held after a switch has been made.

To apply a protect

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Click Protect.

The button is lit. Selecting crosspoints will not take effect and the panel does not update when 
buttons are pressed.

• The destination button displays a blue border.

• The Destination area displays . 

• When a destination is protected, only the panel that initiated the protect can change the 
destination status.

• The Protect button is now labeled as Unprotect. 
• Toggle the button to disable the protect.

To clear a protect

1. Display the soft panel in the DashBoard window as outlined in “To display a soft panel in the 
DashBoard window”.

2. Click Protect.

The button is no longer lit and crosspoint switches can be initiated.
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NRG-MV Setup
The NRG-MV licensed feature allows you to view multiple video sources from a single output on an 
NRG router. Any video source on the router can be assigned to any PiP on an NRG-MV layout. This 
chapter provides an overview of the NRG-MV feature including how to install a NRG-MV license key, 
display the interfaces in DashBoard, and manage the PiP allocation for your Multiviewer setup.

Overview
The NRG-MV licensed feature provides:

• One NRG-MV Head for the NRG-FR1 and NRG-FR1-LCP
• Up to two NRG-MV Heads for the NRG-FR2 and NRG-FR2-LCP (a license is required for each head)
• Each NRG-MV Head uses a 2x2 layout with each PiP providing:

› UMD option (enable/disable)
› Audio metering (enable/disable)
› Static PiP labeling (Unicode)

• Each NRG-MV Head supports 1080p 50/59.94/60Hz with rate synced with the reference signal 
available via the router chassis REF port1

• Ability to enable/disable NRG-MV Head video on the designated BNC output port (SDI format)
• Ability to display up to 16 audio channels with EU meter bar and audio bar peak hold options

• Ability to output the NRG-MV Head from the DisplayPort (DP)2 on the router chassis 
simultaneously with the designated BNC (SDI) output

• PiPs can be switched as a destination

Setup Workflow
Configuring the NRG-MV includes the following tasks:

1. Enable the NRG-MV licensed feature.

2. Configure the PiPs.

3. Assign a Source to a PiP.

Before You Begin
Keep the following in mind as you implement your NRG-MV Head(s):

• If a reference is not connected to the NRG, the DP port outputs 1080p 59.94Hz (NTSC) or 1080p 
50Hz (PAL) by default.To connect the DP port to a 1080p 60Hz monitor, an external reference 
must be first connected to the NRG. Refer to the NRG Installation Guide for cabling information.

• If you intend to output the NRG-MV Head on the designated BNC output, you will need to select 
the Enable BNC output box for that Head. Refer to “Enabling the NRG-MV Head Output”.

1. If no reference signal is connected to the REF port, the format is dependent on the default reference of 1080p 50Hz 
(PAL) or 1080p 59.94Hz (NTSC).

2. Ensure the display monitor supports the routed video format.
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Installing a NRG-MV License Key
The maximum number of NRG-MV Heads for a router depends on the number of installed NRG-MV 
license keys and the router model (Table 58). 

One NRG-MV license enables one NRG-MV Head. 

To install a NRG-MV license key

1. Launch the DashBoard client. 

2. Locate and expand the NRG node in the Tree View.

3. Locate and expand the System node to display a list of sub-nodes in the Tree View.

4. Double-click the NRG-MV node.

The NRG-MV interface opens. 

5. Make a note of the character string in the Request Code field for the NRG-MV license.

6. Contact Ross Video Technical Support using the information in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them:

• your name,
• your facility name, and 
• the Request Code from step 5.

b. You will be given a License Key.

7. Enter the provided License Key in the applicable License key field of the NRG-MV interface.

Table 58  NRG-MV Heads per Router

Router Maximum Number of Heads

NRG-FR1 1

NRG-FR1-LCP 1

NRG-FR2 2

NRG-FR2-LCP 2
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 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

8. Click Apply.

9. Verify that the Count field is updated to report each installed License Key.

Displaying the NRG-MV Interface
You can access the NRG-MV settings for the Multiviewer Head once an NRG-MV license is enabled 
on the NRG.

To display the NRG-MV interface

1. Launch the DashBoard client. 

2. Locate and expand the NRG node in the Tree View.

3. Locate and expand the System node to display a list of sub-nodes in the Tree View.

4. Double-click the NRG-MV node.

The NRG-MV interface opens. The following example shows an NRG-FR2-LCP with two 
Multiviewer Heads enabled.

 The NRG-MV settings are hidden when no license is enabled on the router. Refer to “Installing a 
NRG-MV License Key” for details on enabling a license before accessing the settings.

Enabling the NRG-MV Head Output
The NRG-MV Head can be simultaneously sent to the DisplayPort (DP) output and to a specific BNC 
if the Enable BNC output mode is enabled. A NRG-MV Head is identified using the nomenclature of 
NRG.head[x] where x represent the Head ID. A NRG-MV PiP is identified using the nomenclature 
of NRG.slot1.head[x]-pip[y] where x represents the Head ID and y represents the PiP tile in 
the layout.

Enabling the NRG-MV Head Output on a BNC
To the router control system, the NRG-MV Head is a destination of the router and may be controlled 
as such from external controlling devices. A NRG-MV Head is automatically allocated to a specific 
output on the router. When not required by NRG-MV, the BNC remains available for regular SDI 
output routing.
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This section outlines how to enable an NRG-MV Head output on a BNC. Refer to Table 59 for a list of 
the output BNCs that are allocated for Multiviewer Heads.

To enable an NRG-MV Head output for a BNC

1. Display the NRG-MV interface as outlined in “To display the NRG-MV interface”.

2. If you are using an NRG-FR2 or NRG-FR2-LCP and have enabled two NRG-MV licenses, select the 
tab for the required NRG-MV Head.

3. Locate the NRG-MV Configuration area.

4. Select the Enable BNC output box.

 If you wish to use the BNC(s) for SDI routing, ensure the Enable BNC output box is not selected.

Enabling the NRG-MV Output on the DP Port
The NRG-MV can output the NRG-MV Head via the DP port on the back panel when connected to a 
downstream DisplayPort device. The DP default mode is to passthrough for 1080p monitoring.

To output the NRG-MV Head on the DP Port

1. Display the NRG-MV interface as outlined in “To display the NRG-MV interface”.

2. If you are using an NRG-FR2 or NRG-FR2-LCP and have enabled two NRG-MV licenses, select the 
tab for the required NRG-MV Head.

3. Use the Output DisplayPort menu to select one of the following:

• Passthrough — the DP port is used to output a 1080p signal for monitoring purposes.
• Head # — the DP port outputs the selected NRG-MV Head.

Table 59  Allocated BNC Output for Multiviewer Heads

Model Multiviewer Head 1 Multiviewer Head 2
NRG-FR1 OUT 16/MV --

NRG-FR1-LCP OUT 16/MV --

NRG-FR2 OUT 33 MV OUT 34 MV

NRG-FR2-LCP OUT 33 MV OUT 34 MV
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NRG-MV Head Layout
A NRG-MV Head displays a 2x2 layout. (Figure 50)

Figure 50  Example of a NRG-MV Head Layout

Table 60 outlines the NRG-FR1 and NRG-FR1-LCP destination assignment for each PiP.

Table 61 outlines the NRG-FR2 and NRG-FR2-LCP destination assignment for each Head and PiP. 

Adding Objects to the NRG-MV Head Output
An object is an element in a layout that is not a direct video source from the router. The following 
objects can be added to any PiP of an NRG-MV Head:

• UMD — This object is a static text box and reports the user defined name from the UMD Label 
column in the NRG-MV Configuration area.The label is centered and fixed to the bottom of a PiP.

• Meter — Each PiP can display up to 16 channel of audio meters. The audio meters are fixed to 
the top left corner of a PiP.

Table 60  PiP Layout Mapping — NRG-FR1, NRG-FR1-LCP

PiP Number Destination Assignment
1 NRG.slot1.head1-pip[1]

2 NRG.slot1.head1-pip[2]

3 NRG.slot1.head1-pip[3]

4 NRG.slot1.head1-pip[4]

Table 61  PiP Layout Mapping — NRG-FR2, NRG-FR2-LCP

PiP Number
Destination Assignment

NRG-MV Head 1 NRG-MV Head 2
1 NRG.slot1.head1-pip[1] NRG.slot1.head2-pip[1]

2 NRG.slot1.head1-pip[2] NRG.slot1.head2-pip[2]

3 NRG.slot1.head1-pip[3] NRG.slot1.head2-pip[3]

4 NRG.slot1.head1-pip[4] NRG.slot1.head2-pip[4]

PiP 1 PiP 2

PiP 4PiP 3
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To add a UMD label to a PiP

1. Display the NRG-MV interface as outlined in “To display the NRG-MV interface”.

2. Select the tab for the required NRG-MV Head.

3. Locate the NRG-MV Configuration area.

4. Locate the row for the PiP you wish to configure.

5. Select the UMD box.

6. Use the UMD Label field to enter the content to display in the label for the PiP to a maximum of 
24 characters. The text automatically re-sizes to fit inside the label.

To add the audio meters to a PiP

1. Display the NRG-MV interface as outlined in “To display the NRG-MV interface”.

2. Select the tab for the required NRG-MV Head.

3. Locate the NRG-MV Configuration area.

4. Use the Audio bar channels field to specify the number of channels in a single block of audio 
meters.

5. Select the EU meter bar box to enable the audio level status is reported in real-time as a series 
of vertical bars that comply with European Union (EU) standards.

6. Select the Audio bar peak hold box to enable the audio meters to report the audio peak level 
measurements for your audio channels. Measurement units are in decibel full scale (dBFS) 
where 0dBFS is the maximum digital value.

7. Locate the row for the PiP you wish to configure.

8. Select the Meter box.

Assigning a PiP to a Destination in the Database
NRG-MV PiPs (Picture-in-Picture tiles) are required to be mapped in as logical destinations. To the 
router control system, they are a destination of the router and may be controlled as such from 
external controlling devices.
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This section outlines how to assign the PiP of an NRG-MV Head to a destination within the router 
database.

 The default database will automatically configure the logical destinations for PiPs.

To assign a single PiP to a destination

1. Expand the Database node.

2. Expand the Configuration sub-node.

3. Double-click the Destinations node.

 If required, you can add Destinations to the list to accommodate the assignment of NRG-MV PiPs.

4. In the table of the Destinations tab, locate the column for the level.

5. Select the cell for the Destination to assign to the PIP.

6. If desired, type a new name for the PiP destination in the Name cell.

 Ensure the new name clearly identifies the destination as a PiP. You may also want to include a 
reference to the NRG-MV Head.

7. Perform one of the following:

• Click the cell of the row in the table to display a list of available Destinations sockets; or
• Choose a PiP from the available list.

Using a Soft Panel to Route to a PiP
A PiP is controlled by routing just like any destination. The NRG router directly routes to the PiP via a 
crosspoint selection on a soft panel. If the input signal includes embedded audio, the audio is 
included in the NRG-MV Head output.

When routing sources to the PiPs of an NRG-MV Head, you can display sources:

• of different formats on the same head at one given time;
• with no assumed timing relationship on the same head at one given time.

To assign a source to a PiP using a soft panel

1. Ensure your database includes destinations assigned to the required NRG-MV Head(s), and 
destinations. Refer to “Assigning a PiP to a Destination in the Database”.

2. Create a soft panel that includes the PiP(s) for each license (Head).. Refer to “Adding 
Destinations to a Soft Panel”.

3. Load a soft panel that includes the PiP(s) for each license (Head).

4. Select the crosspoint(s) as required.

In the following example, the user assigned SRC 1 to MV1 PIP 4, SRC 3 to MV1 PIP 1, SRC 4 to 
MV1 PIP 2, and SRC 5 to MV1 PIP 3.
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 A PiP displays the source for the Destination the PiP is assigned to (e.g. a PiP acts like a regular 
router destination). 

5. Click TAKE to perform the crosspoint switch on the selected PiPs.
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between an NRG and a device 
in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a label applied to a router output (or group of outputs).

Device — a physical, virtual, or software application that may include multiple sources, 
destinations, senders, or receivers.

Hard Panel — a physical hardware panel of buttons that is used to control the routing system.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Key — a physical button on the front panel of an NRG-FR1-LCP and/or NRG-FR2-LCP.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Local Control Panel (LCP) — refers to the physical buttons located on the front panel of the 
NRG-FR1-LCP and NRG-FR2-LCP.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Macro — a recorded sequence of Remote Control Panel operations (local to the panel).

Map — a table that defines the allocation of names (labels) to router input and output sockets.

Matrix — the part of the routing system that performs the actual signal switching tasks.

Receiver — an element within a device that receives exactly one stream, which contains one flow 
from a network.

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Resource — a source or destination of a router configuration; an external device providing some 
conversion functionality for use within the routing control system.

Sender — an element within a device which presents exactly one flow, packaged as a stream onto a 
network.

Soft Panel — a DashBoard interface that represents a panel of buttons that is used to control the 
routing system.

Source — a label applied to a router input (or group of inputs).

T-Bus — the Ross Video proprietary routing communication method via a defined physical 
interface.
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